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Intended use, data security, and
system requirements

Intended use

Visage 7 is an imaging solution based entirely on efficient thin-client streaming tech-
nology. It scales easily from a single radiology practice to large distributed health-
care enterprises and allows efficient viewing, processing, and archiving of very large
numbers of images, including thin-slice volumetric data from CT, MR, PET-CT, and
other 3D modalities.

Visage 7 is a system for distributing, viewing, processing, and archiving medical
images in healthcare environments. The Visage 7 server receives image data in
DICOM format via network. This provides flexible connections to archives, modali-
ties, and workstations. Modalities supported by Visage 7 are listed in the DICOM
Conformance Statement.

Aside from general image interpretation and processing tools, Visage 7 provides
specific tool sets for several clinical applications, including:

+ CT/MR angiography, for example, for vascular analysis and stent planning

« Cardiac analysis, including calcium scoring and functional assessment of car-
diac CT data

* Neuroradiology, including CT and MR brain perfusion analysis
» Oncology, including SUV analysis and lesion marking and analysis

Visage is to be used only by trained and instructed healthcare professionals. It can
support physicians and/or their medical staff in providing their own diagnosis for
medical cases. The final decision regarding diagnoses, however, resides with the
doctors and/or their medical staff in their own area of responsibility. Although the
Web and thin-client technologies allow the software to be run on a variety of hard-
ware platforms, for diagnostic purposes the user must ensure that the display hard-
ware used for reading the images complies with state-of-the-art diagnostic
requirements and currently valid laws.

Only DICOM for presentation images can be used on an FDA approved monitor for
mammography for primary image diagnosis. Only uncompressed or nonlossy com-
pressed images must be used for primary image diagnosis in mammography.

Visage 7
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Data protection and data security Intended use, data security, and system requirements

Data protection and data security

Patient data is subject to data protection. Therefore, users have to ensure compli-
ance with all applicable laws and regulations in their country. Visage 7 provides
extensive security mechanisms that help you assure data protection and data secu-
rity. On the administration platform, the system administrator can activate the audit
trail option to comply with the strict regulations regarding security and privacy of
health data (HIPAA) according to US law.

Caution

For data security reasons, it is not permitted to make changes to the Visage prod-
uct and its database. Contravention of this will lead to all guarantees being
revoked and under some circumstances may violate applicable laws.

System requirements

With Visage 7, all image data is stored on the server at all times. Users access the
data directly on the server from any number of radiology workstations, office PCs,
laptop computers, or other devices. Image data does not need to be sent to client
computers in the process. Instead, Visage 7 employs a technique that is called thin-
client streaming or thin-client computing. All image processing (2D, 3D, or 4D) is
performed on the server.

Server hardware consists of standard server platforms, but they must be qualified
by Visage Imaging. For a detailed server hardware and software specification, con-
tact customer support.

Client computers neither need to hold large volumes of data nor do they need to
perform any of the actual image processing. Therefore, system requirements for
Visage 7 Client computers are minimal as far as memory, graphics, or computing
power is concerned. As a result, the Visage 7 Client can be installed on virtually any
standard computer or standard laptop with a network connection. Visage 7 supports
all recent versions of Windows® and Mac OS. With Visage 7, Mac and Windows
users can work together in a fully integrated environment and workflow.

Detailed system requirements are documented in the release notes, which are
available on your Visage 7 server's download page.

12 Visage 7
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Symbols on the packaging

Symbols on the packaging

These symbols on the packaging convey information that is essential for the proper

use of the product.

Fragile

Keep dry

Protect from heat and radioactive sources

Temperature limitation

Consult operating instructions

Caution, consult accompanying documents

Date of manufacture (YYYY)

Manufacturer

CE-mark with reference number of VI's Notified Body
(TUV Rheinland LGA Products GmbH)

Serial number

Reference number

Visage 7
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System and workflow overview

Visage 7 delivers a fully scalable solution for primary interpretation, advanced visu-
alization, image distribution and archiving. All functionality is provided in a single cli-
ent software application with native thin-slice access and 3D and 4D
postprocessing. Visage 7 is entirely based on client-server streaming technology
with all functionality accessible from anywhere in the enterprise network or via the
Internet. With the Visage 7 thin-client solution, there is no waiting time for the data
to be copied onto your client computer, because all 3D processing and other calcu-
lations are performed on the server.

Key features of Visage 7

Visage 7 is an archive-neutral diagnostic and clinical viewing application that pro-
vides a comprehensive imaging workflow for all modalities.

Universal viewing
One thin-client application for reading everything from plain film to cardiac CT.
Native thin-slice and 3D processing

Seamlessly integrated multiplanar reformatting, volume rendering, and volumet-
ric analysis.

Advanced clinical applications

Supporting a wide spectrum of modalities, including CT and MR angiography,
cardiac CT, neuroradiology, and oncology.

Distributed workflow and archiving
Instant, unified remote access to multiple locations without replicating data.
Native Windows and Mac Client OS

Windows and Mac users seamlessly integrated into a single workflow and IT
platform.

Easy scalability

The fully scalable distributed thin-client architecture makes it easy to add more
modalities, users, and locations.

Features and user levels

Most features and tools can be turned on or off for individual user levels. User
levels allow the definition of roles, such as the role referring physician, who will
be presented the Patient Search window rather than the Study Browser. On a
finer level, individual tools can also be enabled or disabled for each user level.

Visage 7
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Workflow overview

System and workflow overview

Workflow overview

Visage 7 offers all the benefits of a flexible state-of-the-art PACS with advanced 2D,
3D, and 4D visualization. Efficient image interpretation is central to this solution, in
which all data remain on the server at all times and client computers use thin-client

technology to access the data.

Before or during primary interpretation, users can
perform advanced postprocessing tasks such

as bone removal, volumetric analysis, or

perfusion analysis.

Authorized users (e.g. PACS
administrators) can verify or
correct the assignment of
images to accession numbers
and patient IDS, split and
merge patients and studies,
and delete images.

Users can import prior studies

from any client computer and

assign them to the correct patient.
Visage 7 can be configured either to
archive or to delete prior studies after a
period of time.

Visage 7 receives and stores image data from all modalities
and can be configured to forward selected data to other destinations.
Visage 7 can serve as a full archive, or as a cache storage

for efficient access to large data volumes on top of an existing archive.

Efficient primary interpretation is facilitated by fast loading times,
flexible display protocols, and fully integrated 3D navigation.
Prior studies, postprocessing results, and interactive
processing tools are instantly available, and the
radiologist can easily store and share key
images and examination results.

Radiologists and clinicians

can easily access images
and postprocessing results
simultaneously or
consecutively.

Users can export original
images as well as key images
from any client computer.
Images can be printed on
paper or film or they can be copied
to CD, DVD, or other electronic
media.

Referring physicians can be provided with instant
thin client access to reports and images via Internet, from
any Windows or Mac 0S computer as well as on mobile devices.
Display protocols, functionality levels, and access rights can be
configured individually per user or user type.

16
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Study Browser

In the Study Browser, you search for patient and study data. Here you select the
images that you want to read and load them into a View window.

Note

If your Visage 7 is integrated in other clinical software, such as a Pro Medicus
RIS, the Study Browser might not be shown. Instead, you use the worklist of the
RIS to select and load data directly into Visage 7.

If the Visage 7 Study Browser is shown, remember that the Study Browser is not
a worklist. A worklist would present and preselect cases and tasks that a user has
been scheduled to complete next. By contrast, the Study Browser gives an over-
view of all data that is stored on the Visage 7 server or on connected network
nodes. You search these lists for the study or studies that you want to read next.

Find out more about the Study Browser and about how to load data and perform
data management tasks in the following sections.

* Query section

« Study list

» Loading data from the study list
» Session management

* Data management

Visage 7
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Query section Study Browser

Query section

Before you start defining search criteria for a database query, select the database
tab where you want to search. Queries apply only to the database whose tab card is
currently shown in the foreground.

Tip

If you do not know a complete name or number, you can use wildcards in your
search. For example, type Mi1 in the patient name box to find Miller, Milford, Milt-
ner, or *mi1 to find all the above and also Hamilton, or AB? 234 in the patient ID
box to find AB1234, AB0034, and AB11345678.

However, even if you use wildcards, always specify your search criteria as pre-
cisely as possible. Rather general queries might yield a very long hit list, which
requires extensive scrolling.

Filter and search criteria

Use the filter and search criteria in this list to search for study data.

Patient Enter the name, date of birth or age, or ID of the patient that you are looking for. If
you do not remember the exact name, date, or number, use wildcards.

For names that occur frequently, you might want to include the first name or other
components of the patient’s name in your search. To define such a search, you
need to know how patient names are stored in the database.

FamilyName GivenName MiddleName Prefix Suffix
The following example shows a search for first name, last name. and title.
Doe John*Dr.

If you want to search for more than one patient, separate patient names with a
semicolon (;) or the pipe character (|). For example, Anderson|Alexander or
Miller;Milford.

Date Click the Date box and select if you want to search by Study Date or Insertion
Date. The Insertion Date is the date when the study was transferred to the server
from a modality or an archive.

From ... To specifies a search period. Type dates in the format YYYY-MMM-DD, or
click the button to the right of a date box and select a date in the calendar.

Use the buttons Today, Yesterday, 1 Week, 2 Weeks as a quick way to specify fre-
quently searched periods in the correct format.

You can configure these four search-period buttons. Right-click one of the four but-
tons and select Hours > 1 Hour, for example, if you are frequently looking for stud-
ies that were performed within the last 60 minutes.
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Study Browser

Query section

Modality

Fields

Study Labels

Select the check boxes for all modalities for whose studies you want to search:

CT (computed tomography), MR (magnetic resonance tomography), PT (positron
emission tomography, PET), US (ultrasound), CR (computed radiography), DX
(digital radiography), MG (Mammography), XA (X-ray angiography).

-Or-

Enter a modality abbreviation in the Others box. Separate multiple modalities by a
space, for example, CT PT MR.

Here you can specify additional search criteria.

Open the lists of available criteria with the double-arrow buttons and select a crite-
rion.

Specify your search string in the input box below the selected criterion. Remember
that you can use wildcards in your search.

If you want to search for more than one accession number, for example, separate
numbers with a semicolon (;) or the pipe character (|). For example, 12345| 67890
or09876;54321.

If the search strings themselves contain semicolons, pipe characters, or back-
slashes, as in Ward 4; Rm.6 orWard 1\Rm.2, use the following notation:
Ward 4\; Rm.6;Ward 1\\Rm.2 orwWard 4\; Rm.6|Ward 1\\Rm.2

-Or-

Click the list button next to an input field.

Select an item.

If you are using labels to organize your studies, you can use these flags to search
for data in the Study Browser.

Open the list of available labels and select one or several labels.

-Or-

Type the label that you are looking for, or define a combined search.

Label A Label B -this string searches for all studies with either Label_A or
Label B.

Label A +Label B -this string searches for all studies that are marked with both
Label A and Label_B.

Label A -Label B -this string searches for all studies that are marked with
Label_A but not with Label B.

Note that in the Study Browser you can not only search for labels but also assign
labels to studies. Use Study Labels from the context menu of the study list to
assign labels. Proceed in the same way as when you assign labels while reading
images. See Assign and Manage Study Labels, page 122.
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Query section

Study Browser

Study States

Starting, resetting,

Starting a query

Resetting search
criteria

Repeating a recent
query

Click the Study States button and select study states in the Select State dialog
box.

Note that searching by study state Interpretation Status makes sense only if the
modalities that send the data to the Visage 7 server set this flag. In Visage 7 you
cannot set or edit the interpretation status of a study.

If study states have been defined in your search, the Study States button label is
shown italic and the Reset button next to it is available. Click this Reset button if
you want to reset only study states but none of the other search criteria.

or repeating a query

Use these buttons to start a database search, to reset search criteria, or to repeat a
recent query.

Click Query to start a database search.

Remember that the system queries the server whose tab card is currently shown in
the foreground.

Click Reset to remove all search criteria from the query section.

1. Click Reset and hold the mouse button down to show a list of recent queries.

7 berbel = BEA
Name: butler
Name: kunz
Name: mhh lesion9
Mame: MWL_F
All available Studies
Name: Gard
Name: Miller
Name: *annot
Name: case2
Name: Danniels
Name: buttler
Name: herr
Name: Marsha

2. Click the query that you want to repeat.
The filter and search criteria of this query appear in the query section now.

3. Click Query to start the database search.
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Query section

Query presets

Quick search with a
preset

Defining a preset

If you frequently use the same combinations of search criteria, you can save them in
a preset. Your presets are listed directly above the query section. Any presets that
you define are available for your own user account only. You cannot make presets
public.

Tip

A preset stores both search criteria and the arrangement of the study list and the
preview section.

1. Click a preset button to retrieve its search criteria.

Patient

2. Depending on how you defined the preset, you might have to click Query to start
the search.

1. In the query section of the Study Browser, select and type search criteria.
2. Click New Preset.

=+ Mew Preset

3. In the Preset dialog box, enter a name for your new preset.
4. Select Default if you want to make this preset the default query preset.

The default preset is the query preset that is automatically applied when the
Visage 7 Client is started.

5. Check Auto Query if you want the system to reenter your search criteria and
then run the search immediately. You do not have to click Query again.

-Or-

Check Default plus Auto Query to have the system run this search every time
you call up the Visage 7 software.

6. Save the preset.

A new preset button appears above the query section.

Tip

Right-click presets that you have defined earlier. A context menu appears which
helps you to manage presets. For example, you can remove preset buttons that
you no longer need.

Visage 7
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Study Browser

Study list

The study list may comprise two or more tab cards.

» The leftmost tab card is your Visage 7 server, which is also referred to as the pri-
mary server.

+ The tab card next to the primary server tab lists the studies that you read
recently.

» Any tab cards further to the right represent more Visage 7 servers, connected
DICOM network nodes, or external drives.

1. Click the + tab to show a list of available servers, nodes and drives.

5 TP-PACS01 |Recent Studies = k

> TP-PACS02
Patient
ALEGAR ELISE
MEDLEY ANON MATT

5 TP-PACS03

BERAUTOTEST1
BERAUTOTEST2
BERAUTOTEST3
TESTDATA
TP-PACS02
TP-PACS03

Visage PACS Archive

Servers with the Visage 7 logo are partner systems. You can load data from part-
ner systems in just the same way as from the primary server. List items without
Visage 7 logo are connected DICOM network nodes or external drives. You need
to retrieve data from these nodes or drives before you can load the data.

2. Select a server, network node, or drive to add this tab card.

7 TP-PACS01 Recent Studies » TP-PACS02 =+

Information in the study list

Patient
Date of Birth

Issuer

The study list is arranged in a hierarchical tree view. Use the +/- buttons in front of
the entries to expand or collapse this list.

For a better overview, you can sort the list by clicking a column header. Clicking a
second time reverses the search order.

If a study in the study list appears dimmed, the Visage 7 server has not or not yet
received all images and the study is considered incomplete. Whether you can nev-
ertheless load incomplete studies depends on your system configuration.

The name of the patient.
The date of birth of the patient.

The institution that issued the patient ID.
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Patient ID
Accession Number
Modality

Images

3D

L

Study/Series Description

Study/Series Date

Institution/Station Name

Insertion Date

Interpretation

Patient Location

Preview section

Windowing preview
images

Resizing the preview
section

Patient’s identification number.

Job number of the study in the HIS/RIS (hospital or radiology information system).
Modality or modalities where the patient was examined.

Number of images in a study or series.

This column shows a bullet when a series is a 3D series, which means that it con-
tains at least one continuous 3D volume.

A green bullet indicates that a volume dataset is available on the primary server or
on a partner server.

A yellow bullet indicates that the system is currently creating a volume dataset from
the original slice images.

Study or series description.

Date and time when the study or series was performed. The format is YYYY-MMM-
DD and HH:MM:SS (24 hour clock).

Name of the institution or department or name of the device where the study was
performed.

Date and time when the study or series was sent to this database. The format is
YYYY-MMM-DD and HH:MM:SS (24 hour clock).

This column indicates whether a report exists for a study and shows the report sta-
tus (new, in progress, draft, preliminary, or final).

Name of the institution, ward, or room where the patient is or was staying.

When you select a series or volume dataset on the primary server (leftmost tab
card), a preview image is shown below the study list.

The preview image is the first image of a series, or the central slice of a volume
dataset. If you select multiple series, one preview image is shown for each of these
series.

For a better overview, you can window preview images.

1. Click a preview image.

2, Hold the mouse button down.

3. Drag the mouse up or down or right or left to change brightness or contrast.

You can change the size of the preview section and the study list.
Drag the split bar that separates these screen areas up or down.

You cannot resize individual preview images.

Visage 7
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Loading data from the study list Study Browser

Loading data from the study list

Loading with double-
click

Loading more than one
study, series, or dataset
into one tab card

Loading studies into
separate tab cards

Loading studies into a
separate Visage 7
Client

Choose one of the following methods to load data from the study list.

To load a single study, series, or volume dataset, double-click it in the study list.
However, be aware that when you double-click a study for which session informa-
tion exists, the system loads the session and not the original images. See also Ses-
sion management, page 25.
1. Select the studies, series, or volume datasets that you want to load.

Use the Shift key or the Ctrl (Windows) or Cmd (Mac) key for multiselection.
2. Click the View button or select View from the context menu.

-Or-

Use Add to View if you do not want to replace the currently loaded data but load
additional data.
Tip

Right-click a patient name and select Find All Studies For This Patient as a
quick way to find and load prior studies of a patient.

If you are currently reading images and are interrupted by a request for your opinion
on a different case, you can load this new study in a separate tab card.

1. Select the new case in the study list and click the View In New Tab button or
select View In New Tab from the context menu.

In the title bar, a new tab card appears. The tab of the active tab card is high-
lighted with a bullet.

Study Browser AMSELL “ MILLER Export

2. Use these tabs to switch between cases.

1. Right-click a study in the study list and select Load in separate window.

A new Visage 7 Client opens containing only this case and the Export window. A
colored bar below the title bar reminds you that this is not the case you worked
on originally.

2. Return to your original case with Alt + Tab (Windows) or Cmd + Tab (Mac), this
leaves the second case open.

-Or-

Close the new case with the Close Window button in the colored bar.
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Session management

Special loading options

Viewing reports

Loading data for quality
assurance

Instead of having the system select a protocol best suited for the selected data, you
can preselect data display options when loading the data. You can choose to show
all series of a study side by side or, for time series, to show all phases side by side.

1. Select the study you want to load.

2. Right-click and select View All Series Side-By-Side or View All Phases Side-
By-Side.

If a preliminary or final report exists for a study, you can preview it in Study

Browser.

Right-click a study for which a preliminary or final report exists and select View

Reports from the context menu.

If your user rights permit you to perform quality assurance tasks, you can load data

directly from the study list onto the Quality Assurance platform.

1. Select one or several studies, series, or volume datasets.

2. Right-click and select Quality Assurance from the context menu.

Session management

Saving a session

AutoLogoff session

Visage 7 supports session management. Session management means that you can
save image processing and evaluation results when you have to interrupt your work.
When you return later, you can load the session again and resume your work or
present your results to colleagues.

Note

Session management requires that your user account is assigned to an appropri-
ate user level. Talk to your system administrator to find out about your user level
settings.

Use File > Save Session or File > Save Session As to save a session. For one
study you can save more than one session if you want to document stages or dis-
cuss different aspects.

If the system logs you off automatically after an extended period of no user interac-
tion, it saves any changes in an AutolLogoff session.

Tip

Open the AutoLogoff session immediately after you have logged on again and
decide whether to save it in a user-created session. When the system logs you
off automatically a second time, a new AutoLogoff session is created, which
overwrites the previous one.

Visage 7
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Session management

Study Browser

Session list

Loading a session

Ignoring session infor-
mation

Sharing sessions

Sending session links
or study links

If session management has been enabled for your user account, the lower right cor-
ner of the Study Browser displays a session list.

When no study is selected in the study list, all your recent sessions are shown in the
session list.

When a study is selected in the study list, the session list displays only sessions of
this particular study. An AutoLogoff session is shown in red and in the topmost
position of this list.

Double-click a session in the session list.

-Or-

Double-click a study in the study list.

Depending on the configuration of this feature, a double-click either loads the most
recent session or starts a new session. See Properties dialog box, page 202.

You might choose to ignore session information explicitly when you load a study.

1. In the study list of the Study Browser, select the study.

2. Then double-click <New Session> in the session management box.

The system loads the original data as they were sent from the modality and ignores
any intermediate evaluation results.

Sessions are usually available only for the user account that created the session.
However, you can choose to share sessions with colleagues.

When you save a session, indicate whether you want to make this session available
for all users or only for your own user account. Sessions that you made available for
all users are marked with the word (shared) in the session management box.

You can send shared sessions as session links to colleagues.

1. Double-click a session in the session list.

2. Select File > Copy Session Link.

3. Open your email program and send the session link in an email.

When your colleagues receive such emails, all they need to do is to click the
attached link. Visage 7 loads the session, provided, of course, Visage 7 is installed
on your colleagues’ computers.
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Data management

More information about
sessions

If you did not share a session or if you are not working with sessions, you can copy
and send study links instead of session links. A study link will help the recipient of
the email to find and open a study quickly. A study link will not communicate ses-
sion-specific information, however.

1. Double-click the study in the study list.
2. Select File > Copy Study Link.

3. Open your email program and send the study link in an email.

A session saves the following information and image processing results:

+ How many and which datasets were loaded at the time the session was saved
* Protocol and display settings

+ Key views and screenshots with or without annotations and measurements

+ Segmentation results, such as 3D ROls or vessel segmentation results

+ Structures and contours

+ Cardiac analysis results

Session information is temporary data. Sessions are stored on the Visage 7 server
for as long as the studies they refer to are stored on the server. When a study is
deleted from the database, session information is lost. Deletion of study data can be
triggered manually or automatically, that is when the hard disk is full. Automatic
deletion of study data affects the oldest studies on the server.

To avoid losing sessions that you want to preserve over a longer time, delete-pro-
tect these studies. See Delete-protecting studies, page 34.

Data management

Aside from the daily tasks of searching and loading study data, you also use the
Study Browser for less frequent data management tasks.

Importing and exporting studies (DICOM format)

You use these functions when you receive image data on a patient CD or DVD or
when you want to create a patient medium.

Note

You need appropriate user rights to be able to import and export studies.

Visage 7
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Study Browser

Importing a study from CD, DVD, or USB stick

1. Insert a patient CD, DVD, or connect a USB stick.

If Visage 7 finds DICOM data on this medium, the DICOM data detected dialog
box opens.

2. Click Import.

In the study list of the Study Browser, a new tab card appears.
3. On this new tab card, select the study or studies that you want to import.
4. Click Import.

e

The Import DICOM Data dialog box opens. In this dialog box you can modify
certain attributes of the data to be imported.

For example, if you are importing a study from another institution, you might
have to update the patient ID so that it matches the ID used in your own practice.
Identical patient IDs is a prerequisite for Visage 7 to identify the imported study
as a prior study for a patient who already exists in your system.

5. Select Create new UIDs and modify the Patient ID, for example.

Other import presets might also be available in your Visage 7 Client. These pre-
sets were configured to meet the requirements for patient data import in your
particular institution.

6. Select Don't archive data (for Visage 7 installations with archive option) if you
want to import the data only temporarily and plan to delete it again later.

7. Select Prevent autorouting to ensure that your data is not forwarded to other
servers, independent of the autorouting rules that are configured in your system.

8. Click Import Data.

Imnport Data

Tip

If your forgot to select the Don’t archive data option during data import, you can
select this flag later in the study list. Right-click a study that has not yet been
archived and select Don’t archive data. Be aware that you cannot reset this flag.

Exporting studies

You can export studies either from Study Browser or from the View or Export win-
dows. In Study Browser, you explicitly select studies from the study list of your
Visage 7 server (primary server). You cannot export data from partner systems or
connected DICOM nodes. In order to export studies from a View window, you load
the relevant studies first. All the loaded studies will be exported. You cannot exclude
loaded studies from data export.
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1. In Study Browser, select the study or studies that you want to export, right-click
and select Media Export.

-Or-
In a View window or the Export window, select File > Media Export.
2. Select a Destination

Export files to local client folder - select this option to download data onto your
local computer or onto a USB stick at your local computer. Also select the drive
and folder to where you want to export the data.

Burn Patient CD/DVD - select this option to create a CD or DVD on a CD/DVD
writer on your local computer.

Export files on server - select this option to export data to a predefined folder
on the Visage 7 server. From there, the data can be picked up by a CD/DVD pro-
ducer station, for example.

CD Producer Station - select this option to create a CD or DVD on a CD/DVD
producer station that is connected to the Visage 7 server. Also select the storage
capacity of your medium. This option is only available if a CD producer station is
connected to the Visage 7 server.

CD producer station or stations configured as DICOM nodes - if configured, one
or more additional CD producer stations in your hospital might be available here.

Send to ... - select a DICOM node that has been configured to receive studies
from Visage 7.

3. Select export options.

Include Media Viewer allows the recipient of the CD, DVD, or USB stick to read
the study data directly from this medium. No other software is required. Also
select Autorun Media Viewer if you want Media Viewer to be started automati-
cally when the CD or DVD is inserted in the CD/DVD drive or when a USB stick
is connected to a computer.

Uncompressed only exports data according to the IHE standard.
De-ldentify exports an anonymized copy of the selected data.
4. Click Export.

Exporting includes sending the images and creating a DICOM directory. Depending
on the data volume that you are exporting, this process might take a while.

Retrieving and sending studies (DICOM network)

You use these functions if you want to fetch a study from a connected DICOM net-
work node or send a study to another DICOM node.

Note

You need appropriate user rights to be able to retrieve and send studies.
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Study Browser

Retrieving a study from a DICOM node

You need to retrieve studies from a connected DICOM node before you can load the
data. You do not need to retrieve data from partner systems. Partner systems are
servers whose tab cards are marked with a Visage 7 logo.

1. Select the tab card of a connected DICOM node.

2. Define search criteria in the query section and click Query.

3. In the study list, select the study that you want to retrieve.

4. Click Retrieve.

Be

5. Return to the leftmost tab card. That is the tab card of the Visage 7 server.

6. Search for the study that you just retrieved.

Sending data across the network

You can send data either from the primary server, that is your own Visage 7 server,
or from partner systems. The tab cards of partner systems are marked with a
Visage 7 logo. You cannot send data directly from connected DICOM nodes or
external media. If you want to send data from such a node or medium, retrieve the
data first.

1. Select the study that you want to send in the study list of the Visage 7 server.

2. Right-click and select DICOM Send and select the server or servers that you
want to send the data to.

-Or-

Select DICOM Quick Send to send the selected data off to preconfigured desti-
nations immediately.

Importing studies (hon-DICOM format)

Use these functions when you receive study data in a non-DICOM format (for exam-
ple, jpg, pdf or as a paper printout).

You can import new studies either from the Study Browser or from a View window.
To import studies from a View window, you use the Import From Non-DICOM Files
and Import from Document Scan tools, which you can add to your tool palette.
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Importing a study from file

&

1. From the menu of the Study Browser, select File > Import New Study > From
Non-DICOM Files.

2. Onthe Select Patient page of the Import New Study dialog box, select the type
of study that you want to import.

3. Click Query and select the patient in the list.

If the list of patients found is very long, type the patient’s name or part of the
name in the Filter box.

-Or-

Select <New Patient> in the patient list and specify at least patient ID, patient
name (family name and given name), date of birth and sex in the Patient Details
section of the dialog box.

4. Click Next.

5. On the Select Files page, click Browse and select one or several files in your
file system.

6. Modify series information, if necessary.

7. Select Don't archive data (for Visage 7 installations with archive option) if you
want to import the data only temporarily and plan to delete it again later.

8. Select Prevent autorouting to ensure that your data is not forwarded to other
servers, independent of the autorouting rules that are configured in your system.

9. Click Import.

Scanning a study

TN
1. From the menu of the Study Browser, select File > Import New Study > From
Document Scan.

2. Onthe Select Patient page of the Import New Study dialog box, select the type
of study that you want to import.

3. Click Query and select the patient in the list.

If the list of patients found is very long, type the patient’'s name or part of the
name in the Filter box.

-Or-

Select <New Patient> in the patient list and specify at least patient ID, patient
name (family name and given name), date of birth and sex in the Patient Details
section of the dialog box.

4. Click Next.

5. On the Scan Documents page, select your scanner and scan settings.

Visage 7
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Note that the highest resolution you can select here might be lower than the
maximum resolution of your scanner.

6. Click Scan to scan one or several pages.

7. Use these buttons to review the scanned pages.

Q0O

8. Modify series information, if necessary.

9. Select Don’t archive data and Prevent autorouting to prevent the attachments
from being archived or sent to other network nodes for archiving.

10.Click Import.

Attaching documents to studies

You can attach reports, scanned documents, or notes from the referring physician,
or other files to a case.

Attachments are appended to a study as a separate series each. The program sug-
gestion for the series number ensures that the attached series will be added to the
end of the study.

In a View window, the attached files will appear as additional thumbnails in the
thumbnail section. Here you can double-click an attachment and show the data in a
separate window.

Attaching files to studies

Only pdf files and image files can be imported from the file system and attached to a
study.

1. In the study list of the Study Browser, right-click a study and select Add Attach-
ment.

-Or-
In a View window, select Add Attachment from the File menu.

2. In the Add Attachments To Study dialog box, click Browse and select one or
several files in your file system.

3. Modify series information, if necessary.

4. Select Don’t archive data and Prevent autorouting to prevent the attachments
from being archived or sent to other network nodes for archiving.

These settings will affect only attachments and not the study as such.

5. Click Import.

32

Visage 7



Study Browser Data management

Scanning attachments

1. In the study list of the Study Browser, right-click a study and select Add Docu-
ment Scan.

2. In the Add Document Scan to Study dialog box, select your scanner and scan
settings.

Note that the highest resolution you can select here might be lower than the
maximum resolution of your scanner.

3. Click Scan to scan one or several pages.

4. Use these buttons to review the scanned pages.

Q0O

5. Modify series information, if necessary.

6. Select Don’t archive data and Prevent autorouting to prevent the attachments
from being archived or sent to other network nodes for archiving.

These settings will affect only attachments and not the study as such.
7. Click Import.

Managing access rights to data

When you import a study from an external medium, the study is automatically
assigned to your own user account and the user group Standard. Change the study
assignment to user or user group to make the data available for other users as well.

Note

You need appropriate user rights to be able to grant access rights to individual
users or entire user groups.

1. On the primary server (leftmost tab), select one or several studies.
2. Right-click and select Assign study to groups or Assign study to users.

3. In the Study Assignment dialog box, select the user groups or users who will
have access to these studies.

Note

In the Study Assignment dialog box, you can also revoke access rights to study
data. Do not revoke access rights to a study for your own user account or for a
user group that you are a member of. If you do, you no longer have access to this
study either. You cannot restore your own access rights to study data after you
have closed the dialog box. As soon as the study list is updated, the study is no
longer listed. You or your user group can only be granted access rights to this
study again by another user with appropriate user rights, or by the system admin-
istrator.
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Delete-protecting studies

Users with advanced user rights can delete studies that are not delete-protected
from the Visage 7 server in the Quality Assurance window. Manual deletion of
studies might become necessary when patient data have been corrected and dupli-
cates of a study exist on the server. Automatic deletion of old data that has already
been archived can be configured by the system administrator to free disk space.

When a study is deleted from the server either automatically or manually, session
information is irretrievably lost. Therefore, you might want to delete-protect cases
whose sessions contain information that you want to preserve over an extended
period of time. For example, you might want to save cases that you have marked
with labels and that you want to keep for research purposes.

1. Select the study that you want to delete-protect.

2. Right-click and select Delete Protection.

Note

You need appropriate user rights to be able to delete-protect studies.

Anonymizing and marking cases for presentation

Assigning a confer-
ence label

Visage 7 provides mechanisms for marking studies for presentation or other pur-
poses and for anonymized display of data.

Assigning conference labels and scheduling conferences

You use conference labels to mark cases for discussion in a conference or meeting
on a specific date and at a specific time. Visage 7 features a calendar for planning
conferences and for assigning studies to them.

1. In the study list, right-click a study and select Conference Labels.

The Conference Labels dialog box shows the current week with all the confer-
ences that have been scheduled for this week. If the selected study has already
been assigned to a conference this week, this conference has a check mark.

Below this week’s calendar, you will see if the study is also assigned to other
conferences or if it has been marked with a study label.

34

Visage 7



Study Browser

Data management

7 Conference Labels

-~
February 10 - 16
w

Other Labels:

Scheduling confer-

ences

Today

Tumor Board
10:30 - 11:30

Tumor Board
10:30 - 11:30

Tumor Board
10:30 - 11:30

MPMC Urology Conference
10:00 - 10:30
v

Tumor Board
10:30 - 11:30

Tumor Board
10:30 - 11:30

Weekly Review
15:00 - 15:45

2. To assign the study to a conference, first select the week.

P

February 17 - 23
-

Today

3. Click the conference in which you want to discuss this case.

y Conference

4. If you want to reschedule a case, delete the conference label the study was
assigned to originally.

Other Labels:

MPMC Urology Conference [20190213] Fk

5. Click Close.

You also use the Conference Labels dialog box to plan conferences or recurring
meetings regardless of whether you will assign cases to them immediately.

1. In the study list, right-click any study and select Conference Labels.
2. In the Conference Labels dialog box, click New Conference.

3. In the New Conference dialog box, specify a subject or the name of the confer-
ence.

4. Select the date, time, and duration.
5. Select a specific color to highlight this conference.

6. Define a recurrence pattern, if required.
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Editing or deleting con-
ferences

7. Specify who will be allowed to take part in this conference under Permissions.

Selecting Public will allow all Visage 7 users to assign studies to this conference
and to see the studies assigned to it.

Selecting Private will allow you to restrict access to this conference and its stud-
ies in terms of individual users or user groups.

7 Mew Conference

Subject: Weekly Meeting

Date: 2019-Feb-22 Set color:
Start time: 9:00 AM
End time: 30 minutes
+ Recurrence pattern
Daily Every weekday ® Weekly Manthly

Endby: 6/22/19 =

Per ons
Public # Private

are with users:  adrad;alyson;gomez

Share with groups:

Cancel

8. Click OK.

You and the users whom you granted permission to take part in this conference can
now start assigning cases to it.

1. In the Conference Labels dialog box, right-click a conference or meeting.

2. Select Edit Conference to change the date, time, duration or any other confer-
ence details.

Weekly Meeting =
09:00 - 09:30 Edit Conference

Delete Conference

-Or-

Select Delete Conference to delete this conference from the calendar and to
remove conference labels from all the studies that were assigned to it.

Weekly Meeting -
09:00 - 09:30 Edit Conference

Delete Conference

Assigning and managing study labels
You use study labels to mark studies for various purposes.
Three types of study labels exist:

+ Public labels for marking teaching files
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Data management

Creating and assigning
a study label

Assigning public or pri-
vate labels

Deleting a study label

You use these labels to mark anonymized cases that you want to discuss with
your students. Students who open the Visage 7 Client will see only those studies
that have been marked with a teaching file label.

Teaching file labels start with a configurable prefix, for example, the word teach.
If teach is the configured label prefix, teach class2 or teaching-course?2
are considered teaching file labels. However, a public label with the name
classl or course2-teaching would not be identified as a teaching file label
but as a public label for other purposes.

Public labels for other purposes

You use a label of this type, for example, to mark studies that you want to dis-
cuss with a colleague.

Private labels

Private labels are only visible in your own user account. You use labels of this
type, for example, to collect cases for research purposes or simply to find a
study again quickly.

Tip

If you use labels to collect cases for teaching or research purposes, you will prob-
ably want to keep these cases in your database for some time. Therefore, con-
sider delete-protecting such cases to avoid that labels and session information
being lost when the data is moved to the archive and deleted from the server.
See Delete-protecting studies page 34.

. In the study list, right-click a study and select Study Labels.

. In the Labels box, type the new label name.

Visage 7 now offers you two versions of the new label, new label (private) and
new label (public).

. Select the check box in front of the public or private version and click Apply.

Visage 7 creates the new label and assigns the selected study to it.

. Assign a second label to the study, if required.

. In the study list, right-click a study and select Study Labels.

The Study Labels dialog box opens. In this dialog box, you find a list of all public
labels as well as all of your own private labels.

. Select Show labels from other users and specify user names to make private

labels of other users available as well.

Separate user names with a comma to show private labels of several other users
(e.g.Miller, Smith, Johnson).

. Select the check boxes of one or several labels and click Apply.

. In the study list, right-click a study and select Study Labels.
. Start typing the name of the label that you want to delete.

. In the list, right-click the study label and select Delete.

Visage 7
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Study Browser

When you delete a study label you remove the marker from all studies that it had
been assigned to. You do not delete the studies.

Privacy mode

In privacy mode, any information that would identify a case is temporarily hidden.

7 TP-PAC502 +

Patient v | Date of Birth Patient ID Accession Number | Modality | Images |3D |Online | Study [/ Seri

+ M... 040-..-.. 5 717 *© @ NCT132CTA
+ M..... .. 950-...- . 10 @ THORAX

You can switch to privacy mode either from the Study Browser or from a View win-
dow.

Select File > Privacy Mode > Study Browser and View Screen or View Screen
Only.

Privacy mode will remain turned on until you end it again (File > Privacy Mode >
Off).

Creating anonymized teaching files

While privacy mode is a display mode only, de-identification or anonymization of
case data means removing any information that would identify the patient from a
copy of a case permanently.

You can anonymize a study and assign the anonymized copy to a predefined teach-
ing file label in one step.

1. In the study list, right-click a study and select De-identification and Teaching
Files.

In the de-identification dialog box, the Create De-identified Copy check box is
selected. Do not clear this box.

Moreover, the system suggests that you replace the patient name with a case
description and the prefix TF__ (for teaching file). The system has also replaced
the patient ID, study ID, and accession number with random codes. The date of
birth is replaced by January 1st of the patient’s actual year of birth.

2. Click an item in the New Value column and change this random data if you want.
3. Select the following options for anonymization:

Remove other demographic tags and Remove private tags: Aside from the
data shown in this dialog box, other information might be stored in the DICOM
data of this study that also helps to identify the patient. Selecting these two
options removes all DICOM tags that might contain information about the patient.

Don’t archive and Prevent autorouting: Selecting these options prevents the
anonymized study from being archived or sent to another network node for
archiving.

4. Select a teaching label for the anonymized copy.

You can only select predefined teaching labels here. You cannot create a new
teaching file label in this dialog box.
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Data management

Creating an ano-
nymized copy of a case

Marking the ano-
nymized case with a
private label

5. Click Apply.

6

When copying is complete, the anonymized study does not appear in the study
listimmediately.

. Check your query settings and click Query to update the study list.

Tip

Do not forget to delete-protect the anonymized study, particularly if you selected
the options that prevent archiving and autorouting. See Delete-protecting studies
page 34.

Anonymizing cases for other purposes

If you want to create an anonymized copy of a study in order to present it at a con-
ference or to include it in a research project, you proceed in two steps.

1.

In the study list, right-click a study and select De-identification and Teaching
Files.

Proceed as described in Creating anonymized teaching files, page 38. However,
do not assign a teaching file label.
. In the study list, search for the anonymized case.

Right-click the anonymized case and select Study Label.

3. Assign a public or private label as described in Creating and assigning a study

label, page 37.

Visage 7
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Patient Search

Query section

First Name, Last Name

Date of Birth

Patient ID

Location
Accession Number
Study Date

From ... To

Today, Yesterday,
1 Week, 2 Weeks

Patient Search is targeted at referring physicians. Here, referring physicians can
search for patients and open reports and images of patients whom they have
referred. The list of patients and studies in this window is populated from the RIS
(radiology information system) and depends on your access rights that have been
defined by your RIS administrator.

Patient Search is subdivided into two sections:
* Query section

* Results list

In the query section you can configure your search of accessible studies by select-
ing one or several of the following criteria.

The patient’s last name and first name.

The patient’s date of birth.

The date of birth box allows free text entry in most date formats. For example, for
June 3rd, 2009, the system accepts any of the following date entries: 03062009,
3.6.2009, 3.JUN 2009, 3/6/2009, 3/JUN/2009.

The default date format is defined by the property settings of the user interface
(date widget, date local settings). For example, the default for the region Germany,
Austria, Switzerland, Australia and UK is DD.MM.YYYY.

The patient’s identification number.

Name of the location where the study was performed.

Job number of the study in the RIS (radiology information system).
Date when the study was performed.

Here you can specify a search period. Enter dates in the format YYYY-MMM-DD, or
click the button to the right of a date box and select a date in the calendar.

Use the buttons Today, Yesterday, 1 Week, 2 Weeks as a quick way to specify fre-
quently searched periods in the correct format.

Visage 7
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Patient Search

Modality

Only My Patients

Only Patients from my
Practice

All Patients

Only Signed Reports

Results list

Viewing images

Opening reports

Select the check boxes of all modalities whose studies you want to search:

CT (computed tomography), MR (magnetic resonance tomography), PT (positron
emission tomography, PET), US (ultrasound), CR (computed radiography), DX
(digital radiography), MG (Mammography), XA (X-ray angiography).

-Or-
Type the abbreviation of the modality in the text box.
-Or-

Select All to search for all studies irrespective of the modality where they were per-
formed.

Depending on your access rights in the RIS, you can to search for and open studies
of only your own patients, only patients from your practice, or all patients.

If you have access rights to all patients, you have to provide the exact Patient ID,
Date of Birth or Accession Number for identification.

Limits your search to reports that are finalized, that is signed.

Click this button to start the search.

In the search results list, you find images and reports for patients that you referred
for radiologic examination.

You can open images directly from the results list, where they are shown with the
patient name, date of study, examination type, and modality.

Double-click the image symbol to open the images.

v

When reports are available, a report button is shown next to the images in the
results list.

Double-click this button to open the report from the RIS (radiology information sys-
tem).

5
-Or-

Double-click this button to open a signed report.

2
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Tip

In the report window, you can view and print reports.
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View windows

Once you have loaded images, these are shown in one or several View windows
which appear as tab cards in the title bar. Tab cards show the name of the patient
whose data they contain. The active tab card is highlighted with a bullet.

Study Browser AMSELL “ MILLER Export

Use tab cards to switch between cases.

Depending on your selection of data, a View window is shown with a specific screen
layout. This screen layout is defined in a protocol.

The system preselects a different protocol for data of different modalities and ana-
tomical regions, and depending on the monitor configuration and the number of
loaded series. If you prefer a different screen layout, you can select a different pro-
tocol, show a different arrangement of viewers, or show and hide toolbars and tool
cards.

Find out more about these options and the tools available for reading images in the
following sections:

» Protocols

« Viewers and viewer layouts
+ Tools

» Tool cards

For more information about how to perform complex tasks that combine various
tools and tool cards, refer to this section:

» Complex tools and applications

Visage 7
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View windows

Protocols
Protocols define the screen layout and the display parameters for the loaded
images.

Protocol assignment When a user loads one or several studies, series, or volume datasets, the system
automatically selects a suitable protocol for the data. The system uses the following
matching criteria to make this selection.

* Monitor configuration
Different protocols exist for different combinations of monitors and for different
screen resolutions.

» Study and series criteria
Protocol matching criteria usually include the modality or a combination of
modalities that acquired the data.
For example, a CT series might be shown with a different screen layout than an
MR series or a combination of CT and PET series. Other study and series crite-
ria include the study description, the part of the body, or whether current and
prior studies are displayed.

* Protocol availability and protocol ranking
Protocols might have been defined in such a way that they are available for indi-
vidual users or individual user levels only. Moreover, users can assign priority
ratings to protocols. A protocol with a high priority rating is more likely to be auto-
matically selected than a protocol with a low priority rating.

Protocol definition Your system comes with a number of predefined protocols. Users with advanced
user rights can adapt these protocols and their matching criteria or create protocols
of their own.

See Properties and protocols, page 202.
A protocol typically defines the following layout and display aspects:
* The number and arrangement of image segments (viewers)
» The initial rendering parameters for each viewer
» The linking of viewers for synchronized navigation in multiple viewers
» The availability and location of toolbars
» The availability and location of tool cards
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Selecting a different 1. Drop down the protocol menu and select a different protocol.
protocol

Further up in the Protocol menu, you find alternative system suggestions for the
current dataset. Further down in the list, you find all protocols that exist in your
system. These protocols are grouped by monitor configuration and by modality
or modalities.

2. Select one of these protocols to change the screen layout.

Viewers and viewer layouts

After you have loaded one or several studies, series, or volume datasets, Visage 7
displays the images in one or several viewers.

Use the following controls and the various tools from the toolbars to optimize and
read image data. See also Tools, page 60.

Use the mouse if you want to rearrange datasets in viewers: Click any of the four
corners of a viewer where the image text is shown. Drag the thumbnail that rep-
resents the data in this viewer to another viewer.

Layouts toolbar

Axial+MPR Axial+MPR* MIP+hPR MPRE+%RT MPR + 30 MIP MPR+Scout Axial Current+Prior 3 on 3 Current+Prior

With the buttons of this toolbar you can switch between various viewer layouts that
are suitable for the loaded data. These layouts have been defined in the active pro-
tocol. Different protocols offer different sets of layouts.
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Selecting a layout Click one of the buttons on this toolbar.

Tip

Double-click a viewer in any of the available layouts or use this tool to show this
viewer fullscreen.

)
W

Double-click again to return to the original layout.

If the layout you are looking for is not shown on the Layouts toolbar, add it to this
toolbar.

1. Right-click the toolbar and select Show Layout from the context menu.
2. Select the layout.
3. Now click the new layout button that has appeared on the toolbar.
Rearranging the Lay- You can rearrange the Layouts toolbar for frequently used protocols.
outs toolbar 1. Drag a layout along the toolbar to show it in a more prominent place.
-Or-

Right-click a layout and select Make default from the context menu to show this
layout right after loading a study.

-Or-

Add or remove layout buttons on the toolbar with Show Layout or Hide Layout
from the context menu.

2. Select Save Layout Preferences from the context menu to save these changes

for your user account.
Creating a new layout By creating a new layout you can arrange images in a way suitable for reading a

particular case.

1. Right-click the Layouts toolbar and select New Layout.

2. Move the cursor across the matrix of available viewers.
Selected viewers appear black.

3. Click to complete viewer selection.

4. From the thumbnail section, drag images into the viewers.

5. Click the Save Sort Order button to save the new layout and image arrange-
ment in a DICOM presentation state.

(el

In Study Browser, the presentation state appears as a new series with modality
PR. The next time you load this study, images will be displayed in the new layout
automatically.
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Thumbnail section

At the bottom of the screen the thumbnail section might be shown. If the thumbnail
section is currently not shown, click the small arrow that points up at the bottom of
the screen.

Topogra
ocalizer:

. B&2img | E6img

Initially, the thumbnail section shows the study (or studies) that you have loaded into
the View window as well as any prior studies that were identified by the system as
potentially relevant for a case.

A green border around a thumbnail indicates that this image set is currently shown
in the active viewer. Click a thumbnail with a green border to highlight the active
viewer briefly.

A green triangle in the lower right corner of a thumbnail indicates that this image
set is shown in one of the other viewers on the screen.

A gray triangle in the lower right corner of a thumbnail indicates that this image set
had been displayed in a viewer at some time during the current session but has
been unloaded in the meantime.

A cube symbol indicates that a thumbnail represents a volume.

O: Hals Spir:
(thick). In this case, this would be a volume that contains 69 images.

A folder symbol indicates that a thumbnail represents subsets of images.

In this case, this would be 20 time series containing 32 images each.

20071011 @D Lo A thumbnail with background hatching represents a prior study that has not been
a7 loaded or expanded yet.

Ling zarcef PET/CT2
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Study dates are color-coded:

+ Typically, the study date of the current study, that is the study that you have
loaded from Study Browser, is shown white with a black background.

+ The study dates of prior studies are shown red with a white background.

+ The study dates of additional and more recent studies are shown green with a
black background.

Thorax W 2016-Feb-26 Thorax W 2015-Jul-18 Thorax W
2zlaiy 23 2: at 2: laE
(All Images,

1img’

Tip

You can modify this color coding for your user account.

Showing DICOM series Right after you have loaded a study, image sets are arranged in the thumbnail sec-
tion as defined by the active protocol.

Right-click the thumbnail section of a study and select Show DICOM Series from
the context menu.

Show DICOM Serierk
Sort by time a

1000: 9
) |(key vid
Show Images...
Show Reports... 4 |1img

All series of this study are now displayed in their DICOM hierarchy.

Sorting thumbnails by Right after you have loaded a study, image sets are arranged in the thumbnail sec-
time tion as defined by the active protocol, which is by relevance rather than in chrono-
logical order.

Right-click the thumbnail section and select Sort by time from the context menu.

Show DICOM Series
Sort by time

) |(key vid
Show Images...
Show Reports... 4 |1img

Thumbnails are now sorted by acquisition time.

Showing images or 1. Right-click a thumbnail with a folder symbol and select Show Images from the
subsets of data context menu.

The thumbnail folds out and shows the image sets it contains.
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2. Click the Close button to close the foldout again.

Viewing reports If a preliminary or final report exists for a study, you can preview it in the thumbnail
section.

Right-click a study for which a preliminary or final report exists and select Show
Reports from the context menu.

XR TOE SPEC Show DICOM Series

Sort by time
Show Images...

2%1 img;, & 2¢ img, =

Scrolling in the thumb- If more studies or image sets have been loaded than can be shown in the thumbnail
nail section section at a time, a white triangle is shown at the right edge of the thumbnail sec-
tion. This triangle indicates that there are more thumbnails further to the right.

Drag any of the shown thumbnails to the left to scroll in the thumbnail section.

Collapsing or expand- 1. Click a study date to collapse the study.
ing studies

3. Click the study date a third time to expand the study again.

Showing all studies ofa  Move the slider to the left of the thumbnail section all the way up to show all studies
patient that exist for this patient on the Visage 7 server.

2012-Apr-27 2011-Mrz-29 201 0-Apr-20 2008-Apr-17 2007-Mz-07 2006-Apr-24 2005-Nov-11
2152: Mam We P i e : i

¥

&= 4 img
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View windows

Selecting more prior
studies

Controlling display of
prior studies

Popup viewer

Updating the thumbnail
section

If you find more prior studies that you consider relevant for your case, select them.

Click the pin symbol in front of the study date to select a study.

), (ETIEIESE - 020

If a large number of studies exist for a patient on the Visage 7 server, use the slider
to the left of the thumbnail section for a better overview.

Slider position bottom: shows only loaded studies and studies you selected with a
pin symbol.

Slider position center: shows all the above studies plus studies preselected as rele-
vant prior studies by the system as a result of auto-prior loading settings.

Slider position top: shows all studies of this patient on the Visage 7 server.

*
m |9860: Mam |1000: 215. G PR

Lmo) | I i/

limg | |1img 1 img B 4img

Double-click a thumbnail to show this image set in a separate floating window.

1: Topogra
(Localizers)

1 img™

For example, you can use this window to show a scout image, which can remain
open while you read images in the various viewers.

If images are still being uploaded to the Visage 7 server when you open a case,
update the displayed data at intervals.
1. Open the Study Navigator,
See Study Navigator, page 74.
2. Click Refresh to refresh both the Study Navigator and the thumbnail section.

)
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Loading image sets Drag a thumbnail from the thumbnail section into a viewer to load this image set.

(scroll)

| 14%

Mam ([8269: Mam 1
o) | (LmLo)

1img P 1.irl'lf_.'l 1img " 1img

Note

Not all image sets can be displayed in all viewers. For example, an MPR viewer
or a 3D viewer accepts only 3D volumes, but no 2D images. If you cannot show
2D images in a viewer, select a different layout and try again.

Tip

With large monitors or multiple monitors, dragging thumbnails into viewers might
mean that you have to drag thumbnails a long way.

Select Show Mini Drop Zone for your user account in such a case (File > Pref-
erences > Properties > User Interface).

When you now start dragging a thumbnail, a small image appears in the thumb-
nail section. This image represents the monitor layout. Dragging a thumbnail into
a viewer in the Mini Drop Zone has the same effect as dragging it all the way
across the monitor to the target viewer.

Unloading image sets Click viewer text in any of the four corners of a viewer and drag the thumbnail back
to the thumbnail section to clear a viewer.
-Or-

Right-click and drag the thumbnail back to the thumbnail section to remove only the
overlay dataset from the viewer but not the primary dataset.

-Or-

Select Show Mini Drop Zone for your user account and drag the thumbnail onto
the small red x in the Mini Drop Zone to clear a viewer or to remove the overlay
dataset.
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Loading an entire study Drag a study date from the thumbnail section into a viewer to load the entire study.

v i ¥ [2W:18F | 2D

Mam |[8269: Mam 1000
= o] | (Lmo) | [ike

1.irl'lf_.'l 4 1img i 4 1img p 1 im & 4 img 1img 4 1img

Viewer controls

Below each viewer, a bar with controls can be shown. These controls are within
easy reach of each viewer and help to optimize image display. For example, you
can use the viewer controls to change the zoom factor or window level for your
images.

From the viewer controls, you can select which type of image you want to display in
a viewer. The viewer controls bar offers different display options for different image
types. For example, if you are currently showing thick slices, you can change the
compositing mode here. See also Compositing modes for thick slices, page 56.

1. From the viewer context menu or tool palette, select Viewer Controls to show
this bar.

60 W:388 | MIP Vk 10mm ¥ | 41%
Viewe! Type

Thin MPR.

v Maximum Intensity (MIF)
Minimum Intensity (MinIF)
Average Intensity (AvIF)

L Inverse

Display...

-Or-

Click to select window level, slice thickness, or zoom factor and overwrite these
settings.
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Navigation and display options for volume datasets

Crosshair navigation in
MPR viewers

These options are available only if you have loaded volume datasets. This means
that these options are available in MPR viewers or 3D viewers but not in 2D view-
ers.

In MPR viewers, scoutline crosshairs indicate the orientation and position of the
slices that are currently shown in other MPR viewers.
» Ablue line represents the image in the MPR segment with the blue viewer frame.

» A green line represents the image in the MPR segment with the green viewer
frame.

» Ared line represents the image in the MPR segment with the red viewer frame.

¥ | Thin MPR * [ 1.0mm

Note

The scoutline crosshair is shown only in viewers that show orthogonal views of
the same volume dataset. Crosshair lines are not shown in viewers that display
2D data, or in isolated MPR viewers.

Small arrows that point to the crosshair indicate the viewing direction in the other
two MPR viewers.

When you move the cursor over the center of the crosshair, the cursor changes its
shape. Use the crosshair center to drag the entire crosshair. This moves two view
planes simultaneously and shows new slice images in the other two MPR viewers.

The move cursor is not available for partial crosshair display.

When you move the cursor over a crosshair line, the cursor changes its shape.
Drag this line up or down to move through the volume along one of the other two
standard axes. Dragging a crosshair line updates one of the other two MPR view-
ers.

Visage 7
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View windows

Compositing modes for
thick slices

When you move the cursor over the rotation handles (small dots), the cursor
changes its shape. Drag the cursor up or down to rotate the crosshair. Crosshair
rotation updates the two other MPR viewers and generates images with nonstan-
dard views.

When you click one of the small triangles on the crosshair lines along the edges of
the image the crosshair lines appear dotted.

You can now change the slice thickness in the MPR viewers by dragging the han-
dles up or down. When you release the mouse button, the slice thickness indicator
and the selected thick slice compositing mode in the viewer controls are updated.

The default slice thickness for reconstructed images in MPR viewers is specified in
the active protocol. The default slice thickness is usually the slice thickness of the
original scans.

You can change the slice thickness for your loaded images and then choose a dif-
ferent compositing mode for thick slices from the viewer controls.

+ Thin MPR
In this mode, slices are shown in their original slice thickness.
* Maximum intensity (MIP)

In this mode, data values are computed as the maximum of the values of the
original slices.

*  Minimum intensity (MinIP)

In this mode, data values are computed as the minimum of the values of the orig-
inal slices.

» Average intensity (AvIP)

In this mode, data values are computed as the average of the values of the orig-
inal slices.

-Or-

Use this tool or keyboard shortcut T to switch from display of thin slices to display of
thick slices and vice versa.

=

Use this tool or keyboard shortcut Shift + T to toggle compositing modes (MIP,
MinilP, AVIP).
[RLTHS

Ballan
HUIES
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Display options in 3D The 3D viewer displays a 2D projection of a volume. In this viewer, you can choose
viewers between several volume rendering techniques and volume display modes.

3D MIP (maximum intensity projection)

Visage 7 calculates the maximum of all the voxel values that lie on the virtual
viewing ray behind this pixel. 3D MIP requires a grayscale color map.

VRT (volume rendering technique, also called emission-absorption model)

This technique maps data values to colors and transparencies defined in a 3D
color map. The voxels are interpreted as small diffuse light sources that emit and
absorb light in the direction of the viewer. Each voxel is interpreted as a local dif-
fuse light source, without additional shading.

VRT (diffuse)

This rendering technique is similar to VRT. However, an additional virtual light
source and a diffuse lighting model adds shades to the surfaces of the volume.
For example, curved surfaces become darker toward the edges, which results in
a more natural appearance.

VRT (specular)

In addition to diffuse shading, specular shading uses a lighting model that
reflects light dependent on the angle between the incoming and reflected light.
This means that on smooth surfaces users see highlights, and that shading
becomes even more expressive than with diffuse shading. Specular shading is
especially good for large surfaces with fine detail.

Perspective projection

This projection mode gives a more natural impression. Perspective projection
corresponds with the everyday experience of perspective distortion. Objects that
are far away appear smaller than objects close by.

If perspective projection is not selected, orthographic projection is active.
Orthographic viewing is like viewing an object through a lens with a very long
focal distance, a telelens. The viewing rays are almost parallel to each other and
no perspective distortion occurs. In orthographic mode, you can perform mea-
surements in the image plane, for example distance measurements and angle
measurements. With perspective projection turned on, measurements are not
possible.

The Perspective Projection toggle is available only from the 3D viewer context
menu (Properties > Perspective Projection) but not from the viewer controls.

Smart sampling
This option reduces artifacts in the volume display.

The Smart Sampling toggle is available only from the 3D viewer context menu
(Properties > Smart Sampling) but not from the viewer controls.

Visage 7
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View windows

Warning symbols, image text, and the display of menu bar and toolbars

Warning symbols

Scale

Showing or hiding

Aside from image information, viewers contain information about the loaded data in
the form of image text and symbols.

These symbols alert you to the fact that an image is shown with reduced image
quality or that warnings exist concerning the displayed images.
Low resolution warning

A red bullet in the lower right corner of a viewer indicates reduced image quality.
The low-resolution warning appears while the dataset is still being loaded and the
system generates full image quality. The low-resolution warning also appears if a
low streaming compression level is selected.

See Best Image Quality, page 122, for information on how to load individual images
in best image quality but with slower download time.

Image synchronization in progress

A yellow bullet indicates that the image has not yet been updated with your latest

image processing step. The previous image is still displayed while image process-
ing is performed in the background. When image processing is complete, the yel-

low bullet disappears.

Miscellaneous warnings

A yellow warning triangle in the upper left corner of the images indicates that warn-
ings exist for this dataset.

Note

Do not use images that show a red or yellow bullet for primary diagnosis.

Find out more about warnings by clicking the yellow warning triangle if you see it
in your viewers.

In calibrated image types, for example, CT images, a scale can be shown on the
right edge of the viewers. The scale looks like a small ruler and indicates centime-
ters. When you zoom in on an image the scale switches to millimeters.

If the image text is in your way during image processing, you can hide it.

image text Use View > Show in Viewer to hide or redisplay image information.
-Or-
Use tools from the tool palette to show or hide image information. See Tools for
switching image text and graphics on and off, page 126.
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Viewers and viewer layouts

Resizing image text,
orientation cube and
scoutlines or crosshair

Showing or hiding
menu bar and toolbars

Privacy mode

Tip

When you are working with a small window size and low screen resolution, it is
not always possible to show image texts and symbols correctly. Texts are trun-
cated, and symbols, the scale, or a color bar might be shown on top of each
other. Maximize the program window and then switch to fullscreen mode for dis-
play of all image information.

Position the cursor over image text, hold the Ctrl key down, and rotate the mouse
wheel to show the image text in all viewers larger or smaller.

-Or-

Position the cursor over the orientation cube, hold the Ctrl key down, and rotate the
mouse wheel to enlarge the orientation cube and to show scoutlines or crosshair
lines thicker.

Select View > Autohide > Autohide Menu Bar or View > Autohide > Autohide
Toolbar to hide the menu bar and/or toolbars.

The menu bar and toolbars reappear when you move the mouse to the upper edge
of the screen.

Switch to privacy mode if you want to hide any information that would identify a
patient temporarily. You would use this mode for presentation purposes, for exam-
ple.

Select File > Privacy Mode > View Screen Only.

See also Privacy mode, page 38.

Visage 7
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Tools

Arrangement of tool-
bars

Resizing toolbars

Tool palette and viewer
context menu

Keyboard shortcuts

A number of buttons are shown along the edges of your screen after you have
loaded data. These buttons represent tools with which you can start functions or
select options with a single mouse click. The tools are grouped in toolbars. Which
toolbars are shown when you first load data, the position of toolbars, and the
assignment of tools to toolbars depends on the selected protocol.

Select View > Show Toolbars to show more toolbars or to hide toolbars.
-Or-
1. Click the toolbar handle to the left or above a toolbar.

2. Drag the toolbar across the screen and drop it wherever you prefer it to be
shown.

When you drag a toolbar to the left, right, or bottom edge of the screen, a new tool-
bar section appears there. When you drag a toolbar anywhere else on the screen, it
turns into a floating window.

If you are working with more than one monitor, use View > Show Toolbars > Syn-
chronize with other monitors to synchronize your arrangement of toolbars on all
monitors.

Position the cursor over the toolbar section, hold the Ctrl key down, and rotate the
mouse wheel to show tools larger or smaller.

A selection of the most frequently used toolbar buttons is also available from right
within a viewer.
1. Right-click a viewer to show the tool palette, viewer context menu, or both.

In your user profile, you can define whether tool palette, viewer context menu, or
both are shown. See Configure Tool Palette dialog box, page 201.

2. Click the Show Context Menu button on the tool palette to show this menu if it is
not displayed when you right-click a viewer.

3

Some of the functions and options that are represented by toolbar buttons can also
be selected with keyboard shortcuts. These keyboard shortcuts are active even if a
toolbar or button is currently not displayed on the screen.

A number of keyboard shortcuts have been predefined for your system. These
shortcuts are indicated in brackets after the tool name in this document.
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Tip

Select Help > Keyboard Shortcuts in the main menu to show the list of factory-
default shortcuts. From this dialog box, you can copy the shortcuts list and print it
out with another software program.

On your keyboard, press Ctrl + A (Windows) or Cmd + A (Mac) to select all
shortcuts and then Ctrl/Cmd + C (copy).

Open your word-processing program.

Paste the shortcuts list (Ctrl/Cmd + V) and then print it (Ctrl/Cmd + P).

Note

Users with appropriate user rights can change the assignment of keyboard short-
cuts for their own user account or for other users as well. See Configure Key-
board Shortcuts dialog box, page 199.

Therefore, the keyboard shortcuts indicated in this document might no longer be
correct for your system.

Basic navigation and image display tools

This set of tools is available in almost all protocols. Typically, these tools are part of
the Standard Tools toolbar.

Default Navigation

W

This tool is assigned to the function that is most frequently used in the context of an
image type and viewer type.

1. Click the Default Navigation button to select this tool.

2. Use the left mouse button to perform the function that is assigned to the default
navigation tool.

Zoom

¢

With this tool, you can enlarge or reduce images interactively.
1. Click the Zoom button to select this tool.

2. Click a viewer and hold the mouse button down.

Visage 7
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3. Drag the cursor up to zoom in.
-Or-

Drag the cursor down to zoom out.

Tip

Use the middle mouse button (or wheel button) to zoom images without selecting
the Zoom button on the toolbar first.

.

Use the percentage box in the viewer controls to change the image display size.

Pan

With this tool, you can move an image within a viewer.
1. Click the Pan button to select this tool.

2. Drag the mouse across a viewer to move the image within the viewer.

You typically use this tool after you have zoomed an image and relevant image
information has moved out of the viewer.
Tip

Use the right mouse button to pan images without selecting the Pan button on
the toolbar first.

Inverse (.)

N

This tool inverts the image in the active viewer. Inversion means that light areas are
displayed dark and dark areas are displayed light.

Inversion is not possible for the 3D viewer.
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Tip

The factory-defined keyboard shortcut for the inversion tool is the period key.

Edge enhancement

»

Use this tool to optimize image quality and to increase contrast between structures
in slice images.

1. Click the Edge Enhancement button to select this tool.
2. Drag the mouse up or down to adjust image sharpness.
-Or-

Use the edge enhancement slider on the Display tool card to adjust image
sharpness.
Tip

The edge enhancement filter is particularly useful for improving the sharpness or
definition of XA images.

Window level tools

With this set of tools, you can change contrast and brightness in images.

Window Level

>

With this tool, you can change the contrast and brightness in images interactively.
1. Click the Window Level button to select this tool.
-Or-

Use the left and right mouse button to window images without selecting the Win-
dow Level button on the toolbar first.

(\%}

2. Click a viewer and hold the mouse button or mouse buttons down.
3. Drag left or right to change the window width (contrast).
_Or_
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Histogram

Windowing in fusion
mode

Drag up or down to change the window center (brightness).
If configured, dragging left or right only affects the upper window width value for PT,
SPECT, ST, NM images.

While the Window Level tool is active, a histogram of grayscale values or HU val-
ues is shown in the lower left corner of the viewer. In the histogram, a small white
bar shows window settings graphically. The bar moves when you move the window
center and expands or shrinks when you change the window width.

If the histogram is in your way, you can hide it. See Toggle Histogram, page 126.
When you window an image in fusion mode, this affects the window level of the pri-

mary dataset. To window the image of the overlay dataset, press and hold the Shift
key while you window the image.

Auto Window Level in ROl

®

With this tool, you can optimize contrast and brightness in images by focusing on a
specific region of interest.

1. Click the Auto Window Level in ROI button to select this tool.
2. Click and draw an ellipse around your region of interest.

When you release the mouse button, the system identifies the minimum and maxi-
mum pixel intensities in this ROI. The system then applies these window levels to all
images in this viewer and in all linked viewers.

Tip

This tool is particularly useful with image data that is not calibrated. For example,
use Auto Window Level in ROl in MR images in which the local receive coil
sensitivity varies considerably and with it the voxel intensity.

Show Window Level Presets

i

Use this tool to show a list of all window level presets that exist for an image type.

1. Click the Show Window Level Presets button to open a menu.

+ Default

CT bone
CT organs

CT lung
CT brain
CT angio

Window/Level Presets, ..

2. Select a window level preset from the list.
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-Or-

Select Window/Level Presets to define new window level presets. See Config-
ure Window/Level Presets dialog box, page 198.

Enlarge/Reduce Window Width

LY

Use these tools to enlarge or reduce the window width step by step.

The adaptation factor and fix point can be configured in the property settings for
these tools. See Properties dialog box, page 202.

The factory default settings are enlargement or reduction of the window width by a
factor of 2 while the window center remains unchanged.

Save Current W/L as Presentation State

=

Use this tool to save window level adjustments permanently.

Clicking this tool saves window level adjustments in a DICOM presentation state. In
Study Browser, the presentation state appears as a new series with modality PR.

The next time you load this study, images will be displayed with the saved window

levels automatically.

Tools for adjusting the display size

In addition to interactive zooming (see Zoom, page 61), Visage 7 offers several
other tools for optimizing image display size quickly.

Fit Width/Height, Fit Width, Fit Height

A
L)

1-4-} S
i)

Fit Width/Height fits images optimally in their viewers. Fit Width makes optimum
use of the viewer width, and Fit Height makes optimum use of the viewer height.

If an MPR viewer is active when you click one of these buttons, the images in the
active viewer and in all linked viewers are resized. If the 3D viewer is currently
active, only the volume display is resized, other viewers are not affected.

Visage 7
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Zoom 100%

This tool shows images in their original size. This means that one pixel from the
image file corresponds to exactly one pixel on the monitor.

If an MPR viewer is active when you click this button, the images in the active
viewer and in all linked viewers are resized. If the 3D viewer is currently active, only
the volume display is resized, other viewers are not affected.

Tip

Clicking the Zoom 100% tool has the same effect as selecting zoom level 100%
(1:1) from the viewer controls.

Magnifying Glass

Q

Use this tool to be able to see details without having to zoom the entire image.
1. Click the Magnifying Glass button to select this tool.
2. Click an image and hold the mouse button down.

A rectangular area appears, which is magnified by a configurable factor (typically
factor 2).

3. Drag to move the rectangle across the image.

This movement gives you the impression of holding a magnifying glass in your
hand.

4. Rotate the mouse wheel while you still hold the left mouse button down to
increase or decrease the zoom factor of the magnifying glass.

5. Release the mouse button to turn the magnifying glass off.

The tool is still selected and you can click again in another viewer and use the
magnifying glass there.

6. Click the tool on the toolbar a second time.

Only now is the Magnifying Glass tool turned off again.

Tip

Choose multiple Magnifying Glasses rather than a single Magnifying Glass
whenever you want to inspect and compare magnified sections in more than one
viewer. See also Magnifying Glasses, page 119.
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Tools for rotating and flipping images

With the tools in this section you can rotate or flip images.

Be sure to show the orientation cube or orientation labels in the viewers before you
use these tools. Select View > Show in Viewer > Orientation Cube, or View >
Show in Viewer > Orientation Labels to show these orientation aids.

Rotate Clockwise, Rotate Counterclockwise

& 9

These tools rotate the image in the active viewer by 90° clockwise or counterclock-
wise.

Rotation affects only the viewer in which you clicked. Images in linked viewers are
not affected.

Flip Horizontally, Flip Vertically

A Ib.
— ”
These tools rotate the image in the active viewer around its vertical or horizontal

axis. Rotation affects only the viewer in which you clicked. Images in linked viewers
are not affected.

Note that you cannot flip the volume in the 3D viewer.

Rotate in Plane

Use this tool to rotate an image with the mouse.

1. Click the Rotate in Plane button to select this tool.
2. Click an image and hold the mouse button down.
3. Drag to rotate the image.

Rotation affects only the viewer in which you drag. Images in linked viewers are not
affected.

Tip

Use this tool, for example, to straighten up images that were acquired tilted.
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Save Flip/Rotate as Presentation State

b

Use this tool to save flipped or rotated images permanently.

Clicking this tool saves flipped or rotated images in a DICOM presentation state. In
Study Browser, the presentation state appears as a new series with modality PR.
The next time you load this study, affected images will be displayed flipped or
rotated automatically.

Tools for scrolling in image stacks

The tools in this section help you to scroll through the images in image stacks.

Browse Slices

LF=

With this tool, you can use the left mouse button or the mouse wheel to move
through an image stack in a 2D viewer or MPR viewer.

Browse Slices is the standard navigation tool in 2D viewers and MPR viewers.
1. Click the Browse Slices button to select this tool.

-Or-

Click the Default Navigation button or hold the Ctrl or Cmd key down.

2. Drag up or down or use the mouse wheel to scroll forward or backward through
the image stack.

When you drag quickly, Browse Slices skips slices so that you reach your desti-
nation as quickly as possible. If you use the mouse wheel for scrolling, whether
or not slices will be skipped depends on whether the tool Skip Slices While
Scrolling is also selected. See also Skip Slices While Scrolling, page 69.

Note

When scrolling in an MPR viewer in thick-slice mode, you can define the scrolling
increment, that is the overlap between thick slices, with the property Tools, Slice
Browsing, Overlap of Thick Slices. Refer to section Properties dialog box,
page 202, to learn how to change properties for your user profile.

Overlap 0 means that each click of the mouse wheel scrolls the distance of the
slice thickness of a thick slice. With overlap 1, scrolling is very smooth because
one click of the mouse wheel scrolls the distance of an original thin slice. Any
value in between 0 and 1 defines an overlap. For example, 0.2 means that when
you scroll to the next thick slice, this slice overlaps approximately 20% with the
previous slice.
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Tip

When you browse slices in MPR viewers, scrolling up with the mouse wheel,
arrow keys, or by dragging with the left mouse button scrolls deeper into the
respective viewer. By contrast, scrolling down scrolls further out.

Referring to standard orientations, this means that scrolling down results in the
following browsing behavior.

+ In axial slices and view F (feet), you move toward the patient's feet.
* In coronal slices and view A (anterior), you move toward the patient's front.

+ In sagittal slices and view L (left), you move toward the left side of the patient.

Browse in All Priors

%,

Use this tool to change the behavior of the Browse Slices tool.

v A current study and more than one prior studies have been loaded.
v' A layout is selected that shows current and prior study side by side.
1. Click Browse in All Priors to select this tool.

2. Click Browse Slices.

3. Point to a viewer that shows an image of the prior study.

4. Turn the mouse wheel.

You now scroll images in all viewers that show prior studies. Scrolling is synchro-
nized so that you can compare the images from the current study with those of the
various prior studies.

Skip Slices While Scrolling

4

This tool affects the behavior of the arrow keys and the mouse wheel when you use
the tool Browse Slices.

If the Skip Slices While Scrolling tool is selected, scrolling quickly with the mouse
wheel or arrow keys results in slices being skipped. Canceling the selection of this
tool ensures that you will not skip images when browsing slices with the mouse
wheel or arrow keys. Scrolling might become slower if the tool is turned off.
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Note
Skip Slices While Scrolling is selected by default.
You need to clear it explicitly if you want to see every single image in an image
stack when you browse slices.
-Or-
Use the tool Browse Continuously instead of the tool Browse Slices when
scrolling through an image stack to be sure you see all slices.
Browse Continuously
This tool is an alternative to Browse Slices. Browse Continuously has a cine-like
effect with a steady browsing speed. This tool shows all the images in an image
stack, it does not skip slices even if you move the mouse fast.
1. Click the Browse Continuously button to select this tool.
2. Start dragging up or down to start scrolling forward or backward through the
image stack.
After an initial mouse movement you no longer need to move the mouse. Hold the
mouse steady and the left mouse button down. Scrolling continues at a steady
speed showing one image in the image stack after the other until you reach the last
image in the stack.
Note
When you scroll in an MPR viewer in thick-slice mode, you can control the slice
overlap for scrolling with properties settings. See Browse Slices, page 68, and
Properties dialog box, page 202.
Scroll Page by Page (Mouse Wheel Mode)
0
o
Some protocols, typically those for ultrasound and plain-film images, present
images as so-called tiles rather than in image stacks. Tiled presentation arranges
images next to each other, and scrolling causes all viewers in this presentation
mode to be updated synchronously.
Two modes exist for scrolling in tiled presentation mode:
+ The Scroll Page by Page tool is selected.
Use Browse Slices or scroll with the mouse wheel to replace the contents of all
viewers with the next page of new images.
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+ The Scroll Page by Page tool is not selected.

Browse Slices or the mouse wheel causes each viewer to advance by just one
image at a time. This gives you the impression of images flowing through your
viewers, for example, from the lower right to the upper left.

First Slice (Home), Previous Slice (1), Next Slice (|), Last Slice
(End)

32 o8 o3 %%

Use these tools to scroll slices in viewers that show image stacks of either scans or
reformats.

Tip

The factory-defined keyboard shortcuts for browsing to the previous or next slice
are the up and down arrow keys.

Previous Thick Slice (PgUp), Next Thick Slice (PgDn)

8 °F

If you have switched to thick-slice display in a volume dataset, use these tools to
browse slices.

Play/Pause

>

With this tool, you can play back images in a stack or time series, or you can rotate
around a volume in a 3D viewer. The tool gives you the impression of a movie being
played back.

Use the Cine tool card to define playback parameters such as playback type, play-
back range, frame rate and playback speed. See Cine, page 136, for details.

Tip

While the movie is being played back, the toolbar button changes its shape. Use
the Pause button to interrupt or stop the playback.

1l
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Synchronized display If you have loaded appropriate data, Visage 7 synchronizes cine display in two or
of pre- and post-stress more viewers based on ECG information embedded in the images.

cardiac echo A typical application for synchronized cine display is a comparison of cardiac ultra-

sound (cardiac echo) sequences before and after physical exercise (pre- and post-
stress). After stress, the heart rate is higher. To allow comparison of the pre-stress
and post-stress sequence, the system slows down playback of the post-stress
sequence (or speeds up playback of the pre-stress sequence). As a result, images
of corresponding heart phases are shown side by side at any time during playback.

Synchronization of cine display based on ECG data is defined in the active protocol.

Show Multiframes in Single Tiles

= o

With this tool, you can switch display of multiframe images:
* Collapsed
The multiframe objects are shown in single viewers as an image stack.

Use the tools Next Frame (Ctrl/Cmd 1), Previous Frame (Ctrl/Cmd |), First
Frame (Ctrl/Cmd Home), Last Frame (Ctrl/Cmd End) to scroll through the
image stack of a collapsed multiframe.

-Or-

Click a viewer and drag up or down or hold the Ctrl/Cmd key down while you
turn the mouse wheel to scroll frame by frame.

-Or-

Click a viewer and simply turn the mouse wheel (Ctrl/Cmd key not held down)
to scroll on to the next multiframe object.

+ Expanded

Each of the individual images of a multiframe object occupies a separate viewer.

Tools for browsing datasets

The tools in this section help you to browse datasets without having to return to the
Study Browser.

Choose which of these tools you use or combine tools according to your preferred
mode of working.

» Select and load multiple datasets in the Study Browser.

Use the following tools to scroll through the loaded data: Next Study, Previous
Study, Next Volume (Ctrl/Cmd —), Previous Volume (Ctrl/Cmd <), Next Image
Set, Previous Image Set, Next N Series, Previous N Series, Next Phase (—),
Previous Phase («<).

» Filter and sort the list in the Study Browser so that it shows the studies you want
to read next. Load the first of these studies.
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Use the following tools to move on to the next study: Next Study from Study
Browser, Previous Study from Study Browser.

Next Study, Previous Study
) =
» @«

These tools expect you to have loaded more than one study.

Use Previous Study/Next Study to scroll through the loaded studies.

Next Volume (Ctrl/Cmd —), Previous Volume (Ctrl/Cmd <)

J =
» «

These tools expect you to have loaded more than one volume dataset.

Use Previous Volume/Next Volume to scroll through the loaded datasets.

Next Image Set, Previous Image Set
(S &
» *
These tools expect you to have loaded more than one image set.

Use Previous Image Set/Next Image Set to scroll through the loaded series.

Next N Series, Previous N Series

R &

If you have loaded a large number of image sets into multiple viewers, use these
tools to scroll image sets.

Next Phase (—), Previous Phase (<)

oo oo
» «

If you have loaded a time series, use Previous Phase/Next Phase to scroll through
the phase images.

Visage 7
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Next Study from Study Browser, Previous Study from Study

Browser
= =
et <X

Use these tools to load the study right above or below the one currently selected in
the Study Browser.

Workflow integration tools

Visage 7 can be integrated in a variety of clinical workflow programs, such as radiol-
ogy information systems (RIS), hospital information systems (HIS), or picture
archiving and communications systems (PACS). The level of workflow integration
depends on the particular setup and configuration of systems in your organization.
Therefore, some functions described here might not be available in your installation
or might be configured to behave slightly differently than described here.

Study Navigator

-

This tool opens the Study Navigator dialog box, from where you can select and
load more studies of the current patient. The tool appears gray if the current study is
the only study that is stored on the Visage 7 server for the current patient.

When you open the Study Navigator for the first time, all studies that are stored on
the server for the current patient are shown.

Study Navigator

Filter

=
)

BE8EBB6EEE

»
>
>
>
>
>
>
>

8/8 studies shown. 4 additional studies in archive
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Selecting more rele-
vant prior studies

The studies that have already been loaded are marked with a green box along the
right edge of the dialog box. Prior studies that are potentially relevant for a case are
shown in standard display. Any other studies are slightly grayed out.

You might consider more prior studies relevant for the case than the ones sug-
gested by the system.

Click the pin symbol of such a prior study.

Study Navigator

Filter

Controlling display of
prior studies

Filtering the study list

Expanding and collaps-
ing studies

If a large number of studies exist for a patient on the Visage 7 server, use the slider
for a better overview.

Study Navigator

Filter

Slider position left: Shows only loaded studies and studies you selected with a pin
symbol.

Slider position center: Shows all the above studies plus studies preselected as rele-
vant prior studies by the system as a result of auto-prior loading settings.

Slider position right: Shows all studies of this patient on the Visage 7 server.

Type a search string in the Filter box.

The study list is updated showing loaded studies, studies you marked with the pin
symbol, and studies whose study description or study date/time fields contain this
string.

1. Click a study to show thumbnails of the images, series, and volume datasets the
study contains.

-Or-

Click Expand to show thumbnails of all studies.

2. Click the study again to hide thumbnails again.
-Or-

Click Collapse to hide thumbnails of all studies.

=
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Relative study date

Display mode Compact,
Standard, or Multi-Line

Updating Study Naviga-
tor and thumbnail sec-
tion

Use the menu in the upper right corner of the dialog box to toggle study date display
modes.

Relative Study Date

Compact (no scrollbar)
Standard
* Multi-Line

Use the menu in the upper right corner of the dialog box to switch between different
ways of displaying image thumbnails in expanded studies.

Relative Study Date

Compact (no scrollbar)

L3

Standard

* Multi-Line

If images are still being uploaded to the Visage 7 server when you open a case, this
is indicated by a plus sign on the Study Navigator icon in the View window and by
a spinning symbol in the Study Navigator dialog box.

O CONTRAST 371 +125

Once all images have arrived, they are loaded automatically. New images are
marked with a plus sign in the Study Navigator and thumbnail section.

Study Nevigator

Mg

§ 2014 22

§ 2014-Oct-14
§ 2013-Aug-12
% 2013-Feb-11
& 2012-Aug-19
¥ 201
® 201

Loading studies from
Study Navigator

Wi
MRI ABDOMEN W AND WO
US ABDOMEN SURVEY C
MRI ABDOMEN W AND WO CONTRAST

Accesslon17772c

Accessionloc9el

066808

To load new images manually, click the Refresh button in the Study Navigator dia-
log box.

)

1. Select the box all the way to the right of a study.
The box turns green.
2. Click Load.
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Loading individual 1. Click a study to show thumbnails of the images, series, and volume datasets it
image sets contains.

2. Drag a thumbnail from the Study Navigator into a viewer.

Study Navigator

Filter

7e128737

147704fc

Mammographie;li

Tip

With large monitors or multiple monitors, dragging thumbnails into viewers might
mean that you have to drag thumbnails a long way.

Select Show Mini Drop Zone for your user account in such a case (File > Pref-
erences > Properties > User Interface).

When you now start dragging a thumbnail, a small image appears in the thumb-
nail section. This image represents the monitor layout. Dragging a thumbnail into
a viewer in the Mini Drop Zone has the same effect as dragging it all the way
across the monitor to the target viewer.

Multiple Protocols If you are using more than one monitor for reading images with Visage 7 Client, you
can define which study or studies you want to show on which monitor.

1. Select the check box Multiple Protocols.

2. Select a monitor column for each study.
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Study Navigator

Filter

(3]

>
>
>
>
>
>
>
>

BBEEERES8

8/8 studie
¥ Multiple
S
3. Click Load.
Viewing a report If a report exists for a study, a report icon is shown which also indicates the report
status.

Click a report icon to show a preliminary or final report.

Study Navigator

Filter

7el28737

(7]

BBEEERES8

8/8 studies shown. 4 additional sti
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New Session

ez

Use this tool to create a new session.

New Session removes annotations, measurements or any changes to the display
of images that you made since you opened the study. New Session also reapplies
the protocol that was selected automatically at the time the images were loaded ini-
tially. New Session does not load new or additional images.

Update Session

=

Use this tool to load and add new images that were acquired since you loaded the
data.

Update Session keeps all annotations and measurements and applies a protocol
appropriate for the images that are loaded now.

Close Session

|

This tool unloads all data from a View window. The tool also closes all viewers, tool-
bars, and tool cards and leaves the View window entirely blank.

Switch to the Study Browser to select and load new data after you have clicked
Close Session.

Start/Stop Dictation

A

Use this tool to start or end dictating a report.
1. Click Start/Stop Dictation after you have loaded a study.

If you have loaded more than one current study, the system will ask you which
study the report refers to.

2. Start dictating your report.
3. Click the button again when you have finished the report.
This marks this study as reported on (dictation status completed).

Depending on your system configuration, ending dictation might load the next case
automatically.

Visage 7
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Reset Dictation
You cannot create a second report for a study for which a report has already been
dictated.
If you want to delete a report and create a new one instead, use this tool to reset the
dictation status of the currently loaded study. Start/Stop Dictation is available again
and you can dictate a new report now.
Go To Next Study
If you have selected more than one study for report dictation in your radiology work-
list, use this tool to move on to the next study.
If the Start/Stop Dictation tool is still turned on when you click Go To Next Studly,
you are prompted to confirm that the first report is finished.
Skip to Next Study
If your worklist supports skipping, use this button to mark the current study as to be
Skipped in the worklist. You proceed to the next study or item in the worklist.
Reports and Scanned Documents

_—

Click this button to open the reports window of your RIS.
Show Worklist
Click this button to open the worklist window of your RIS (radiology information sys-
tem), HIS (hospital information system), or PACS (picture archiving and communi-
cations system).
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Referrer Information

Click this button to open the referrer details window of your RIS (radiology informa-
tion system), HIS (hospital information system), or PACS (picture archiving and
communications system).

Tools for linking viewers

In Visage 7, many image navigation and image processing tasks can be synchro-
nized across viewers, which helps to compare images. For example, synchronized
scrolling means that when you scroll an image stack in a viewer, image stacks in
linked viewers scroll too. For example, synchronized zooming means that not only
the image in the active viewer is enlarged but all images in all linked viewers are.

Viewer linking is defined in the active protocol. After loading image data, the proto-
col decides which viewers are linked and with respect to which activities. Viewer
linking can be modified interactively. You use the tools described in this section to
redefine how activities are synchronized across viewers.

When you close a study or load new data, modifications to viewer linking are dis-
carded. To preserve your modifications, save your session or save the protocol. See
also Session management, page 25, and Properties and protocols, page 202.

Toggle Linking

Gu

Use this tool to turn viewer linking on or off. Toggle Linking affects all viewers that
are assigned to any of the linking groups that are defined in the protocol.

Link Current Position

&

Use this tool to align two 3D datasets based on a common reference point, which
are shown in side-by-side MPR viewers. The tool requires that appropriate linking
groups are defined in the active protocol.

1. Scroll to corresponding images in viewers that are currently not linked.

This means, cancel the selection of the tools Toggle Linking or Link Current
Position first.

2. Select the tool Position Crosshair and click to position the crosshair in the
same reference point in both datasets.

-Or-
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Press and hold the Alt key, and click to position the crosshair.
Use a landmark that can be identified easily, such as the bifurcation of the tra-
chea or a large calcification.
3. Select Link Current Position.
The viewers are now linked for synchronized scrolling. Visage 7 calculates a true
3D registration for the two datasets using the 3D position of the reference point and
the orientation of your MPR viewers. You can now scroll in any direction or rotate
MPR planes and the two datasets remain linked.
Reset Viewer Linking
&,
Use this tool to reset any dataset alignment made with the Link Current Position
tool.
Automatically Link Viewers
Use this tool to link scrolling in all corresponding 2D viewers in basic CT or MR pro-
tocols. Visage 7 will try to link all currently displayed image stacks that show the
same part of the body and that use the same spatial orientation.
For example, select Automatically Link Viewers in a layout that shows five axial
stacks and three sagittal stacks. Visage 7 links all axial stacks that show the same
part of the body, and also all sagittal stacks that show the same part of the body.
This creates two linking groups for synchronized scrolling.
Automatically Link Viewers reads DICOM information to identify corresponding
images.
Tip
Simply clicking Automatically Link Viewers links viewers in one study only.
Pressing and holding the Shift key down and then clicking Automatically Link
Viewers links viewers in all the loaded current and prior studies.
Shift + b
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Only two viewers
shown

More than two viewers:
2D viewers

Automatic Viewer Registration, Automatic Viewer Registration
(Translation Only)

A &R

Use one of these tools to link scrolling in viewers that show corresponding images.

Caution

Be aware that automatic registration does not always align images correctly.
Please verify registration results and correct registration manually, if necessary.

Technically speaking, Automatic Viewer Registration compares grayscale values
of pixels to identify corresponding structures and to align images. Therefore, Auto-
matic Viewer Registration can even link viewers that show images from a current
study and one or several prior studies.

The tools Automatic Viewer Registration and Automatic Viewer Registration
(Translation Only) use a similar algorithm, however, while Automatic Viewer Reg-
istration considers 3D translation and rotation, Automatic Viewer Registration
(Translation Only) only considers a 3D translation but no rotation.

Link Display Properties
éﬁa

Use this tool to synchronize changes to certain display properties such as modifica-
tion of the slice thickness to all linked viewers.

Link Scrolling

Use this tool as a shortcut to Edit Viewer Linking (see below). Link Scrolling syn-

chronizes various activities across viewers.

Clicking this tool has a different effect on different viewer types.

Select the Link Scrolling tool.

Scrolling, panning, rotating, flipping images and, for MPR groups, also zooming and
3D rotation is now synchronized.

1. Select the Link Scrolling tool.

2. Select all viewers that show series with a similar orientation and that you want to
include in synchronized scrolling.

Selected viewers are highlighted with a red border.

3. Click Accept and Exit in the lower right corner of the last selected viewer.
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More than two viewers:
MPR groups

Linking individual MPR
viewers or MIP viewers

Unlinking viewers

In a layout with more than two viewers that show 2D images, for example, X-ray
images, scrolling, panning, rotating, and flipping images is now synchronized.

An MPR group is a set of three MPR viewers that show MPR reformats from a 3D
dataset side by side, initially in axial, sagittal, and coronal orientation. These three
MPR viewers are linked automatically, that is by the protocol.

With the Link Scrolling tool you can link several such MPR groups, for example
one in a current examination and one in a prior examination. Linking MPR groups in
this way will synchronize the following activities in the current and prior examination:
scrolling, panning, rotating, flipping, zooming, and 3D rotation.

1. Select the Link Scrolling tool.
2. Click an MPR viewer in one MPR group.

This viewer and the other two MPR viewers in the group are highlighted with a
red border.

3. Click an MPR viewer in a second MPR group.
All six MPR viewers are highlighted now.
4. Click Accept and Exit in the lower right corner of the last selected viewer.
-Or-
1. Position the crosshair on the same reference point in both datasets.
2. Select the Link Scrolling tool.
3. Click an MPR viewer in one MPR group.

This viewer and the other two MPR viewers in the group are highlighted with a
red border.

4. Click an MPR viewer in a second MPR group.
All six MPR viewers are highlighted now.

5. Click Link with Current Position and Exit in the lower right corner of the last
selected viewer.

Visage 7 calculates 3D registration for the two datasets using the 3D position of the
reference point rather than DICOM frame of reference information stored in the
datasets.

In viewers that show individual MPR or MIP slices, Link Scrolling synchronizes
scrolling but no other activities.
1. Select the Link Scrolling tool.
2. Select all viewers in which you want to synchronize scrolling.
Selected viewers are highlighted with a red border.

3. Click Accept and Exit in the lower right corner of the last selected viewer.

1. Select the Link Scrolling tool a second time.
2. Click a viewer.

All viewers that you linked with the Link Scrolling tool earlier are now high-
lighted with a red border.
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3. Click linked viewers to remove the red border and to remove them from the link-
ing group.

4. Click Accept and Exit in the lower right corner of the last viewer that you
remove from the linking group.

Correcting viewer linking

If synchronized scrolling does not show corresponding images in the linked viewers,
you can correct this interactively. Proceed in the same way if panning or rotation is
synchronized across viewers and you need to correct viewer linking.

1. Scroll until one of the linked viewers shows an image with a clearly recognizable
landmark.

2. Click to select one of the other linked viewers.

This is a viewer that does not show a corresponding image or that does not show
the image correctly panned or rotated.

3. Press and hold the Shift key down.
Scrolling, panning or rotation will only affect the second viewer now.

4. Scroll to an image that corresponds to the image in the first viewer (image show-
ing the same landmark).

-Or-
Pan or rotate the image.
5. Release the Shift key.

Scrolling or panning and rotation will be synchronized across all linked viewers
again now.

Save Registration

s

Use this tool to save the registration (spatial alignment) of series for linked scrolling
in current and prior studies permanently.

Clicking this tool saves the registration of series in current and prior studies in a
DICOM object. In Study Browser, this DICOM object appears as a new series with
modality REG in the current (most recent) study.

Visage 7
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Editing viewer linking

Edit Viewer Linking

&

With this tool, you can edit the assignment of viewers to linking groups for synchro-
nized image navigation and image processing.
1. Click the Edit Viewer Linking button to select this tool.

In this mode, graphical buttons appear in all viewers. These buttons represent
types of activities that can be synchronized across viewers.

2. Point to one of these buttons in a viewer.

The button is highlighted in this viewer and all other viewers that belong to a
group in which this activity is synchronized.

3. Click this button in more viewers to add them to this group.
All viewers that belong to this group are now highlighted with a red border.

4. Click a second activity button to synchronize this activity across the viewers of
this group, too.

5. Click Apply to confirm linking group definition.

v

Continue and define more groups now.
-Or-

Click Delete All Viewer Groups to reset viewer linking and start defining groups
again from scratch.

&

-Or-
Click Accept and Exit to end linking group definition.

x4
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The group concept

Activities that can be
linked

& QP T

(1

w V@

The idea of viewer linking is to synchronize certain activities in multiple viewers.
Synchronized activities help you to compare images and to optimize image display
across linked viewers with a minimum of mouse clicks.

Several linking groups can coexist. For example, if you have loaded CT or MR
series and have a screen layout with eight viewers, two groups might exist. Group 1
might comprise the upper left two viewers and group 2 might combine the lower
right two viewers.

In group 1, only scrolling is synchronized. This means that when you scroll the
image stack in the upper left viewer, images also scroll in the viewer next to it. When
you zoom the image in the upper left viewer, only this image is enlarged but the
image in the viewer next to it is not.

In group 2, zooming and panning is synchronized but scrolling is not. When you
zoom in on the image in the lower right viewer, the image in the viewer next to it is
also enlarged. However, when you start scrolling in one of these lower right image
stacks, only the active viewer is affected.

However, viewers can only belong to one linking group of a specific type.

The following activities can be linked across viewers.

Cursor Position/Navigation Synchronization

Linking viewers with this button synchronizes scrolling in these viewers.

3D Rotation Synchronization

Linking viewers with this button synchronizes 3D rotation in these viewers.

Zoom Synchronization

Linking viewers with this button synchronizes zooming in these viewers.

Pan/Rotate Synchronization

Linking viewers with this button synchronizes the following activities: rotation
clockwise and counterclockwise, flipping horizontally and vertically, and pan-
ning

Tiled Navigation

Linking viewers with this button creates a group of viewers for tiled image display.
See also Scroll Page by Page (Mouse Wheel Mode), page 70.

Window/Level Synchronization

Linking viewers with this button synchronizes windowing in these viewers.

Time Synchronization

Linking viewers with this button synchronizes playback of time series and browsing
in time series.

Dataset Synchronization

Linking viewers with this button synchronizes loading of data in these viewers, for
example, from the thumbnail section.
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Detaching viewers from
groups temporarily

Quick linking of view-
ers

If viewers are linked but you want to apply a particular processing step to one viewer
only, you can detach this viewer from its group.

1. Click the lock in the viewer controls.

g > §
2. Click the lock again later on to reattach the viewer to its linking groups.
-Or-

1. Right-click the lock and cancel the selection for an activity to detach the viewer
from this group.

7, Detach Al 7, Detach Al

Right-click the lock again and reattach the viewer to its group later.

Group Editing tools

Use these tools instead of the Edit Viewer Linking tool as a quick way of linking
viewers with respect to one activity only.

In most protocols you find these tools on a separate toolbar, which is called Viewer
Linking (Group Editing).

1. Select one of these tools, for example, Modify Window Level Group.

&

2. Click all viewers in which you want to synchronize windowing.
Selected viewers are highlighted with a red border.

3. Click Accept and Exit in the lower right corner of the last viewer to confirm.

x4
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Overview of group edit-
ing tools
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The following tools are available for quick and easy group definition:

Modify Translation Navigation Group

Assign viewers to a translation navigation group for synchronized scrolling.
Datasets in a translation navigation group share the same reference point.

Modify Rotation Navigation Group
Assign viewers to a rotation navigation group for synchronized 3D rotation.

Datasets in a rotation navigation group share the same reference point and orienta-
tion.

Modify Zoom Group
Assign viewers to a rotation navigation group for synchronized zooming.

Synchronized zooming shows structures of the same size in the same size in all
linked viewers. This does not necessarily mean that the zoom factor in all linked
viewers is identical when you zoom in or out.

Modify Pan/Rotate Group

Assign viewers to a pan/rotate group for synchronization of the following activi-
ties: rotation clockwise and counterclockwise, flipping horizontally and verti-
cally, and panning.

Modify Tile Group

Assign viewers to a group for tiled image display. See also Scroll Page by Page
(Mouse Wheel Mode), page 70.

Modify Window Level Group

Assign viewers to a window level group for synchronized windowing.

Modify Time Phase Group

Assign viewers to a time phase group for synchronized playback of time series
and synchronized browsing in time series.

Modify Dataset Group

Assign viewers to a dataset group to ensure that several viewers show the same
dataset. For example, if you load data in one viewer from the thumbnail section, all
viewers in a dataset group are updated.

Visage 7

89



Tools

View windows

Annotation and measurement tools

Creating a text annota-
tion

Creating an arrow plus
text annotation

Creating an arrow with-
out text annotation

With this set of tools you can annotate and evaluate image information

Note

In the 3D viewer, measurements are only possible in orthographic but not in per-

spective projection. See also Perspective projection, page 57.

Every time you add an annotation to an image or perform a measurement, the pro-
gram creates a screenshot and sends it to the Export window. From there you can
insert these screenshots in your report.

If annotations or ROI statistics make it hard to read image information that lies
underneath, you can hide annotations and measurements. See Toggle Annotations
and Toggle Annotation Statistics, page 127.

Arrow/Text Annotation (N), Arrow Annotation

® %

Use one of these tools to add annotation text or draw arrows to point to observa-
tions.

1

o DN

-—

. Click the Arrow/Text Annotation button to select this tool.

®

. Click a point in an image.

In the Edit Annotation dialog box, type your annotation text.

. Click the Arrow/Text Annotation button to select this tool.

T
Click where you want to point to.
Hold the mouse button down, and drag across the image to create an arrow.
Release the mouse button.

In the Edit Annotation dialog box, type your annotation text.

Click the Arrow Annotation button to select this tool.

%

Y

. Click where you want to point to.

3. Hold the mouse button down, and drag across the image to create an arrow.

4. Release the mouse button.
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Moving or editing an
annotation

Showing text at a fixed
viewer position

Copying an annotation

Creating a circle plus
text annotation

1. Click an annotation text to select it.

2. Drag the text to move it.

-Or-

1. Click the arrow head.

2. Drag to move this end of the line until it points to a different observation.
-Or-

1. Right-click an annotation text or an arrow and select Properties.

2. In the Edit Annotation dialog box, change the way the annotation is displayed.

1. Right-click a text annotation.
Do not right-click an arrow plus text annotation.
2. Select Fixed Position in Viewer.
3. Start scrolling slices.
The annotation text remains static. This means the text appears in each slice image
and at the same window position.
1. Right-click an annotation and select Copy Object from the context menu.
-Or-
Select the annotation and press Ctrl + C (Windows) or Cmd + C (Mac).
2. Scroll to the slice in which you want to paste the annotation.
-Or-
Click the viewer in which you want to paste the annotation.
3. Right-click and select Paste Object from the context menu.
-Or-
Press Ctrl + V (Windows) or Cmd + V (Mac).

Circle Annotation (Text), Circle Annotation
()1 (

Use these tools to draw a circle around an area of interest or to draw a circle and to
add annotation text that comments your observation.

Do not confuse the Circle Annotation tools with the Circular ROI tool. Annotation
tools merely highlight an area of interest but do not evaluate image information. See
also Circular ROI, page 101.
1. Click the Circle Annotation (Text) button to select this tool.
0!
J‘b

2. Click a point in an image to create a circle around this point.
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Creating a circle with-
out text annotation

Moving or editing a
circle annotation

Measuring a distance

3. Drag in or out to make the circle smaller or larger.

4. Release the mouse button.

5. In the Edit Annotation dialog box, type your annotation text.
1. Click the Circle Annotation button to select this tool.

~

_'J‘b
2. Click a point in an image to create a circle around this point.

3. Drag in or out to make the circle smaller or larger.

4. Release the mouse button.

1. Click the annotation graphic or the text to select it.
Four dots appear around the circle and one dot in the middle of the circle.
2. Drag the dots around the circle in or out to resize the circle.
-Or-
Drag the dot in the middle to move the entire annotation graphic plus text.
-Or-

If the Move text freely option in the Edit Annotation dialog box is selected, you
can select and move the text only.

Distance (D)

Use this tool to measure distances. Distances are indicated in millimeters.

Caution

The accuracy of distance measurements is + 2 pixels. Larger errors can occur if
the image is displayed with reduced matrix size, that is, if not every original pixel
is shown on the screen due to zoom-out. For optimum accuracy, we recommend
zooming into the structure of interest as much as possible. The accuracy is fur-
ther limited by the physical resolution of the acquisition itself. If the monitor used
for display does not permit exact pixel selection, the inaccuracy can be still
greater.

1. Click the Distance button to select this tool.

2. Click where you want to start your distance measurement.
3. Hold the mouse button down, and drag across the image.
4

. Release the mouse button at the endpoint of your distance line.
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Showing the measure-
ment in all slices

Measuring a perpendic-
ular distance

Tip

If configured, the system automatically corrects nearly horizontal or vertical dis-
tance lines so that they are exactly horizontal or vertical. However, if auto-snap
mode has not been configured in your system, hold the Ctrl or Cmd key down
while you draw your distance line to achieve the same effect.

1. Right-click the distance line.
2. Select Show on all Slices.
3. Start scrolling slices.

The measurement graphics and results are shown in all slices.

Perpendicular Distance

Use this tool to perform two distance measurements that are exactly perpendicular.
For example, use this tool to measure the dimensions of a lesion.

Caution

The accuracy of distance measurements is + 2 pixels. Larger errors can occur if
the image is displayed with reduced matrix size, that is, if not every original pixel
is shown on the screen due to zoom-out. For optimum accuracy, we recommend
zooming into the structure of interest as much as possible. The accuracy is fur-
ther limited by the physical resolution of the acquisition itself. If the monitor used
for display does not permit exact pixel selection, the inaccuracy can be still
greater.

Click the Perpendicular Distance button to select this tool.
Click where you want to start your distance measurement.
Hold the mouse button down, and drag the mouse across the image.

Release the mouse button at the endpoint of your distance line.

o B~ 0N =

Draw the second distance line in the same way.

If the lines are exactly perpendicular, the right angle symbol is shown where the
lines intersect.

Tip

Be sure to draw the second line immediately after you have finished the first. If
you click elsewhere in the meantime, the system interprets both lines as separate
distance measurements.
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Showing the measure-
ment in all slices

1. Right-click the measurement.
2. Select Show on all Slices.
3. Start scrolling slices.

The measurement graphics and results are shown in all slices.

Calibrate Image

A

Use the calibration tool if a distance measurement yields only an estimate, which is
indicated by an asterisk, or if the measurement yields pixel values.

Caution

The accuracy of distance measurements is * 2 pixels. Larger errors can occur if
the image is displayed with reduced matrix size, that is, if not every original pixel
is shown on the screen due to zoom-out. For optimum accuracy, we recommend
zooming into the structure of interest as much as possible. The accuracy is fur-
ther limited by the physical resolution of the acquisition itself. If the monitor used
for display does not permit exact pixel selection, the inaccuracy can be still
greater.

1. Click the Calibrate Image button to select this tool.
2. Measure an object with known dimensions.

3. In the Calibrate dialog box, enter the known length.
4. Click OK.

The program recalculates any previously measured distances. In the upper right
corner of the image the words manual calibration indicate that manual calibration
has been performed on this image.
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Angle

e

Use this method of measuring angles if the legs of your angle intersect within the
image area.

Caution

The accuracy of all angle measurements (2D, Cobb's angle) depends on the
length of the shorter of the two angle legs. The longer the angle legs are, the bet-
ter the accuracy.

For example:

Length of shorter angle leg (measurement error): 10 pixels (x 12°),
20 pixels (+ 6°), 50 pixels (£ 2.5°), 100 pixels (£ 1.1°)

Larger errors can occur if the image is displayed with reduced matrix size, that is,
if not every original pixel is shown on the screen due to zoom-out. For optimum
accuracy, we recommend that you zoom into the structure of interest as much as
possible. The accuracy is further limited by the physical resolution of the acquisi-
tion itself. If the monitor used for display does not permit exact pixel selection, the
inaccuracy can be still greater.

Measuring an angle Click the Angle button to select this tool.
Click and drag to draw the first leg of your angle.
Release the mouse button at the vertex.

Drag to draw the second leg.

A

Click to end drawing the second leg.

Showing the measure- 1. Right-click the angle.
ment in all slices 2. Select Show on all Slices.
3. Start scrolling slices.

The measurement graphics and results are shown in all slices.
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Angle (Two Lines)

.

N
Use this method of measuring angles, for example, if the legs of the angle intersect
outside the image area.

Caution

The accuracy of all angle measurements (2D, Cobb's angle) depends on the
length of the shorter of the two angle legs. The longer the angle legs are, the bet-
ter the accuracy.

For example:

Length of shorter angle leg (measurement error): 10 pixels (x 12°),
20 pixels (+ 6°), 50 pixels (£ 2.5°), 100 pixels (£ 1.1°)

Larger errors can occur if the image is displayed with reduced matrix size, that is,
if not every original pixel is shown on the screen due to zoom-out. For optimum
accuracy, we recommend that you zoom into the structure of interest as much as
possible. The accuracy is further limited by the physical resolution of the acquisi-
tion itself. If the monitor used for display does not permit exact pixel selection, the
inaccuracy can be still greater.

Measuring an angle . Click the Angle (Two Lines) button to select this tool.

1
2. Click and drag to draw the first line.

3. Release the mouse button to finish the first line.

4. Click and drag to draw the second line.

5. Release the mouse button to finish the second line.

Of course, you can also use Angle (Two Lines) if the lines intersect. For intersect-

ing lines the system calculates both the acute angle and the obtuse angle.

Showing the measure- 1. Right-click the angle.
ment in all slices 2. Select Show on all Slices.
3. Start scrolling slices.

The measurement graphics and results are shown in all slices.
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Calculating the dis-
tance ratio

Showing the measure-
ment in all slices

Distance Ratio

i

N

Use this tool to measure two distance lines and to have the system calculate the
ratio between both measurements.

Caution

The accuracy of distance measurements is + 2 pixels. Larger errors can occur if
the image is displayed with reduced matrix size, that is, if not every original pixel
is shown on the screen due to zoom-out. For optimum accuracy, we recommend
zooming into the structure of interest as much as possible. The accuracy is fur-
ther limited by the physical resolution of the acquisition itself. If the monitor used
for display does not permit exact pixel selection, the inaccuracy can be still
greater.

1. Click the Distance Ratio button to select this tool.
2. Measure the first distance line.
Click, drag, and release the mouse button at the endpoint.

3. Measure a second distance line.

Tip

You can use this tool to calculate the cardiothoracic ratio in X-ray images, for
example.

1. Right-click the measurement.
2. Select Show on all Slices.
3. Start scrolling slices.

The measurement graphics and results are shown in all slices.
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Vertical Distance

h 4

s

Use this tool to measure the vertical distance between points in your images.

Caution

The accuracy of distance measurements is + 2 pixels. Larger errors can occur if
the image is displayed with reduced matrix size, that is, if not every original pixel
is shown on the screen due to zoom-out. For optimum accuracy, we recommend
zooming into the structure of interest as much as possible. The accuracy is fur-
ther limited by the physical resolution of the acquisition itself. If the monitor used
for display does not permit exact pixel selection, the inaccuracy can be still

greater.
Measuring a vertical 1. Click the Vertical Distance button to select this tool.
distance . N :
2. Click a point in your image.
3. Click a second point in your image.
The system draws two horizontal lines through both image points and calculates the
vertical distance between the two lines.
Tip
You can use this tool to measure the pelvic tilt in an X-ray image of the hip of a
standing patient, for example.
Showing the measure- 1. Right-click the measurement.

ment in all slices 2. Select Show on all Slices.

3. Start scrolling slices.

The measurement graphics and results are shown in all slices.
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Labeling vertebrae or
intervertebral disks

Renaming spine labels

Showing labels in all
slices

Annotate Spine

B

Use this tool to label vertebrae and intervertebral disks in images of the spine.
When you click the tool, a new toolbar appears in the lower right corner of the active
viewer and the Spine Labeling tool card opens.

1. Select whether you want to label vertebrae or intervertebral disks.

E E

2. Select the direction in which you want to proceed.

E* Bo

3. On the Spine Labeling tool card, select the vertebra or intervertebral disk label
with which you will begin.

4. Click this vertebra or intervertebral disk in the image to label it.
-Or-
Click and drag away from the vertebra or intervertebral disk to create an arrow.

On the Spine Labeling tool card, the next vertebra or intervertebral disk label is
selected now.

5. Click the next vertebra or intervertebral disk in the image and continue until you
have labeled all vertebrae or intervertebral disks.

6. Click OK to close the Spine Labeling toolbar and tool card.

x4

Right-click a spine label and select the correct label from the context menu
(Rename to ...).

Any other spine labels in the image are also updated.

-Or-

1. Right-click a spine label and select Properties from the context menu.
2. In the Edit Annotation dialog box, type the correct spine label.

3. Click OK to apply the new label.

Other spine labels in the image will not be changed.

1. Right-click the label of a vertebra or an intervertebral disk.
2. Select Show on all Slices.
3. Start scrolling slices.

The label is shown in all slices.
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Cobb's Angle

i
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Use this tool to measure Cobb’s angles in images of the spine.

Caution

The accuracy of all angle measurements (2D, Cobb's angle) depends on the
length of the shorter of the two angle legs. The longer the angle legs are, the bet-
ter the accuracy.

For example:

Length of shorter angle leg (measurement error): 10 pixels (x 12°),
20 pixels (+ 6°), 50 pixels (£ 2.5°), 100 pixels (£ 1.1°)

Larger errors can occur if the image is displayed with reduced matrix size, that is,
if not every original pixel is shown on the screen due to zoom-out. For optimum
accuracy, we recommend that you zoom into the structure of interest as much as
possible. The accuracy is further limited by the physical resolution of the acquisi-
tion itself. If the monitor used for display does not permit exact pixel selection, the
inaccuracy can be still greater.

-—

Measuring Cobb’s . Click the Cobb’s Angle button to select this tool.

angles 2. Click and draw a first line.
3. Draw a second line. The lines do not have to intersect.

The acute angle between the two lines is shown.
4. Draw a third line.

The acute angle between the second and third line is shown.
5. Continue in this way to measure more Cobb’s angles.
Showing the measure- 1. Right-click the measurement.
ment in all slices 2. Select Show on all Slices.

3. Start scrolling slices.

The measurement graphics and results shown in all slices.
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Drawing an elliptic ROI

Copying a ROI

Elliptic ROI

ul

A 2D ROI evaluates image information in the currently displayed image or slice.

Caution

The relative error of an elliptical ROl measurement is * 2 pixels/(shorter radius).
For example:

Shorter radius (measurement error): 10 pixels (x 20%), 20 pixels (x 10%),
50 pixels (+ 4%), 100 pixels (+ 2%).

Larger errors can occur if the image is displayed with reduced matrix size, that is,
if not every original pixel is shown on the screen due to zoom-out. For optimum
accuracy, we recommend that you zoom into the structure of interest as much as
possible. The accuracy is further limited by the physical resolution of the acquisi-
tion itself. If the monitor used for display does not permit exact pixel selection, the
inaccuracy can be still greater.

-—

. Click the Elliptic ROI button to select this tool.
2. Click the center of your region of interest and drag the mouse out.

3. Release the mouse button when the ellipse is large enough.

1. Right-click a ROI and select Copy Object from the context menu.
-Or-
Select the ROI and press Ctrl + C (Windows) or Cmd + C (Mac).
2. Scroll to the slice in which you want to paste the ROI.
-Or-
Click the viewer in which you want to paste the ROI.
3. Right-click and select Paste Object from the context menu.
-Or-
Press Ctrl + V (Windows) or Cmd + V (Mac).

Circular ROI

=

Use this tool to evaluate a 2D region of interest that is exactly circular.

Do not confuse the Circular ROI tool with the Circle Annotation tool. Annotation
tools merely highlight an area of interest but do not evaluate image information. See
also Circle Annotation (Text), Circle Annotation, page 91.
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Drawing a circular ROI

Comparing circular
regions of interest

Copying a ROI

Drawing a rectangular
ROI

Copying a ROI

1.
2.
3.

Click the Circular ROI button to select this tool.
Click the center of your region of interest and drag the mouse out.

Release the mouse button when the circle is large enough.

If you want to compare regions of interest, you can predefine the size of your next
ROI.

1.

Right-click your first circular ROI.

2. Select Set Size as Default.
3.
4

. Click to create a second circular ROI.

Select the Circular ROI tool again.

The new ROI has exactly the same size as the first ROI.

. Right-click a ROI and select Copy Object from the context menu.

-Or-
Select the ROl and press Ctrl + C (Windows) or Cmd + C (Mac).

. Scroll to the slice in which you want to paste the ROL.

-Or-
Click the viewer in which you want to paste the ROI.
Right-click and select Paste Object from the context menu.
-Or-

Press Ctrl + V (Windows) or Cmd + V (Mac).

Rectangular ROI

4

A 2D ROI evaluates image information in the currently displayed image or slice.

. Click the Rectangular ROI button to select this tool.

. Click the upper left corner of your region of interest and drag the mouse out.

3. Release the mouse button when the rectangle is large enough.

. Right-click a ROl and select Copy Object from the context menu.

-Or-

Select the ROI and press Ctrl + C (Windows) or Cmd + C (Mac).
Scroll to the slice in which you want to paste the ROI.

-Or-

Click the viewer in which you want to paste the ROI.
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Drawing a spherical
ROI

Copying a ROI

3. Right-click and select Paste Object from the context menu.
-Or-
Press Ctrl + V (Windows) or Cmd + V (Mac).

Spherical ROI

b

Use this tool to evaluate 3D ROIs that are exactly spherical.

1. Click the Spherical ROI button to select this tool.
2. Draw a circle in a slice image.

The program calculates the statistics of a volume of interest (3D ROI) with the
size of the circle in all dimensions.

3. Scroll through the image stack to see 2D representations of the selected spheri-
cal volume in various slices.

Tip

A 3D ROI evaluates volume information and therefore only makes sense in data
of modalities that allow generation of volume datasets.

3D ROIs are also called VOIs (volumes of interest).

1. Right-click a ROI and select Copy Object from the context menu.
-Or-
Select the ROl and press Ctrl + C (Windows) or Cmd + C (Mac).
2. Scroll to the slice in which you want to paste the ROI.
-Or-
Click the viewer in which you want to paste the ROI.
3. Right-click and select Paste Object from the context menu.
-Or-
Press Ctrl + V (Windows) or Cmd + V (Mac).

Point-Sized ROI, Pixel Value

g X

If you want to evaluate a point rather than an area or volume, use the Point-Sized
ROI or the Pixel Value tool.
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Point-sized ROIs

Pixel Value

Freehand 2D ROI tools

1. Click the Point-Sized ROI button to select this tool.

2. Click a pixel in an image.

The grayscale or density value of this pixel is shown and the program creates both a
screenshot and a key view.

1. Click the Pixel Value button to select this tool.

2. Move the cursor across an image.

The intensity value of the current cursor position is shown in the lower left corner of
the viewer, below the series and image number. The program does not create a
screenshot.

Freehand 2D ROI

(4
Use this tool to draw a freehand shape and evaluate image information in this

region of interest (ROI).

When you click the Freehand 2D ROI tool, a new toolbar appears in the lower right
corner of the active viewer. Here you find the following tools for drawing and refining
freehand shapes in 2D.

New Elliptical Contour

Use this button to circle the area of interest with an ellipse or a circle. Click a start
point, and drag the mouse out.

New Freehand Contour

Use this button to draw a freehand shape. Click a start point on the contour. Hold
the mouse button down, and draw a contour line.

New Balloon Contour

Use this tool to draw a border around a structure or area of interest of a specific
brightness. Click in the structure and drag out.

Append mode

o

With any of the contour tools, use the Shift key to start Append mode (the cursor
turns into an arrow with a plus sign).
Draw a contour or select a contour you have drawn earlier.
Press and hold the Shift key down and then draw a second contour.
If the contours overlap, the system merges them into a single ROI. If the contours
do not overlap, the system nevertheless interprets them as parts of a single region
of interest. Add a third contour to this ROI, if necessary.
Release the Shift key to turn Append mode off again.
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Copying a ROI

Freehand 3D ROI tools

3

2

Refine Contour
Use this tool to correct or refine contour lines.

Click anywhere in the image and drag the mouse to show a circle with which you
can correct the ROI graphic. The further away from the contour line you click, the
larger the circle will be.

Click inside the ROI graphic to enlarge the ROI graphic by pushing the contour out.
Click outside the ROI graphic to use the circle to push the contour line in.

Undo

Use Undo to retrace your steps.

OK

Click OK when you have finished drawing and refining 2D ROls to close the tool.

1. Right-click a ROI and select Copy Object from the context menu.
-Or-
Select the ROI and press Ctrl + C (Windows) or Cmd + C (Mac).
2. Scroll to the slice in which you want to paste the ROI.
-Or-
Click the viewer in which you want to paste the ROI.
3. Right-click and select Paste Object from the context menu.
-Or-
Press Ctrl + V (Windows) or Cmd + V (Mac).

Freehand 3D ROI

&
ip
Use this tool to define a freehand 3D ROI by drawing ROI graphics in various slices

of a volume dataset.

When you click the Freehand 3D ROI tool, a new toolbar appears in the lower right
corner of the active viewer. Here you find the following tools for drawing and refining
freehand shapes in 3D.

New Elliptical Contour

Use this button to enclose the area of interest with an ellipse. Click a start point, and
drag the mouse out to draw a circle or ellipse.

New Freehand Contour

Use this button to draw a freehand shape. Click a start point on the contour. Hold
the mouse button down, and draw a contour line.
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New Balloon Contour

Use this tool to draw a border around a structure or area of interest of a specific
brightness. Click in the structure and drag out.

Append mode

With any of the contour tools, use the Shift key to start Append mode (the cursor
turns into an arrow with a plus sign).

Draw a contour or select a contour you have drawn earlier.
Press and hold the Shift key down and then draw a second contour.

If the contours overlap, the system merges them into a single ROI. If the contours
do not overlap, the system nevertheless interprets them as parts of a single region
of interest. Add a third contour to this ROI, if necessary.

Release the Shift key to turn Append mode off again.

Refine Contour
Use this tool to correct or refine contour lines.

Click anywhere in the image and drag the mouse to show a circle with which you
can correct the ROI graphic. The further away from the contour line you click, the
larger the circle will be.

Click inside the ROI graphic to enlarge the ROI graphic by pushing the contour out.
Click outside the ROI graphic to use the circle to push the contour line in.

When you have finished drawing and refining a ROI graphic in one slice, scroll on to
the next slice and also draw a ROI there.

Continue in this way through all slices that show the volume of interest.

Undo

Use Undo to retrace your steps.

OK
Click OK when you have finished drawing and refining ROI graphics in all slices.

The system calculates ROI statistics and closes the freehand 3D ROI tool.

1. Right-click a ROI and select Copy Object from the context menu.
-Or-
Select the ROl and press Ctrl + C (Windows) or Cmd + C (Mac).
2. Scroll to the slice in which you want to paste the ROI.
-Or-
Click the viewer in which you want to paste the ROI.
3. Right-click and select Paste Object from the context menu.
-Or-
Press Ctrl + V (Windows) or Cmd + V (Mac).
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Screenshot tools

Save Annotations as Presentation State
=)
PR

Use this tool to save all annotations and measurements in the currently loaded
dataset permanently.

Clicking this tool saves annotations and measurements in a DICOM presentation
state. In Study Browser, the presentation state appears as a new series with
modality PR. The next time you load this study, your annotations are shown in the
images.

Delete All Measurements/Annotations

oT

%

Use this tool to delete all measurements and annotations in your dataset.

Note

Clicking this tool removes all measurements and annotations in all the images of
all the loaded studies. Moreover, key views and screenshots, which the program
created automatically for each measurement or annotation, are also deleted.

Screenshots serve the purpose of documenting observations. For example, you
create a screenshot to show it in your report.

Every time you add a text or graphical annotation or perform a measurement, the
program takes a screenshot. Screenshots are hard copies of the image in the cur-
rently selected viewer, complete with annotations, measurements, and image text, if
shown. If you want to preserve an image without annotating it, you create a screen-
shot with one of the screenshot tools. Visage 7 collects all screenshots that you cre-
ate during a session in the Export window. From the Export window, you can save
these screenshots, send or print them, or include them in your report.

Screenshot (S)

(93

Use this tool to create a screenshot of the currently selected viewer. The screenshot
is sent to the Export window.

Visage 7

107



Tools

View windows

Key views tools

Screenshot All (Shift + S)

Use this tool to create screenshots of all viewers that are currently shown on the
screen. Several screenshots are sent to the Export window.

Combined Screenshot (Alt + S)

Gie

Use this tool to create a combined screenshot that shows all viewers that are cur-
rently displayed on the screen in one image. One screenshot is sent to the Export
window.

When you read images, you make observations that you want to highlight and also
save to be able to come back to them later. For cross-sectional images, that is CT,
MR, and PET images, Visage 7 offers the concept of key views for this purpose.

Key views help you to come back to an observation in a later session and also to
repeat or refine measurements, for example.

A key view is created every time you annotate an image or perform a measurement.
In addition to this, you can create a key view for every other slice to which you want
to return later.

Note

Key views exist for the duration of the current session. To preserve key views,
save your session. See also Session management, page 25.

Store Key View (K)

E3

Use this tool to save what is currently shown in the active viewer in a key view.
When you save a key view this way, the program also creates a screenshot and
sends it to the Export window.
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Delete Key View

£

Use this tool to delete a key view. This button is available only if a key view is shown
in the active viewer.

When you delete a key view, the corresponding screenshot in the Export window is
also deleted.

Previous Key View, Next Key View

JEEE  AEEE
@« »

Use these tools to browse through the key views that are stored in your session.

Tools for 3D navigation

3D rotation in the 3D
viewer

In 3D datasets, you use the tools in this section or the scoutline crosshair to move
through the volume. See also Crosshair navigation in MPR viewers, page 55.

Tip

For a better overview, show orientation labels and the orientation cube before
you start navigating through the volume. Use View > Show in Viewer on the
menu to display the orientation cube and orientation labels.

3D Rotate

4

With this tool, you can rotate around the volume in the 3D viewer or in the MPR
viewers.

3D Rotate is the standard navigation tool in the 3D viewer and in curved view.

1. Click the 3D Rotate button to select this tool.

-Or-

Click the Default Navigation button or hold the Ctrl or Cmd key down.
2. Click anywhere in the 3D viewer.

3. Hold the mouse button down and drag to rotate the volume in the direction of the
mouse movement.

-Or-
Rotate the mouse wheel to rotate around the vertical axis only.
-Or-
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3D rotation in MPR
viewers

Press and hold the Shift key down while you rotate the mouse wheel to rotate
around the horizontal axis only.

Tip

Use any of the standard orientation buttons or keyboard shortcuts to reset rota-
tion. See Anterior (A), Posterior (P), Left (L), Right (R), Head (H), Foot (F) View,
page 110.

1. Click the 3D Rotate button to select this tool.
2. Click the point in an image that is to be the center of rotation.
3. Hold the mouse button down and drag to rotate the image plane.

New slice images in nonstandard orientations are created in the process. The orien-
tation labels and orientation cube indicate the new image orientation.

Tip

Use Reset Slice Orientations to return to the original image orientation

2D rotation 1. Click the 3D Rotate button to select this tool.
2. Hold the V key down while you drag to rotate a single image or 3D volume.
V + 3D Rotate has the same effect as choosing the tool Rotate in Plane. See
Rotate in Plane, page 67.
Reset Slice Orientations
Use this tool to reset the orientation in all linked MPR viewers to their original orien-
tation. Images are now shown in the orientation in which they were displayed right
after loading.
Anterior (A), Posterior (P), Left (L), Right (R), Head (H), Foot (F)
View
Use these tools to display the image in the currently active viewer in one of the stan-
dard anatomical views.
For example, if you click H or F in an MPR viewer that shows axial slices, this
reverses the viewing direction in this viewer. If you click H or F in an MPR viewer
that shows sagittal or coronal slices, this rearranges viewers.
Clicking a standard orientation button in the 3D viewer affects the 3D viewer only.
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Position Crosshair

@

Use this tool to focus on a particular point in the volume in linked viewers.

Note

Position Crosshair affects linked viewers only.

1. Click the Position Crosshair button to select this tool.
2. Click a visible (opaque) structure in the 3D viewer.

-Or-

Click any point in one of the images in the MPR viewers.

Clicking sets the crosshair of the MPR viewers to this 3D position and updates all
MPR viewers that show this dataset.

Tip

Show the 3D crosshair in the 3D viewer before you click Position Crosshair.

Triangulation

G;.;

Use this tool to focus on a particular point in the volume in all viewers that show
images or volume datasets that contain this point.

Note

Triangulation affects image display in all viewers and not only in linked viewers.

1. Click the Triangulation button to select this tool.

2. Click a point in any of the viewers.

Tip

The Triangulation tool is particularly useful when you are reading multiseries
MR datasets.
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Center View
O

LR
Use this tool to move images in linked viewers in such a way that the scoutline
crosshair is in the viewer center.
For example, use this tool after you have moved the crosshair. See also Crosshair
navigation in MPR viewers, page 55.

Cropping tools

Creating a crop box

Use the cropping tools to cut away portions of the volume that hide more important
information that lies underneath.

Tip

Show the bounding box in the 3D viewer before you select one of these tools.
The bounding box helps you to identify the portions of the volume that you want
to cut away.

.

<2

Crop Box

1t

el

Use this tool to cut away the outer parts of the volume.

1. Click the Crop Box button to select this tool.

This tool removes the outer volume parts, a smaller volume box in the center of
the volume dataset remains.

2. Click inside the box to move it.
-Or-
Drag a border line to resize the box.
-Or-
Click a corner of the box and drag to rotate the crop box.

3. Click the Crop Box button a second time to show the entire volume again.
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Locking the crop region

Creating a box annota-
tion

Cropping a slab

Locking the crop region

When you click a cropping tool, the Lock Crop Region button appears in the lower
right corner of the active viewer.

Click this button to lock the crop region.

You can now move or rotate the volume within the crop box.

With the tool Create Box Annotation, you can save the position and size of the 3D
crop box in an annotation.

1. Click Create Box Annotation in the toolbar in the lower right corner of the active
viewer.

IS N
2. Click Save Annotations as Presentation State or Save Results to save the
annotation in a presentation state.

=
L[Td
See Save Annotations as Presentation State (page 107) and Save Results (page
121).

Crop Slab

=

Use this tool to cut away portions of the volume so that only a slab remains. A slab
is a section of the volume between any two parallel planes with oblique orientation.
1. Click the Crop Slab button to select this tool.

-Or-

In the 3D viewer use the keyboard shortcut T to turn slab display on or off.
2. Drag slab boundaries out or in to change the slab thickness.
3. Click the Crop Slab button a second time to show the entire volume again.
When you click a cropping tool, the Lock Crop Region button appears in the lower
right corner of the active viewer.

Click this button to lock the crop region.

2

You can now move or rotate the volume within the slab.
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Cropping along a plane

Locking the crop region

Cropping a corner

Locking the crop region

Crop Plane

B/

Use this tool to cut away a corner of the volume along an oblique cutting plane.

1. Click the Crop Plane button to select this tool.

2. Drag the orange line, which defines what will be cut away, to move this plane in
or out.

3. Click the Crop Plane button a second time to show the entire volume again.
When you click a cropping tool, the Lock Crop Region button appears in the lower
right corner of the active viewer.

Click this button to lock the crop region.

9

You can now move or rotate the volume within the remaining volume box.

Crop Corner

Use this tool to cut away a box from the corner of the volume.

1. Click the Crop Corner button to select this tool.
A box is removed from the corner that is pointing toward you in the 3D viewer.

2. In the MPR viewers, drag the orange lines, which define the corner to be cut
away, to increase or decrease the box.

3. Click the Crop Corner button a second time to show the entire volume again.
When you click a cropping tool, the Lock Crop Region button appears in the lower
right corner of the active viewer.

Click this button to lock the crop region.

—

L

You can now move or rotate the volume within the remaining volume box.
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Fusion registration tools and tools for displaying primary and overlay data

With Visage 7 you can display suitable datasets in fusion mode. Fusion display
overlays datasets, for example, a CT and a PET series of the same study.

Fusion display requires that datasets are registered, which means that they are
aligned spatially. Even though Visage 7 usually aligns datasets automatically when
you load suitable data, always check and confirm alignment manually.

Manual Registration

B

Use this tool to start manual alignment mode. In this mode, the two datasets are
overlaid. The primary dataset is shown pink, and the overlay dataset is shown green
in the active viewer. An outlined cross also appears in the viewer.

1. Click the center of the cross.
2. Hold the mouse button down, and drag the green layer.

3. When corresponding structures in the green and pink layer are exactly overlaid,
release the mouse button.

-Or-
1. Click one of the ends of the cross.
The cursor changes its shape and indicates rotation.

2. Hold the mouse button down and drag to rotate the green overlay layer.

Tip

Before you align datasets manually, window the two datasets in such a way that
prominent structures, such as bones, are clearly visible. This helps you to overlay
the two corresponding images correctly.

Align Centers

B

Use this button to have Visage 7 align the centers of the bounding boxes of the two
datasets.
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Automatic Registration

+
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Use this button to have Visage 7 identify and align corresponding structures by
comparing pixel intensities.

Caution

Be aware that automatic registration does not always align images correctly.
Please verify registration results and correct registration manually, if necessary.

Tip

Automatic Registration of primary and overlay datasets and Automatic Viewer
Registration for linked scrolling use the same principle of comparing grayscale
information in images.

See also Automatic Viewer Registration, Automatic Viewer Registration (Transla-
tion Only), page 83.

Reset Registration

s

Click this tool to undo manual alignment, center alignment, or automatic registra-
tion. The two datasets are now registered in the same way as they were right after
loading.

Accept Registration

v

Click this tool after you have finished aligning your datasets manually.

Viewer Objects (Primary), Viewer Objects (Overlay)

%

Multimodality studies can contain more than one series per modality. Multiple series
are indicated by these buttons in the MPR viewers and the 3D viewer.

Use these tools to open a menu from which you can select a different primary or
overlay dataset.
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Tool for time-series analysis
When you load time series, the system selects a protocol that has been optimized
for comparison and analysis of images at various phases.

Time-density analysis plots the density progression in one or several regions of
interest over time in time-resolved 3D datasets.

1. Select the viewer that shows the baseline phase. Typically this is the upper left
viewer.

2. Draw a circular, elliptical, freehand, or point-sized ROI.
— — —
g 8 8 (&4 & ®
3. Right-click and select Time-Density Analysis.

The program evaluates the density of the ROI in the various time steps of the
series and plots this information in a graph.

4. Draw a second ROI.
5. Right-click and select Add to Time-Density Analysis.

The graph of the second ROI is added to the plot. ROls are numbered both in the
plot and in the image.

Tool for subtracting image information

Use this tool from the Multiphase toolbar to subtract image information, for exam-
ple, the baseline phase in a time series or a non-contrast image from a contrast-
enhanced image or series.

Subtracting the baseline phase in a time series
1. Load the time series from which you want to subtract its baseline phase.
2. Click Subtract Baseline Phase.

The tool identifies the baseline phase automatically and subtracts its image infor-
mation from the other images in the time series.

As a result you see only those structures in which changes occurred over time.

3. Click Subtract Baseline Phase a second time to reset subtraction and show all
image information again.
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Subtracting image information in other series or volume data

1.

Load two volume datasets into an MPR viewer in fusion mode.

For example, load a contrast-enhanced series as primary dataset and a corre-
sponding native series as overlay dataset.

. Click Subtract Baseline Phase.

The system subtracts the overlay dataset from the primary dataset.

. Click Subtract Baseline Phase a second time to reset subtraction and show

both primary and overlay datasets again.

Tools for viewing mammography studies

Protocols for mammography studies feature a specific arrangement of images,
which is particularly well-suited for a comparison of the left and right breast.

Moreover, these protocols offer tools for synchronized image navigation in high-res-
olution images and for comparing magnified sections in corresponding images.

Quadrant Navigation

c

Use this tool to enlarge the displayed images and to read them quadrant by quad-
rant.

1.
2.

Click the Quadrant Navigation button to select this tool.

Press the right arrow key to show the upper right quadrant of images of the right
breast and the upper left quadrant of images of the left breast enlarged and side
by side.

Press the right arrow key a second time to move on to the lower right quadrant
(right breast) and lower left quadrant (left breast).

Press the right arrow key a third time to move on to the lower left quadrant (right
breast) and lower right quadrant (left breast).

Press the right arrow key a fourth time to move on to the upper left quadrant
(right breast) and upper right quadrant (left breast).

6. Press the right arrow key a fifth time to show the entire images again.

. Continue pressing the right arrow key to return to quadrant display.
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Tip

When the entire images are shown, you can choose whether to show complete
overview images or whether to cut away background information and show the
overview image enlarged.

i

C

Quadrant Overview Enlarged shows the overview image enlarged and cuts
away background pixels, burnt-in text, and markers.

[

Quadrant Overview shows either the full image or cuts away only background
pixels, depending on the property settings for this tool.

Choose this tool if you suspect that Quadrant Overview Enlarged might not dis-
play all diagnostically relevant information.

Magnifying Glasses

&

Use this tool rather than Magnifying Glass to be able to compare enlarged sections
of the left and right breast.

1. Click the Magnifying Glasses button to select this tool.
2. Click the image of the left breast and hold the mouse button down.

A rectangular area appears which shows this section of the image in its original
size (100%).

3. Drag to move the rectangle across the image.
4. Release the mouse button and move on to the image that shows the right breast.
5. Also click here and move the magnifier to the area of interest.

The magnifiers remain visible in both viewers for as long as the Magnifying
Glasses tool is selected.

6. For layouts that show images in more than one orientation, you can continue
applying magnifying glasses to these other viewers as well.

7. Click the tool on the toolbar a second time or click another tool to remove the
magnified sections from all viewers.
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Tip
The tool Magnifying Glasses is not reserved for mammography studies but also
available in other protocols, image types and viewers.

Choose multiple Magnifying Glasses rather than a single Magnifying Glass
whenever you want to inspect and compare magnified sections in more than one
viewer. See also Magnifying Glass, page 66.

Previous Prior Study (Mammo), Next Prior Study (Mammo)

® G

* »
Use these tools to scroll through corresponding images in prior studies.
-Or-

Use Browse in All Priors for a similar effect. See Browse in All Priors, page 69.

Toggle MG/Tomo, Toggle MG/Projection, Toggle MG/Tomo/Pro-
jection

e el
Q37

Use these tools to switch between 2D image, projection view, and 3D series display
in the current viewer. These tools are only available in DBT (digital breast tomosyn-
thesis) studies.

Data handling tools

These tools help you with various data handling tasks.

Study Info Dialog

Use this tool to show the study information dialog box. The information in this dialog
box is read-only, except for the Comment box.

In the Comment box you can add or edit study comments. Any changes are saved
on the Visage 7 server automatically. No further user interaction is required to save
comments.
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Save Results

(el

Use this tool to save any unsaved information such as annotations or measure-
ments or changes to the image representation.

Clicking this tool is a shortcut to saving the following aspects individually: Save Cur-
rent W/L as Presentation State, Save Flip/Rotate as Presentation State or Save
Annotations as Presentation State.

Clicking Save Results creates a DICOM presentation state. In Study Browser, the
presentation state appears as a new series with modality PR.

View Structured Reports

"

Use this tool to show any DICOM structured reports that exist for the currently
loaded study, as well as for associated prior studies.

View Reports (RIS)

—_—

Use this tool to show reports that exist for the currently loaded studies in the RIS.
The reports are shown in a separate report window.

The tool icon indicates the report status (unsigned report, signed report, report for
prior study only, no report at all).

Tip

In the report window, you can view and print reports.

View Reports (PACS)

5
Use this tool to view PACS reports or HL7 reports for the currently loaded studies.

This tool opens the Export window and displays the reports there.

The tool icon indicates the report status.
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Best Image Quality

For users who access the Visage 7 server over the Internet, a red bullet might be
permanently shown in the lower right corner of all images. The red bullet indicates
low image resolution as a result of high compression rates, which were selected to
improve download speed.

Use the Best Image Quality tool and select individual images only. These images
are downloaded with best image quality but potentially slow download times.

Assign and Manage Study Labels

&

Use this tool to open the Study Labels dialog box.

Assigning a label to a 1. Select one or several of the existing labels that you want to assign this study to.

study The list of study labels presented here contains all public labels as well as your

own private study labels.

To make private labels of other users available as well, select Show labels from
other users and specify user names. Separate user names with a comma to
show private labels of several other users (e.g. Miller, Smith, Johnson).

-Or-

Type the name of a new label and select either the public or private version of
the new label.

7 Study Labels

Label: |MyNewLabel

Assigned by

2. Click Apply.
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Creating a label button For even easier label assignment in future, you can create label buttons on the

Labels toolbar.

1. Right-click a label and assign it to a button placeholder.

3 Study Labels

Label:
Label

v
4

abc_de
blabalb

public

Make Public

Delete

1 to button 7
button &
1 to button 9

2. Next time you want to assign this label, click the button on the Labels toolbar.

Tip

For more information about study labels, see Assigning and managing study

labels, page 36.
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Schedule for Conference

&)

Use conference labels to mark cases for discussion in a conference or meeting on a
specific date and at a specific time.

1. Click this tool to open the Conference Labels dialog box.

7 Conference Labels

-
February 10 - 16  Today
A4

Tumor Board
10:30 - 11:30

Tumor Board
10:30 - 11:30

MPMC Urology Conference = Tumor Board
10:00 - 10:30 10:30 - 11:30

Tumor Board
10:30 - 11:30

Tumer Board Weekly Review
10:30 - 11:30 15:00 - 15:45

Other Labels:

2. Select the correct week.

3. Select the conference and click Close.

Tip

For more information about study labels, see Assigning conference labels and
scheduling conferences, page 34.

Tool for printing images (Ctrl/Cmd + P)
With this tool, you can print out images on a DICOM printer, or on a Windows
printer, or save one or several images as a pdf file.
1. Right-click a viewer and select Print from the context menu.
2. Select a printer and printer settings in the Print dialog box.

3. Click Print to start the printout or to create a pdf file.
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Printer settings

Device

Images

Layout

Media Properties

In the upper part of the dialog box, select DICOM printers and one of the DICOM
printers connected to your Visage 7 server.

-Or-
Select Other Destinations and select a Windows printer or Save as PDF.

Also select the number of copies.

Select which image or images you will print out:

Active Image prints the image in the active viewer. Image orientation, zoom and
window settings in the printout are the same as in the active viewer. If image texts
are currently shown in the image, these texts are printed as well. Measurements or
annotations are not printed.

Active Image Set prints all images of the image set currently shown in the active
viewer. All images are printed in their original orientation and together with any
image texts that are currently displayed on the screen. Measurements or annota-
tions are not printed.

Visible Images prints all images that are currently shown on the screen. Image ori-
entation, zoom and window settings in the printout are the same as on the screen
when you click the tool. This option is available only if all viewers show original
images.

Visible Image Sets prints the images of all image sets that are currently displayed
in the various viewers of the selected layout. If one image set is shown in more than
one viewer, it is printed only once. All images are printed in their original orientation.

Select how many images you want to print on one page or film sheet by specifying
the number of Rows and Columns.

Selecting 1 for rows and also 1 for columns prints exactly one image per page or
film sheet. Selecting 2 for rows and also 2 for columns prints exactly four images
per page or film sheet.

Also specify the Fit Mode:
Image fits the image into the image box on the page or film.

Viewer prints images as shown in the viewer. This option is available only for the
tools Active Image and Visible Images.

True Size scales the image up or down so that one centimeter on the printout cor-
responds to one centimeter in reality. This mode takes image calibration into
account. If you select this option for uncalibrated images, a warning appears. True
Size is only available for DICOM printers.

In this section of the dialog box, select medium type, size, orientation, and color
mode. Which options are available in this section depends on the selected device.
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Tools for switching image text and graphics on and off

With the tools in this section, you can show or hide texts or graphics that overlay the
actual images. Some of these tools show or hide all text or groups of text or graph-
ics, whereas other tools toggle only specific information.

Toggle tools affect all viewers or all viewers of a specific viewer type. For example,
you cannot show patient and study data in one viewer but hide this information in all
other viewers.

Toggle tools on the tool  The toggle tools can be configured to be shown in toolbars or on the tool palette.

palette Show the tool palette by right-clicking a viewer. However, remember that it depends
on your system configuration whether right-clicking shows the tool palette, or the
viewer context menu, or both (see also Configure Tool Palette dialog box, page
201).

Toggle All

N
,Qf"\.

Use this tool to show or hide any texts or graphics that are currently selected for
display in the View > Show in Viewer menu.

Alternatively, use the Space key on your keyboard to show or hide text and graph-
ics.

Toggle Patient/Study Data

Use this tool to show or hide patient or study information in all viewers.

Toggle Viewer Text Categories

Use this tool to show patient and study information at different levels of detail.

Toggle Orientation Labels

N

Use this tool to show or hide orientation labels in viewers.

Orientation labels indicate the viewing direction: A for anterior, P for posterior, L for
left, R for right, H for head, and F for feet.

52 Toggle Orientation Cube
R Pl
4 Use this tool to show or hide the orientation cube in the lower left corner of the view-
ers.
For DBT (digital breast tomosynthesis) volumes, a slice-position reference graphic
is shown instead of the orientation cube.
Toggle Histogram
Y g9 g
N4 While the Window Level tool is active, a histogram of grayscale values or HU val-
ues is shown in the lower left corner of the viewer.
Use this tool to hide or redisplay the window level histogram.
v Toggle Scale
J In calibrated image types, for example, CT images, a scale can be shown on the

right edge of the viewers. The scale looks like a small ruler and indicates centime-
ters or millimeters when you zoom in.

Use this tool to hide or redisplay the scale.
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Toggle Color Scale

In viewers that show color images, a scale that indicates the value range can be
shown. For example, in PET (positron emission tomography) images the value
range indicates standard uptake values (SUV) and the colors they correspond to.

Use this tool to show or hide the color-map value-range indicator.

Toggle Annotations

Use this tool to show or hide annotation text, annotation arrows, and measurement
graphics and results.

-Or-

Toggle Annotation Statistics

Use this tool to hide or redisplay the results of measurements only. With Toggle
Annotation Statistics turned off, measurement graphics are still visible, only the
results of measurements are hidden.

This tool is particularly useful in the context of ROI statistics, which might hide
underlying image information.

Note that instead of showing or hiding all ROI statistics you can also hide the
results of individual ROl measurements only. Select a ROl measurement and use
the context menu and not the Toggle Annotation Statistics tool to show or hide
this information. Or you can hide individual statistical data for all ROls in the Prop-
erties dialog box (see Properties dialog box, page 202).

Toggle Viewer Controls

Use this tool to show or hide the viewer control bar at the bottom edge of the view-
ers. Toggle Viewer Controls affects all viewers of the same viewer type.

Toggle 2D Bounding Box, Toggle 3D Bounding Box

Use these tools to show or hide a box or cube that indicates volume borders in
MPR viewers or 3D viewers.

Toggle 2D Crosshair, Toggle 3D Crosshair

Use these tools to show or hide scoutline crosshairs in MPR viewers or the 3D
crosshair in 3D viewers.

Toggle Partial Crosshair

When the full 2D crosshair is shown the crosshair center becomes a move handle,
irrespectively of the tool that is currently selected.

Switch to partial crosshair display to turn the move function off. For example, switch
to partial crosshair display before you perform any measurements that start at or
near the crosshair center.

Toggle Scoutlines

Use this tool to show or hide scoutlines. Scoutlines are dashed lines in 2D viewers
or MPR viewers that indicate the location of a slice shown in one of the other view-
ers.
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Toggle Slice Boundaries

In thick-slice display use this tool to show slice boundaries in MPR viewers of the
same dataset.

Toggle Centerline

Use this tool to show or hide the curve definition or vessel centerline during vessel
analysis or curved planar reformatting.

Note that in curved view centerline display must be turned on in the context menu.
Only then can you use the Toggle Centerline button on the toolbar to hide or redis-
play the centerline.

Toggle DICOM Overlays, Toggle DICOM Annotations
Toggle DICOM Shutters, Toggle ECG curve

Use these tools to show or hide DICOM overlays, DICOM annotations, DICOM
shutters, or the ECG curve.

These tools are available only if images contain this information.

Toggle Localizer Image

Use this tool to hide or redisplay the embedded scout or localizer image in
fullscreen mode.

Note that this is possible only if display of the embedded scout or localizer has been
defined in the property settings of a viewer type.

Tools for performing quality assurance on images

On some occasions it is necessary to correct images so that these corrections apply
even if the images are viewed with a viewer software other than Visage 7 Client.

Such corrections include the following cases:

» Patient information or orientation labels that are burnt into the images need to be
replaced.

+ 2D images need to be rotated or flipped.

+  Window level settings need to be changed in individual 2D images or in a 3D vol-
ume dataset.

» The assignment of images to series or studies needs to be corrected.

On other occasions it might be necessary to delete images because of poor image
quality.
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Note

Visage 7 Client provides tools for performing these quality assurance tasks. How-
ever, these tools are available only if your user account has appropriate user
rights.

Note that deletion of images for quality reasons might be restricted to images
from certain modalities.

Permanent Text Label

Use this tool to overwrite patient or study data or orientation labels that are burnt
into the images.

1. Click the Permanent Text Label button to select this tool.

The Edit Permanent Labels dialog box opens. Text label creation and editing
mode is active as long as this dialog box remains open.

2. In the image, click the patient information or orientation label that you want to
overwrite.

A black box appears. The box more or less covers the existing patient informa-
tion or orientation label.

3. Drag to move the box or use the sizing handles (orange dots) so that the box
covers the text that you want to overwrite completely.

4. Type the correct information in the Label properties box of the Edit Permanent
Labels dialog box.

5. Use the Font size slider to resize the text.

6. Under Image selection, select whether to apply the new label to the current
image only or to all images in the image set.

7. Save your changes and close the dialog box.

Closing the dialog box ends label creation and editing mode.

Tip
To change a text label that you just entered, or to delete one of your labels, reen-
ter label editing mode.

Click the Permanent Text Label button again and click a label that you entered
earlier to select it. You can now change the label text, move or resize the label, or
delete it with the Del key on the keyboard.
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Save Modified Image

i

Use this tool to save changes to image content permanently.
1. Click Save Modified Image.
2. Select which changes you want to save.

You can only save changes to window level settings, flip or rotate operations,
annotations, layout changes and changes to text labels but no other modifica-
tions to image content.

Save Modified Image combines the tools Save Current W/L as Presentation
State, Save Flip/Rotate as Presentation State, Save Annotations as Presen-
tation State, and Save Sort Order with saving permanent text label changes.

Delete Image

)

Use this tool to delete individual images with poor image quality.
1. Select one or several images.

2. Click Delete Image.

3. Click OK to confirm deletion.

Select for Quality Assurance

)5
Use this tool to load a case onto the Quality Assurance platform.
1. Select an image.

2. Click Select for Quality Assurance.

In the Quality Assurance window, you will find the selected case in the Per-
formed Procedures list.
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Tool cards

Tool cards can be arranged in one or several stacks, usually along the right edge of
the program window. Alternatively, tool cards can be displayed as floating windows.

Your currently active protocol defines how and how many tool cards are shown right
after you have loaded data.

Showing or hiding tool 1. Click the arrow button on the right edge of the screen to show tool cards, if these
cards are currently hidden.

2. Select the tool card you need from the drop-down list.

-Or-

Select a tool card from the Tools menu.

When you select a tool card from the Tools menu, it is shown as a floating window.
Tips for arranging tool Some tool cards require more space than others. You can therefore resize tool card
cards stacks or the width of the entire tool card area.
1. Point to the line that divides two stacks of tool cards.
The cursor changes its shape.

2. Drag the line up or down to resize the tool card above and below.

If the tool card area is temporarily in your way, you can hide it.

Clear View > Show Tool Cards in the main menu to hide the tool card section.
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Templates

User-defined templates

Controls on this tool
card

CT Color 1 (all)

Floating windows are usually displayed in a size that ensures that they are not in
your way while you are reading images. You can enlarge these windows, if neces-
sary.

Click the lower left or lower right corner of the window and drag it out to show the
tool card larger.

Templates offer a quick way to optimize the volume display in the 3D viewer for spe-
cific tasks.

A template defines volume rendering and display parameters for volume datasets of
a particular modality or a combination of modalities.

A template stores the following information:
» The modality of the primary and overlay dataset
* A color map for the primary and overlay dataset
See also 3D Color Map, page 133.
* Rendering and display settings for the volume display in the 3D viewer
A number of predefined templates came with the system. Advanced users can
adjust these to their own requirements or define their own set of 3D templates.

When you save a new or adapted template, you can make it available for all users
or for your own user account only.

Note

When you edit and save one of the All users templates, you change this tem-
plate permanently and for all Visage 7 users in your network. The factory-defined
template version is lost this way.

Use the following buttons and tools to select a template or to manage templates:

Click a template thumbnail on the tool card to select it.

The tool card lists only templates that were defined for the modality or modalities of
the data that is currently loaded.

Click Reset to return to the original volume display and to revoke your changes.

132

Visage 7



View windows

Tool cards

(el

X

3D Color Map

User-defined color
maps

Controls on this tool
card

Primary Dataset, Overlay
Dataset

Color map selection

Click Save to save the 3D rendering and display settings currently applied to the
volume in the active 3D viewer. A dialog box opens. Enter a template name and
decide whether the new template will be available for all users or for your user
account only.

Select a thumbnail and click Delete to remove it from the list of available templates.

On the 3D Color Map tool card, you can select and edit the color map that is used
for VRT rendering in the 3D viewer.

A color map assigns colors and transparencies to different tissue types as defined
by their window level. By selecting and adjusting a color map, you focus on struc-
tures and tissue types that are of particular interest to you. With a suitable color map
you can display these structures particularly clearly and hide what would only dis-
tract you from the question at hand.

A number of predefined color maps came with your system. Advanced users can
adjust these or define their own set of 3D color maps. When you save a hew or
adapted color map, you can make it available for all users or for your own user
account only.

Note

Some of the available color maps, for example, gray ramp and temperature, can
only be edited to a limited extent. In these color maps you can adjust only the
data windows of the tissue types but no color and transparency settings. You
cannot save changes to these color maps either.

Use the following controls to select the dataset and color map that you want to
change, and to manage color maps.

Fusion mode only.

Select which of the two color maps you want to edit, the color map of the primary
dataset or the overlay dataset.

Click the arrow button next to the currently selected color map label to drop down a
list of all color maps available in your system

Click Reset to return to the original 3D color map and to revoke your changes.
Click Save to save changes or to create a new color map. A dialog box opens.

Enter a color map name and decide whether the new color map will be available for
all users or for your user account only.

Click Delete to remove the selected color map from the list.
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Color map editor

Moving or resizing the
histogram

Editing a graph

The color map editor shows the histogram of grayscale values or HU values of the
selected dataset as a background image. The graphs that overlay the grayscale his-
togram represent the tissue types and their color and transparency settings for VRT
rendering.

You can edit these graphs to change the color map.

You can change the data window for a tissue type.
See Moving or resizing the histogram

You can select different colors for each graph or you can change the transpar-
ency settings for a tissue type.

See Editing a graph

You can change the tissue type description.
See Editing a graph

You can add or delete tissue type graphs.

See Adding or removing a graph

. Click the black area above or below the grayscale histogram, and hold the

mouse button down.
The cursor changes its shape: it turns into a double-arrow.

Drag the mouse to the right or left to move the histogram and to show areas to
the right or left that were previously hidden.

-Or-

Drag the cursor up or down to condense or expand the histogram.

EEEEEEEENNF " lll-
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1. Click a graph to select it.

Drag the boxes along the bottom line of the histogram to change the window
center and window width of this tissue type.

-Or-

Double-click the boxes along the bottom line or at the apex or apices to change
the color definition of the graph.

-Or-
Drag these boxes up or down to change transparency settings.
-Or-

Click the tissue description text above the histogram and edit this text.
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Renaming a graph

Adding or removing a
graph

Display

Display tool card in
fusion mode

Primary Dataset, Overlay
Dataset

Histogram and color
map

EEEEENEENENNF"
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1. Select a tissue graph.

The name of the selected tissue type appears above the graph section.

2. Select this text to overwrite it.

1. Right-click next to a graph to open a menu.

2. Select New Tissue to add a new graph.
-Or-
Select Delete Tissue to delete the selected graph.
-Or-

Select one of the listed tissue types for editing.

On this tool card you can adapt display settings in the selected viewer. The Display
tool card offers slightly different controls depending on the selected viewer and
whether fusion mode is active or not.

When you have loaded suitable data, you use this tool card to turn fusion mode on
and off and to adjust display settings.

Use these check boxes to turn fusion mode on and off.

Select which dataset to display on top of the other from the drop-down lists below
the Primary Dataset and Overlay Dataset check boxes.

Fusion display is particularly suitable for studies from combined multimodality scan-
ners, such as CT-PET and CT-SPECT. However, you can also use this feature to
overlay two CT series, for example.

Use the slider below a histogram to adjust the window settings for this dataset. Or
drop down a list of color maps with the arrow button to the right of the histogram
and select a suitable color map.
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Fusion slider

Edge enhancement
slider

Display tool card in
nonfusion mode

Dataset selection

Histogram and color
map

Always Highest Resolu-
tion

Cine tool card for MPR
viewers

Use this slider to fade between the primary and the overlay datasets. If you move
the slider all the way to the left, only the primary dataset is visible. If you move it all
the way to the right, only the overlay dataset is visible.

If Smart Fusion Slider is configured in the tool properties for fusion mode, image
display switches to grayscale inverse for a 100% PET image. See Properties dialog
box, page 202, for information about how to configure tool properties.

Use this slider to adjust the sharpness of images.

This slider is available only when the Edge Enhancement tool is selected.

When you have loaded data that is not suitable for fusion display, you use this tool
card to adjust window level and image resolution.

If you have loaded more than one dataset, use the drop-down list of the Display
tool card to select which dataset to display.

Use the slider below the histogram to adjust window settings. Alternatively, drop
down a list with the arrow button to the right of the histogram and select a color
map.

This check box is available only if the active viewer is an MPR viewer, the CPR
viewer, or the lumen viewer.

Select this box to show full resolution images even during image processing. This
might slow down system performance. To show a downsampled image during pro-
gram interaction, clear this check box.

With the controls on the Cine tool card you can animate image display in a viewer.
For example, you can scroll through images in an image stack, or play back a time
series or a video. In the 3D viewer, you can rotate the volume or move the crop
plane through the volume.

You can record these animations for presentation purposes, for example. You can
save the resulting images as a new DICOM series (.dcm) on the primary server or
send them to another DICOM server. Or save images on your computer as an
MPEG movie (.mpg), or as JPEG (.jpg), PNG (.png), or DICOM (.dcm) images.

The Cine tool card looks slightly different depending on the loaded data and the
selected viewer.

The following options are available for MPR viewers with image stacks or time
series.

Batching Select whether you want to scroll through the slice images (Stack) or whether you
want to show a time series over the acquired time (Time).

Position Select the first and last image of your movie.
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Increment

Frame Rate

Play Speed

Update All Viewers

Cine tool card for 3D
viewers

Batching

Parameters

Axis

Frame Rate

Play Speed

Best 3D Quality

Select an increment for scrolling. The increment can either be the Same as Slice
Thickness or any other value in millimeters (Custom).

Select Frame Time, Frame Time Vector, or Recommended Display Frame Rate
to play back the movie with the frame rate defined in the DICOM data.

-Or-

Select User-Defined to define the frame rate in frames per second (FPS) here on
the Cine tool card.

-Or-

Select Default Cine Rate (User Property) to play back the movie with a preferred
frame rate, which you have defined in your user profile.

Use this slider to slow down or speed up playback interactively.

Only active for time series.

With this check box you decide whether to apply cine mode to all viewers or to play
the film in the selected viewer only.

The following options are available for 3D viewers.

Select an animation mode here:
Rotate - this rotates the entire volume.

Crop - this has a crop plane move through the volume. This option is shown only if
the Crop Plane tool is currently turned on.

Time - this plays the volume back over time. This option is available only if the
loaded dataset is a time series.

Select the rotation Angle (360° is full rotation) and Increment.

Select a rotation axis and decide whether this axis refers to the patient coordinate
system (Object Coordinates) or to Screen Coordinates.

Select Frame Time, Frame Time Vector, or Recommended Display Frame Rate
to play back the movie with the frame rate defined in the DICOM data.

-Or-

Select User-Defined to define the frame rate in frames per second (FPS) here on
the Cine tool card.

-Or-

Select Default Cine Rate (User Property) to play back the movie with a preferred
frame rate, which you have defined in your user profile.

Use this slider to slow down or speed up playback interactively.

Select this box for slow playback in best 3D quality.
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Update All Viewers

Cine tool card for CPR
or lumen viewer

Batching

Position, Increment

Parameters, Axis

Frame Rate

Play Speed
Best 3D Quality

Update All Viewers

Only active for time series.

With this check box you decide whether to apply cine mode to all viewers or to play
the film in the selected viewer only.

The following options are available if the active viewer is the CPR viewer or lumen
viewer.

Select whether you want to scroll slice by slice (Stack) or whether you want to
rotate around the segmented structure or vessel (Rotation).

Only active if you have selected Stack.
Select the first and last image of your movie.

Select an increment for scrolling. The increment can either be the Same as Slice
Thickness or any other value in millimeters (Custom).

Only active if you have selected Rotation.
Select the rotation Angle (360° is full rotation) and Increment.

Select a rotation axis and decide whether this axis refers to the patient coordinate
system (Object Coordinates) or to Screen Coordinates.

Select Frame Time, Frame Time Vector, or Recommended Display Frame Rate
to play back the movie with the frame rate defined in the DICOM data.

-Or-

Select User-Defined to define the frame rate in frames per second (FPS) here on
the Cine tool card.

-Or-

Select Default Cine Rate (User Property) to play back the movie with a preferred
frame rate, which you have defined in your user profile.

Use this slider to slow down or speed up playback interactively.
Select this box for slow playback in best 3D quality.

Only active for time series.

With this check box you decide whether to apply cine mode to all viewers or to play
the film in the selected viewer only.
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Cine tool card for
videos

Batching

Frame Rate

Play Speed

Playback tools
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Progress bar slider

The following options are available if the active viewer shows a video.

Indicates that the active viewer displays a video file (MPEG or H264)

Select Frame Time to play back the movie with the frame rate defined in the video.
-Or-

Select User-Defined to define the frame rate in frames per second (FPS) here on
the Cine tool card.

-Or-

Select Default Cine Rate (User Property) to play back the movie with a preferred
frame rate, which you have defined in your user profile.

Use this slider to slow down or speed up playback interactively.

Use the following tools on the Cine tool card to start or halt cine display:

Click Play or use the keyboard shortcut C to play your film back once.

Click Pause or use the keyboard shortcut C again to pause the playback.

Select Loop to play the film in an endless loop.

Select Swing to play the film in a bouncing loop: When the playback reaches the
last image, the movie is played backward to the firstimage, then forward again, and
SO on.

Click Record to open the Cine Options dialog box.
(Not possible if a video is displayed.)

Choose whether to save your film as an MPEG movie or as a slide show. Alterna-
tively, you can save the film as a new DICOM series on your local computer or on a
connected DICOM server.

Use this slider to fast-forward or rewind the video.
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Line Profile

Controls on this tool
card

Linear/Log

xly- axis

The Line Profile tool card shows the grayscale or HU value profile of a selected
distance line. If there is only one line in the image, the profile of this line is shown
even if you have not selected it.

If you have moved a distance line that was in your way no line profile can be shown.
Move the distance line back to its original position to redisplay the line profile.

Use the controls on this tool card to save line profile data or to create a screenshot.

Select linear or logarithmic scale.

The x-axis shows the length of the line or lines, the y-axis represents grayscale val-
ues, HU (Hounsfield units), or SUV (standard uptake values).

In fusion mode, two profiles are shown, one for the primary image and one for the
overlay image. The colors of the lines correspond to the colors of the units shown
on the two y-axes.

Click this button to create a screenshot of your line profile or profiles. The screen-
shot is sent to the Export window. From the Export window, you can save it to hard
disk, or drag it into your report.

Click this button to save the data of your line profile onto your hard disk as a
comma-separated list (*.csv file).
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Complex tools and applications

This section describes complex tasks and applications that involve more than one
tool or a combination of tools from toolbars and tool cards.

Batching tools and tool card

Stacked batching tools

AGE

Batching is a process that generates new slice images (reformats) from a volume
dataset and saves them on the server or on your local computer.

Two types of batching are possible with Visage 7:
» Stacked batching

* Rotational batching

Stacked batching

8

Stacked batching is a process in which a new stack of coplanar reformats is created.

When you click the Stacked Batching tool, a new toolbar appears in the lower right
corner of the active viewer. Here you find tools for creating a new image series.
Toggle Direction

This button reverses the direction in which you will walk through the volume.

Toggle Aspect Ratio

This button plans new images either in the resolution of the viewer or in a standard
512x512 pixel resolution. 512x512 is available for grayscale images only.

Toggle RGB/Grayscale
With this button you select the color scheme for the reformats: grayscale or RGB.

Grayscale creates a new series of medical images. These images can be win-
dowed, resized, or evaluated in future postprocessing sessions, just like any other
DICOM series.

RGB images are screenshots and any information that they contain is burnt into the
images. This means that you cannot change any of their display parameters or per-
form measurements in these images in future postprocessing sessions.

Save/Send

With this button you start the batching process and save your new series on the
server or on a DICOM node. See Saving, sending, or exporting images.
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Export

With this button, you start the batching process and export the new images to your
local computer or to a folder in your network. See Saving, sending, or exporting
images.

Open Tool Card

With this button, you open the Batching tool card in stacked batching mode. On
the tool card, you can specify the number of images to be created, their slice thick-
ness, overlap, and slice distance.

Cancel

With this button, you exit stacked batching mode without creating a new series.

On the Batching tool card, you define slice parameters and you lock or unlock
parameters.

Unlocking a parameter means that this slice parameter changes when you adjust
the range of the new image stack graphically in the scout images.

Locking or unlocking of slice parameters affects only graphical processing steps.
You can overwrite slice parameters on the Batching tool card irrespectively of
whether they are locked or not.

This parameter defines how many new reformats will be created.
This parameter defines the slice thickness of the new reformats.

This parameter indicates whether and how much images overlap. A positive value
creates overlapping slices, a negative value creates gaps between slices.

With these buttons, you define the direction in which you will walk through the vol-
ume.

This parameter defines the distance between corresponding slice boundaries.

With this button, you can open the configuration dialog box for stacked batching.

See also Properties dialog box, page 202.

Save/Send

With this button, you start the batching process and save your new series on the
server or on a DICOM node. See Saving, sending, or exporting images.

Export

With this button, you start the batching process and export the new images to your
local computer or to a folder in your network. See Saving, sending, or exporting
images.
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Rotational batching
tools
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Rotational batching

2 &

Rotational batching is a process that creates new reformats from a volume dataset
by rotating around a center point. In 3D this gives you the impression of walking
around the volume. Rotational batching can be started from MPR viewers or from
CPR viewers.

When you click Rotational Batching (Vertical) or Rotational Batching (Horizon-
tal), a new toolbar appears in the lower right corner of the viewer. Here you will find
tools for creating a new image series.

Toggle Direction

This button reverses the direction in which you will walk around the volume.

Center Rotation Axis

This button moves the rotation axis to the center of the preview image. This function
is useful if you have panned the image in the viewer that is to become the preview
before you started rotational batching.

Toggle Aspect Ratio

This button plans new images either in the resolution of the viewer or in a standard
512x512 pixel resolution. 512x512 is available for grayscale images only.

Toggle RGB/Grayscale
With this button, you select the color scheme for the reformats: grayscale or RGB

Grayscale creates a new series of medical images. These images can be win-
dowed, resized, or evaluated in future postprocessing sessions, just like any other
DICOM series.

RGB images are screenshots and any information that they contain is frozen into
the images. This means that you cannot change any of their display parameters or
perform measurements in these images in future postprocessing sessions.

Save/Send

With this button, you start the batching process and save your new series on the
server or to a DICOM node. See Saving, sending, or exporting images.

Export

With this button, you start the batching process and export the new images to your
local computer or to a folder in your network. See Saving, sending, or exporting
images.

Open Tool Card

With this button, you open the Batching tool card in rotational batching mode. On
the tool card, you can specify the number of images to be created, their slice thick-
ness, overlap, and slice distance.
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Cancel

With this button, you exit rotational batching mode without creating a new series.

On the Batching tool card, you define slice parameters and you lock or unlock
parameters.

Unlocking a parameter means that this slice parameter changes when you adjust
the range of the new image stack graphically in the scout images.

Locking or unlocking of slice parameters affects only graphical processing steps.
You can overwrite slice parameters on the Batching tool card irrespectively of
whether they are locked or not.

This parameter defines how many new reformats will be created.
This parameter indicates the increments between slices.
This parameter defines the slice thickness of the new reformats.

With these buttons, you define the direction in which you will walk around the vol-
ume.

With this button, you can open the configuration dialog box for rotational batching.

See also Properties dialog box, page 202.

Save/Send

With this button, you start the batching process and save your new series on the
server or on a DICOM node. See Saving, sending, or exporting images.

Export

With this button, you start the batching process and export the new images to your
local computer or to a folder in your network. See Saving, sending, or exporting
images.

Saving, sending, or exporting images

You can save, send, or export images from all the toolbars of all three batching
modes and from the Batching tool card.

Save/Send or Export starts the actual batching process. It is not until you click one
of these buttons that new images are actually created.
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Tip

In Visage 7 we make a distinction between the concepts of saving, sending, and
exporting data. Saving data means storing data on the Visage 7 server in
DICOM format. Sending data means transferring data to a connected DICOM
node. Exporting data means downloading data to the file system of your local
computer, or to a network drive and folder.

Save/Send

With this button, you save the new series on the server or on a DICOM node. Click-
ing Save/Send opens the DICOM Send dialog box. Here you select send options:

Destination - select one or several servers where you want to save the new series.

Scout Images - select whether you want to include the scout images in the series.
If you also select Show Measurements and Annotations and Show Orientation
Cube under Scout Images, this refers to scout images but not to new reformats.

Series Number and Series Description - enter a series number and series
description. For example, enter a high number to append the series to the end of
the study.

Make Default - this button saves your settings as program suggestions for subse-
quent batching jobs.

Save - this button starts the batching process and sends the new series to the
selected server or servers.

Export

With this button, you export the new images to your local computer or to any folder
in your network. Depending on the color scheme that you selected earlier, clicking
Export opens the Export Grayscale dialog box or the Export RGB dialog box.

Export as - select the file format of the new images. Note that the file formats *.jpg,
*.mpg, and *.png are available only for RGB images but not for grayscale images.
Note also that when you select DICOM for RGB images this creates screenshot
images only. Windowing and measurements are only possible in new reformats of
the type grayscale plus DICOM format.

Destination - click Browse to select a destination folder.

Scout Images - select whether you want to include the scout images in the series.
If you also select Show Measurements and Annotations and Show Orientation
Cube under Scout Images, this refers to scout images but not to new reformats.

Options - for grayscale DICOM images enter a series number and series descrip-
tion. For RGB images of any file format, select whether patient information and ori-
entation labels are to be shown permanently in the images.

Export - this button starts the batching process and saves the images on your local
computer or in a folder of your network.
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3D segmentation tools and tool cards
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Visage 7 provides various tools and techniques for 3D segmentation. 3D segmenta-
tion is the process of identifying objects in 3D and defining their contours. As a
result of 3D segmentation, the system has assigned each voxel in the volume either
to this object or to surrounding structures.

3D segmentation is relevant in a variety of contexts and for a variety of objects or
structures. In all applications, 3D segmentation is the first step before objects can
be removed or before structures can be analyzed in greater detail. Visage 7 pro-
vides tools for automatic, semiautomatic, or manual 3D segmentation and also per-
mits a combined approach.

Tools for automatic removal of structures

These tools segment and remove specific structures automatically. Both tools are
available for CT datasets only.

Caution

Automatic segmentation tools (remove table, remove leg bones, remove chest
wall) support the physician by hiding structures that occlude important informa-
tion in the images.

However, the software cannot guarantee that the detected pixels correspond to
the actual anatomical structures for each individual patient and scan. It is the
responsibility of the user to check whether any relevant structure has been acci-
dentally removed. In that case, simply click the respective tool again to bring the
removed structures back.

Remove Patient Table

Use this tool to remove the patient table from a CT dataset with a single click. Click
the button a second time to redisplay the patient table.

Remove Chest Wall

Use this tool to remove the chest wall or rib cage from a CT thorax dataset with a
single click. Click a second time to redisplay the chest wall.
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Bone segmentation
tools

Run Segmentation Algo-
rithm

Find Lorta

Compute

o Bones Bones Cnly

Load Pre-Computed
Segmentation

%Ja :

Bone removal tool card

For CT angiography datasets, Visage 7 provides a tool for semiautomatic segmen-
tation of the bones of the legs, or of pelvis and spine.

Caution

The Bone tool card supports the physician in finding bone structures in the image
data.

However, the software cannot guarantee that the detected and displayed struc-
tures actually correspond to the bones of the pelvis, spine, and the bones of the
legs. It is the responsibility of the user to check the plausibility and accuracy of
the presented data.

The Bone tool card guides you through the segmentation process step by step.

Select Run Segmentation Algorithm and also which bones you want to remove.

Next, click Find Aorta.

The system attempts to find the aorta and asks you to verify the aorta position
before you continue.

If the system cannot identify the aorta, you are prompted to identify it manually. In
an MPR viewer, scroll to a slice in which the aorta is clearly visible. Move the scout-
line crosshair so that its center points to the aorta.

Next, click Compute.

Use these buttons to switch between display of vessels only, bones only, or display
of both bones and vessels.

Click Reset, if bone segmentation did not yield correct results. Run the algorithm
again. However, pay closer attention to the aorta verification step this time.

Bone segmentation with the Bone tool card is automatically stored by the system.

The next time you load the same dataset, you do not have to perform bone removal
again. Instead, load the results from the last segmentation run.

Select Load Pre-Computed Segmentation and click Load.
-Or-

Remove Leg Bones

Use this tool on the toolbar to reload bone segmentation.

If no segmentation information exists for this dataset, a message requests you to
run the segmentation algorithm on the Bone tool card first.
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Freehand cropping tool

Use this tool to segment structures manually.
1. Click the Freehand Crop button on the toolbar to select this tool.

2. Select the viewer that shows the structure that you want to crop particularly
clearly.

3. Drag the mouse around the structure.

When you release the mouse button the system closes the shape.
After you have drawn a freehand shape, a new toolbar appears in the lower right
corner of the active viewer. Use the tools on this toolbar to remove the volume
inside or outside the freehand shape.
Remove Inside
Use this button to remove all that lies inside the shape that you have just drawn.
_Or-
Remove Outside
Use this button to remove all that lies outside the shape that you have just drawn.

The system determines what to remove from the volume by extruding the shape
through all slices in the direction orthogonal to the current image plane. These vox-
els are removed from the volume in the 3D viewer.

Remove Last Contour

Use this button to delete the last shape that you drew in this viewer.

Reset Remove

Use this tool to reset freehand cropping. The complete volume is shown again.

Accept and Exit

Click Accept and Exit to accept cropping and to close the Freehand Crop tool.
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Segmentation princi-
ples

Key terms for manag-
ing 3D segmentation

Tools on the Edit tool
card

R

Edit tool card

The Edit tool card offers tools for threshold-based segmentation or contour-based
segmentation and also for managing segmentation results.

Two basic principles exist for identifying a structure within a volume dataset:
+ Threshold-based segmentation

Threshold-based segmentation combines graphical identification of what to seg-
ment and definition of a range of grayscale or HU values.

» Contour-based segmentation

Contour-based segmentation expects you to draw a contour around the structure
that you want to segment in two or more slices. The system then connects the
contours throughout the volume and identifies all voxels that lie within the 3D
contour as belonging to the selection.

To be able to manage 3D segmentation results efficiently, you need to be familiar
with the following key terms:

« Selection

When you identify a structure with threshold-based segmentation tools or con-
tour-based segmentation tools, you create a selection. A selection is shown red
until you add it to an object, remove it from an object, or clear the selection.

* Object

An object is a named 3D segmentation result. You can add selections to an
object, remove selections from an object, and show, hide, and fade objects that
you have segmented in your volume.

Use these tools on the Edit tool card to segment portions of the volume and man-
age objects.

Connected Voxels in Value Range (3D)

When you select this tool, the system highlights certain structures in the MPR view-
ers. These structures have a grayscale or HU value that lies within the range that is
defined by the Data Range slider on the Edit tool card. In the 3D viewer, only struc-
tures of this data range are visible now.

Now click the structure of interest. This is either a visible structure in the 3D viewer,
or a yellow area in an MPR viewer. The system creates a selection now. The selec-
tion is shown red.

Encircle Voxels in Value Range (3D)

When you select this tool, the system highlights structures of the range defined by
the Data Range slider in the same way as for the tool above.

Now draw a freehand shape around the structure of interest. Circle either a yellow
structure in an MPR viewer or a visible structure in a 3D viewer. The system creates
a selection now. The selection is shown red.
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Data Range
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Encircle Voxels in Value Range (2D)

When you select this tool, the system highlights structures of the range defined by
the Data Range slider in the same way as for the tools above.

Now draw a freehand shape around a yellow structure of interest in an MPR viewer.
This selects all voxels within the freehand shape that lie within the specified data
range but only in one slice. If you zoom in on the volume in the 3D viewer you see
that only a small ribbon is shown red.

Use the data range slider or Min. and Max. boxes to define or fine-tune the data
range of the structure that you want to segment.

Define Contour in 3D

This tool starts contour-based segmentation, which is independent of the data
range that is defined by the Data Range slider.

When you select this tool, a new toolbar appears in the lower right corner of the
active viewer.

Select New Elliptical Contour or New Freehand Contour and roughly circle the
area of interest, or select New Balloon Contour, click, and drag out. (See also
Freehand 3D ROI, page 105)

Use the Refine Contour tool to correct and refine contour lines.

Click anywhere in the image and drag the mouse to show a circle with which you
can correct the ROI graphic. The further away from the contour line you click, the
larger the circle will be.

Click inside the ROI graphic to enlarge the ROI graphic by pushing the contour out.
Click outside the ROI graphic to use the circle to push the contour line in.

The precision required in contour definition depends on the clinical task at hand.
Use your clinical judgement to determine the required accuracy for this contour
definition task.

Scroll to the next slice, and repeat contour definition and refining. You do not have
to use the same contour definition tool in all slices. Choose whichever tool is most
appropriate from slice to slice. Moreover, you do not have to define a contour in all
slices. If the contour of the structure does not change significantly for a few slices

you can skip contour definition in these slices.

Proceed in the same way in several slices until you reach the last slice in the image
stack that shows the structure.

Click OK when you have finished drawing and refining the contour in the last slice.
OK ends contour-based segmentation. The system interpolates your contours and
creates a selection, which is shown red.
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Objects list

Selection Brush (2D)

Use this tool to select voxels or to correct a voxel selection created with another
segmentation tool or algorithm.

Click the arrow next to the tool to select the size of the brush.

Click in an MPR viewer and hold the mouse key down while you move the mouse
over the area that you want to select.

-Or-

Hold the Shift key down while you click and drag the mouse across the image to
remove voxels from a selection.

Note that with the Selection Brush tool you select voxels or correct voxel selection
in one slice at a time.

Use the Grow and Grow 2x buttons to expand the selection by a few pixels.
-Or-

Use the Shrink and Shrink 2x buttons to reduce your selection.

Use Clear to undo a selection that you have not yet assigned to an object, and to
start again from scratch.

By default, this list contains the objects Exterior and Cropped.

Consider Cropped a generic container for any portions of the volume that you want
to remove but not name. Exterior is a container for all portions of the volume that
are not assigned to Cropped or any other object.

If you have already performed segmentation with another segmentation tool, such
as the Remove Patient Table tool, these objects are also listed here.

Right-click the list to create a new object or to manage existing objects in the list.

Click the plus button to the right of an object to add a selection to an object.
-Or-
Click the minus button to the left of an object to remove a selection from this object.

Use the lock button to the right to allow modification of an object (green and open
lock) or to protect an object from accidental modification (red and closed lock).

Save Segmentations as Presentation State
With this tool you can save segmentation results in a DICOM presentation state.

In Study Browser, the presentation state appears as a new series with modality
PR. The next time you load this study, segmentation results from a previous ses-
sion will be available again.
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Contour-based seg-
mentation

2D and 3D structures

Freehand 2D structure

Structures tool card

You use the Structures tool card to perform contour-based segmentation of a com-
plex structure, for example, a tumor or an entire organ. You can then evaluate the
structure, calculate its area or volume, and move on to the Statistics tool card.

Contour-based 3D segmentation expects you to draw a contour around the struc-
ture that you want to segment in several slices. The system connects the contours
throughout the volume and identifies all voxels that lie within the 3D contour as
belonging to the selection.

On the Structures tool card, you can segment both 2D structures and 3D struc-
tures.

2D and 3D structures are the same as freehand 2D or 3D ROls that you draw with
the corresponding tools from the toolbar. See also Freehand 2D ROI, page 104, and
Freehand 3D ROI, page 105.

Click the New 2D button on the tool card. A new toolbar appears in the lower right
corner of the active viewer.
New Elliptical Contour

Use this button to enclose the area of interest with an ellipse. Click a start point, and
drag the mouse out to draw a circle or ellipse.

New Freehand Contour

Use this button to draw a freehand shape. Click a start point on the contour. Hold
the mouse button down and draw a contour line.

New Balloon Contour

Use this tool to draw a border around a structure or area of interest of a specific
brightness. Click in the structure and drag out.

Append mode

.:lr‘.'.

With any of the contour tools, use the Shift key to start Append mode (the cursor
turns into an arrow with a plus sign).
Draw a contour or select a contour you have drawn earlier.
Press and hold the Shift key down and then draw a second contour.
If the contours overlap, the system merges them into a single ROI. If the contours
do not overlap, the system nevertheless interprets them as parts of a single region
of interest. Add a third contour to this ROI, if necessary.
Release the Shift key to turn Append mode off again.
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Freehand 3D structure

Refine Contour
Use this tool to correct or refine contour lines.

Click anywhere in the image and drag the mouse to show a circle with which you
can correct the ROI graphic. The further away from the contour line you click, the
larger the circle will be.

Click inside the ROI graphic to enlarge the ROI graphic by pushing the contour out.
Click outside the ROI graphic to use the circle to push the contour line in.

Undo

Use Undo to retrace your steps.

OK

Click OK when you have finished drawing and refining 2D ROls to close the tool.

Click the New 3D button on the tool card.

A new tool card appears in the lower right corner of the active viewer.

New Elliptical Contour

Use this button to circle the area of interest with an ellipse. Click a start point, and
drag the mouse out to draw a circle or ellipse.

New Freehand Contour

Use this button to draw a freehand shape. Click a start point on the contour. Hold
the mouse button down and draw a contour line.

New Balloon Contour

Use this tool to draw a border around a structure or area of interest of a specific
brightness. Click in the structure and drag out.

Append mode

With any of the contour tools, use the Shift key to start Append mode (the cursor
turns into an arrow with a plus sign).

Draw a contour or select a contour you have drawn earlier.
Press and hold the Shift key down and then draw a second contour.

If the contours overlap, the system merges them into a single ROI. If the contours
do not overlap, the system nevertheless interprets them as parts of a single region
of interest. Add a third contour to this ROI, if necessary.

Release the Shift key to turn Append mode off again.
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Editing structures

Refine Contour
Use this tool to correct or refine contour lines.

Click anywhere in the image and drag the mouse to show a circle with which you
can correct the ROI graphic. The further away from the contour line you click, the
larger the circle will be.

Click inside the ROI graphic to enlarge the ROI graphic by pushing the contour out.
Click outside the ROI graphic to use the circle to push the contour line in.

When you have finished drawing and refining a ROl graphic in one slice, scroll on to
the next slice and also draw a ROI there.

Undo

Use Undo to retrace your steps.

OK
Click OK when you have finished drawing and refining ROI graphics in all slices.

The system calculates ROI statistics and closes the freehand 3D ROl tool.

Use the structures list on this tool card to select ROIs or contours for editing.
Click a ROI or a contour to show the slice that contains the ROI graphic.

The freehand ROI toolbar opens in the lower right corner of the viewer. You can now
refine the ROI or add more contours to a 3D structure.

-Or-
Right-click a ROl or a contour to rename it.
-Or-

Use the Delete Structure button or the context menu of the structures list to delete
a ROI.

Use the button to delete an entire ROI.
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Tip
If ROI graphics are in your way in further image evaluation steps, clear the MPR
check box in the structures list. This hides ROI graphics in MPR viewers.

ROls are usually not shown in the 3D viewer. Select the 3D box for a ROl in the
structures list to ensure that this ROl is visible in the 3D viewer.

Converting a ROl into When you create a 3D structure or freehand 3D ROI, the program assumes that you
an object want to perform statistical evaluation of this volume of interest. The program does

n

ot automatically assume that you want to turn it into an object too.

To turn a 3D structure or freehand 3D ROI into an object, proceed as follows:

1.

2
3.
4

Select the 3D ROI on the Structures tool card.

. Right-click and select Create Selection.

Go to the Edit tool card.

. Create a new object and add the selection to the new object.

See also Objects list, page 151.

Statistics tool card

T

he Statistics tool card performs statistical analysis of all ROls and structures that

you have defined in your dataset:

Volumes of interest that you have cropped with the Freehand Crop tools
The table, if you removed it with the Remove Patient Table tool

Bones that you have segmented with the Bone tool card

The chest wall, if you removed it with the Remove Chest Wall tool
Vessels that you have analyzed with the Vessel tool card

Structures that you have defined on the Structures tool card

Objects that you have segmented and named on the Edit tool card

Lesions that you have segmented with the Segment Lesion tool on the Lesion
toolbar

Tip

For a better overview, show the Statistics tool card as a floating window.

Double-click the Statistics tab in the tool card section.
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Statistics for the report

Exporting results

1. Click Compute to update the results table on the Statistics tool card.

Compute

2. Click the Screenshot Statistics button in the upper left corner of the Statistics
tool card.

This button creates a screenshot of the entire results table and sends it to the
Export window. You can drag the screenshot into your report from there.

_Or_
Select one or several rows in the results table and click the Screenshot

Selected Statistics button if only selected measurements are relevant for the
report.

If you want to evaluate statistics any further, export the entire results table or only
individual lines as comma-separated lists (*.csv). Comma-separated lists can be
imported in spreadsheet programs, such as Excel.

Click Export CSV.

Export C5%

-Or-

Select one or several rows in the results table and click Export CSV Selected.

Export C3

Vessel analysis tools and tool card

Visage 7 provides tools specifically for the segmentation and analysis of vessels in
3D datasets of CT and MR angiography studies.

These tools are available from the Vessel tool card and from toolbar buttons. If you
plan to trace more than one vessel in a dataset, start from the Vessel tool card.

Caution

Vessel tracing supports physicians in finding vessel-like structures in the image
data and in navigating quickly along these structures for efficient review.

However, the software cannot guarantee that the detected and displayed struc-
tures correspond to an actual vessel fragment. It is the responsibility of the user
to check the plausibility and accuracy of the presented data.
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Defining a new curve

Semiautomatic versus
manual vessel tracing

Image navigation
during curve definition

1. Select and name the vessel you are about to trace.
-Or-
Right-click the vessels list and insert a new vessel.
2. Define and edit a curve and start vessel tracing.
See Curve definition and vessel tracing.
3. Switch to one of the overview and analysis views for further vessel evaluation.

See Curved View, page 159, or Lumen View and Cross-Section View, page 160.

Curve definition and vessel tracing

'

You use the Define/Edit Curve tool on the toolbar or on the Vessel tool card to start
curve definition.

1. Click Define/Edit Curve to start curve definition mode.

2. Now click control points along the vessel, either in the 3D viewer, or in MPR
viewers, or in a combination of both.

3. End curve definition and have the system trace the vessel.

When you define a curve and trace a vessel be aware that two vessel tracing
modes exist, semiautomatic vessel tracing and manual vessel tracing.

* In semiautomatic vessel tracing a user clicks control points and the software
searches for the vessel segments between these points. Semiautomatic vessel
tracing uses a tracing algorithm that uses information such as pixel value thresh-
olds and gradients to identify vessel segments.

Click points between which you want the system to trace the vessel. This creates
green dots in the images.

* In manual vessel tracing the program assumes that the user-defined control
points lie on the centerline of the vessel. The software then connects these
points by straight lines instead of performing a search.

To define manual control points, press and hold the Shift key while you click.
This creates blue dots in the images.
Tip

You can even combine the two methods to connect critical points where auto-
matic, that is voxel-density-based tracing, would fail.

Even while you are defining or editing points, you can return to standard image nav-
igation functions by holding the Ctrl (Windows) or Cmd (Mac) key down. For exam-
ple, press and hold the Ctrl or Cmd key and drag in an MPR viewer to scroll
through the stack, or drag in a 3D viewer to rotate the volume.
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Switching endpoints

Editing existing curves
or vessels

Tools in the curve edit-
ing toolbar

74

V4

When you define a new control point for a vessel, the software automatically con-
nects it to the closest endpoint of the vessel. This point is shown as a pink box.

In very curved vessels, both endpoints might lie close to the new point and the soft-
ware might pick the wrong endpoint. If this happens, switch to the correct endpoint
manually. Press and hold both the Shift and Ctrl (Windows) or Cmd (Mac) keys
when you define a new point.

If you have already defined a curve or vessel, use the Define/Edit Curve tool to edit
control points and points inserted by the software.
1. On the Vessel tool card, select the curve or vessel that you want to modify.
2. Click Define/Edit Curve to start curve-editing mode.
Now you can see points along the curve in your MPR and 3D viewers.
3. Click a point to position the MPR crosshair exactly on this point.
-Or-

Click a point and drag the mouse to change its 3D position but without position-
ing the MPR crosshair on this point. After you have moved a point, the software
retraces the segments adjacent to this point and adjusts the curve accordingly.

4. To delete a point, briefly rest the cursor on the point to select it, then press the
Del or Backspace key. Surrounding curve segments are retraced.

-Or-

To define new points, position the mouse away from an existing point and click,
or press and hold the Shift key and click. New points are connected to the clos-
est endpoint of the curve.

-Or-

Position the cursor between two existing points to highlight a curve segment.
Click the segment and drag the mouse to define an additional control point
between two existing points.

When you select the Define/Edit Curve tool, a new toolbar appears in the lower
right corner of the active viewer.
Large Vessel Tracing

Click this button when you have finished clicking points along the length of the rele-
vant vessel section and when you are analyzing a large vessel.

-Or-

Small Vessel Tracing

Click this button if you are analyzing a small vessel, and in particular a coronary
vessel.

To start large or small vessel tracing you can use either a tool on the toolbar or a
tool card button. Both the tools and buttons start the same function. Both the large
and small vessel tracing tools also end curve-editing mode.

-Or-
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Navigating in curved
view

Trace Aorta

Click this button if you are analyzing the aorta.

Show All Vertices

This button is particularly useful if you are using MPR viewers and not the 3D
viewer to define a curve along a vessel.

Show All Vertices projects the curve that you have defined so far onto the cur-
rently shown slice. If you switch Show All Vertices off, only those points that lie in
the currently displayed slice are visible.

Undo

Click this button to undo the last curve editing step.
-Or-

Clear Points

Use the Clear Points button on the Vessel tool card to delete all points and start
curve definition again from scratch.

Accept and Exit

Click Accept and Exit to end curve definition without actually tracing a vessel but
to create a curved view only.

Curved View

Use this tool to open curved view, which is an additional viewer.

If you have not yet defined a curve, this viewer is empty. After you have defined a
curve this viewer shows a projection image of a curved plane defined by the vertices
of your curve definition.

See also Curve definition and vessel tracing, page 157.

1. If you have traced more than one vessel, use the context menu of the CPR
viewer to select which vessel you want to display.

2. Click Toggle Centerline for better orientation.

L
See also Toggle Centerline, page 128.

3. Rotate around the centerline in curved view. Rotation is the standard navigation
tool in the CPR viewer.

W

4. Press and hold the Alt key, and click a point on the vessel in the CPR viewer.

Visage 7

159



Complex tools and applications View windows

Curved view other than
in vessel analysis

Navigating along the
vessel in lumen view

Navigation in cross-
section view

Measuring stenoses

The crosshair moves to exactly this point in all MPR viewers.
You can use curved view not only in the context of vessel analysis but also to ana-
lyze curved structures.
1. For example, use the Define/Edit Curve tool to define a curve along the spine.
2. End curve definition with OK.

See also Curve definition and vessel tracing, page 157.

3. Open curved view.

Lumen View and Cross-Section View

m K

Lumen view and cross-section view are two views particularly for the analysis of
vessels. Both views are not available in any other context. Both views are available
only if you have defined a curve and then clicked either the Large Vessel Tracing
or the Small Vessel Tracing tool.

See also Curve definition and vessel tracing,page 157.

1. If you have traced more than one vessel, use the context menu of the lumen
viewer to select which vessel you want to display.

2. Rotate around the vessel.

The rotation tool is selected automatically in this viewer. Therefore, you can
rotate by dragging the left mouse button.

W

3. Drag one of the vessel sliders to a point of interest.
The active vessel slider is highlighted with an orange triangle at its bottom.

4. Click Switch Active Vessel Slider to switch between vessel sliders.

=

Alternatively, use the keyboard shortcut E to switch vessel sliders.

Clicking and dragging a vessel slider in lumen view turns cross-section view on in
the upper left viewer.

o

Scrolling in cross-section view means navigating along the vessel slice by slice.
While you scroll, the slice orientation changes so that you always see an exact
cross-section of the vessel.

Stenosis calculation can either use line measurements or area measurements.
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Measuring vessel seg-
ment length

1. Use lumen view, or cross-section view, or a combination of both views to move
to points of interest along the vessel.

2. In cross-section view, use the Distance tool to measure vessel cross-sections.

Pl
o

-Or-

Use one of these area measurement tools.

a ‘B (&

In lumen view, measurement results are shown next to the vessel sliders.

3. Right-click a measurement text and classify the measurement. For example,
select Stenosis n%.

0.90 mim

If Stenosis n% is not available, you might have right-clicked the vessel slider
and not the text. Or you have clicked the text of the reference point, which is the
higher value.

In lumen view, use the Distance tool to measure the length of a vessel segment.

Pl
o

The segment length is shown in millimeters in lumen view and the endpoints of the
measurements are indicated in curved view. Measurements are color-coded in both
views.

Cardiac analysis for CT studies

Cardiac analysis options require that the cardiology option is installed and that your
user account has been granted the right to work with this option.

LV Analysis tool card

The LV Analysis tool card provides tools for LV segmentation and LV analysis. The
tool card also guides you through LV analysis step by step.
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Step 1: finding and cor-
recting axes

Step 2: segmenting the
left ventricle

Caution

The LV tools support the physician in finding the left ventricle in the image data.
However, the software cannot guarantee that the detected and displayed struc-
tures correspond to the left ventricle. It is the responsibility of the user to check
the plausibility and accuracy of the presented data.

1.

Move the scoutline crosshair to the left ventricle in one MPR viewer.

. Click Find Axes on the LV Analysis tool card.

The system identifies the long and short axes of the left ventricle and selects
Edit Axes mode. The short and long axes are now shown as orange lines in the
MPR viewers.

. Correct axes by moving or rotating the orange lines in the MPR viewers, if nec-
essary.

Next, correct the valve level in one of the long-axis views (pink line).
The endpoints of the valve line serve as rotation handles.

. When you have positioned axes correctly, click Apply.

v

Click Find LV (All Phases).

2. Segment left ventricle (LY.

Fi

Fincl

(Current Phaze)

When segmentation is complete, the left ventricle is shown as a yellow shaded
area in the MPR viewers.

Browse phase images, and check segmentation results in all phases.
oo Om
« P

If you do not agree with segmentation results in one or several images, click
Clear LV. Adjust the valve level and the axes as described above.

Click the Find LV button again when you have finished your adjustments.
-Or-

Proceed slice by slice and use the Clear LV (Current Slice) and Find LV (Cur-
rent Slice) buttons.

When segmentation has been performed correctly, proceed with LV analysis
step 3.
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Step 3: time-volume
analysis

LV analysis results

Summary

Global volume

Bull’'s-eye view

Regional volume, endo-
cardial distance

Wall motion, bull’s-eye
motion

Click Results to start time-volume analysis of the left ventricle.

3. Time-volume ans

Results

LV Results tool card

The LV Results tool card or floating window appears after you have clicked Results
on the LV Analysis tool card.

When the LV Results is a floating window, it consists of three segments:

* Summary section

» Curve display section

» AHA (American Heart Association) bull’'s-eye view

When you display the LV Results card in one of the tool card stacks, only one of

these segments can be shown at a time.

Use the drop-down selection box in the lower left corner of the tool card to select a
different view of your LV analysis results.

Enter the heart rate of your patient here. The cardiac output value is updated auto-
matically.

Also adjust the system’s selection of the end-diastolic (ED) and end-systolic (ES)
phases with the sliders, if necessary.

Here you find a graph of the total LV volume over one heart cycle.

View the results of the calculation of regional ejection fractions (%) in a bull’'s-eye
view. The segments in this bull’'s-eye display correspond to the AHA classification.

Move the cursor over a segment to show the segment designation as a tooltip. Or
right-click anywhere in the bull’s-eye view for a context menu with commands for
switching between results view and segment ID view.

In this segment you find the stroke volume curves of the LV regions.

Initially the curves of all regions are shown. If you find this view hard to read, right-
click anywhere in this section. Select individual region curves.

When you create a report, only those curves that are currently shown will be
included.

This segment shows the accumulated wall motion in a bull’s eye view.

Click Report in the lower right corner of the LV Results window to send screen-
shots of all graphs and analysis results to the Export window.
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Tools for identifying
plaque

Calcium Scaring

huti-Slice Mode

Reporting tools

Coronary Artery Age

Sex, Patient Age

Ethnicity

Calcium tool card

Visage 7 provides a tool card for identifying the extent of calcified plaque in coro-
nary arteries. The Calcium tool card is shown when you load a suitable CT study.

Use the following tools on the Calcium tool card to identify plaque in your images.

Click the Calcium Scoring button.
All areas with an intensity of more than 130 HU are highlighted (yellow).

Now start scrolling through the image stack slowly.

When you observe plaque in an image, first select the vessel in which the plaque is
observed. Next, either click into the plaque or click and drag the mouse to draw a
line around the plaque. This assigns the plaque to the selected vessel.

To select a vessel, click one of the following buttons on the tool card: LM (left main
artery), LAD (left anterior descending artery), CX (left circumflex artery), RCA (right
coronary artery), PDA (posterior descending artery), A1, A2, A3 (placeholders for
any other arteries).

Right-click one of the A1 to A3 artery buttons and select Properties. Enter a label
and select a color for this artery.

In multislice mode, both voxels in the slice in which you click and adjacent voxels of
the same density in adjacent slices are assigned to plaque.

With multislice mode turned off, only voxels of the currently displayed slice are
assigned to plaque.

At the bottom of the Calcium tool card, you find tools and input boxes that help you
to prepare your report.

The system calculates this information based on the amount of plaque that you
have identified in the images. You cannot overwrite this information.

Correct this information, if necessary.

The information that you select here refers to the study that you want to refer to in
your report:

Select Undefined, if you want to refer to Hoff, 2001.

(Hoff, Julie Anne et al. Age and Gender Distributions of Coronary Artery Calcium
Detected by Electron Beam Tomography in 35,246 Adults. J. Am. Coll. Cardiology
2001, Vol. 87:1335-1339)

Select White, Black, Chinese, Hispanic, if you want to refer to MESA, 2006.
(McClelland, Robyn L. et al. Distribution of Coronary Artery Calcium by Race, Gen-
der, and Age: Results from the Multi-Ethnic Study of Atherosclerosis (MESA). Cir-
culation 2006, 113:30-37).

Click Report to send your findings to the Export window.
-Or-
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Click Export CVS, to save your results as a comma-separated list on your com-
puter. *.cvs files can be read by spreadsheet programs, such as Excel.

Export C5%

Brain perfusion analysis tools and tool card

Brain perfusion analysis requires that the neurology option is installed and that your
user account has been granted the right to work with this option.

Perfusion toolbar

This toolbar comprises all the tools that you need to perform brain perfusion analy-
sis.

Caution

The brain perfusion tool provides calculated results for neurologic diagnosis and
supports the physician in correcting patient movement in images.

However, the software cannot guarantee that the identified arterial and venous
points are correct and that the data set is suitable for the calculations. It is the
responsibility of the user to check the plausibility and accuracy of the result.

The tools are arranged left to right in the order in which you will need them.

Exclude current Phase from Perfusion Calculation

Browse the time series and decide whether all images can be included in the analy-
sis. If individual images show motion artifacts, for example, you can exclude them
from the analysis with this tool.

Display tMIP

Click this tool to calculate a tMIP image.

In a temporal MIP of a CT dataset, the brightness of each pixel indicates the maxi-
mum pixel value in any of the time steps. In MR datasets, tMIP shows the minimum
pixel value. tMIP helps to show contrast-filled vessels particularly clearly.

A Define Artery

L2 Next, click this button and then the main artery of the brain in the tMIP image.

The point where you clicked is marked as a ROI and an uptake curve for this ROI
appears in the viewer. The update curve for the artery is displayed red.
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Define Vein
Next, click this button and then the main vein of the brain in the tMIP image.

The uptake curve of the vein is added to the graph. The uptake curve for the vein is
displayed blue.

Identification of the vein is necessary in CT datasets, but usually not in MR data-
sets.

Calculate Perfusion
Next, click Calculate Perfusion.

This calculates the following functional maps: mean transit time (MTT), time to peak
(TTP), cerebral blood flow (CBF), cerebral blood volume (CBV).

Mirror Mode
Select the tMIP image (large viewer) and click Mirror Mode.

Drag the orange line so that it separates the left and right half of the brain. By click-
ing and dragging the endpoints you can rotate the line. You might have to move the
plot if it is in your way.

Define ROI
Select one of the functional maps, and click Define ROI.

A new toolbar appears in the lower right corner of the active viewer. The tools on
this toolbar are the same as when you evaluate freehand 2D ROlIs in any other type
of image. Therefore, refer to this section for details on how to work with these tools:
Freehand 2D ROI, page 104.

Use this toolbar to draw an elliptical ROI or a freehand ROI around an area of inter-
est and to refine the contour.

Toggle Mirror Line

If the mirror line is in your way while you are analyzing functional images, use this
tool to hide and later redisplay it. Hiding the mirror line does not turn mirror mode
off, however.

Save/Send Perfusion Result

With this button, you save the new series on the server or on a DICOM node. Click-
ing the button opens the Send perfusion results dialog box. Here you select send
options:

Destination - select one or several servers where you want to save the new series.

Save Options - select how you want to save the maps that were calculated during
perfusion analysis and which maps you want to save. Each map will be saved as a
separate series. The images will have the same slice thickness as shown on
screen.

Original Maps - select this option if you want to save perfusion maps as grayscale
images. This creates new series of medical images. These images can be win-
dowed, resized, or evaluated in future postprocessing sessions, just like any other
DICOM series.
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Presets

Brain Tissue

Remove CSF

Remove Vessels

Colorized Maps - select this option if you want to save perfusion maps as color
images (RGB). RGB images are screenshots and any information that they contain
is frozen into the images. This means that you cannot change any of their display
parameters or perform measurements in these images in future postprocessing
sessions.

Mosaic - select this option if you want to create and send an overview image
showing the tMIP image plus the calculated maps side by side.

Artery and Vein Positions - select this option if you want to save the coordinates
of the artery and vein position that you identified before you had the system calcu-
late perfusion in a DICOM presentation state. In Study Browser, the presentation
state appears as a new series with modality PR. The next time you load this study,
you can resume perfusion calculation or recalculate.

Screenshots - select this option to save or send all screenshots that were created
during perfusion analysis. If you want to save or send only selected screenshots,
use the Export window to do so.

Perfusion results - specify a series number and series description. The various
perfusion result series that will be created when you click Send will count up from
the series number you specify here. The series description text you enter here will
be used as a prefix for the perfusion result series.

Make Default - this button saves your settings as program suggestions for subse-
quent send jobs.

Brain Perfusion tool card

In standard brain perfusion analysis, you might not need to adjust parameter set-
tings on the Brain Perfusion tool card.

Adjust these settings only if default settings do not yield good results.

Brain perfusion presets are parameter sets optimized for specific data acquisition
protocols.

If no presets have been configured for your system, a default parameter set is auto-
matically selected for CT or MR images respectively.

To speed up calculation and to make interpretation of computed maps easier, only
brain tissue voxels are processed in brain perfusion analysis. Therefore, a mask is
computed from the first phase of the perfusion image series. The mask includes
only voxels with values between the Min and Max values that are defined here. All
other voxels are not analyzed during computation.

Default values 0 (Min) and 120 HU (Max) for CT images and 20% and 100% of the
grayscale value range in an MR dataset (indicated as US for “unspecified”).

To speed up the calculation and for ease of interpretation of the computed maps,
voxels that contain cerebro-spinal fluid (CSF) will not be processed.

For ease of interpretation of the computed maps, voxels that contain larger vessels
will not be processed.
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Smoothing

Pre-contrast Images

Last image

Regularization Param.

Auto-Registration

2D Regiztration

Detault (acdult)

e

To improve the signal-to-noise ratio (SNR), a Gaussian image filter can be applied
to all images before the computation. This parameter turns the smoothing filter on
or off and also allows the adjustment of the kernel width of the filter. Larger values
improve the SNR at the expense of a diminished spatial resolution.

This parameter indicates the number of phases acquired before the contrast
medium reaches the brain. The baseline signal is computed by averaging these
images. After definition of the artery, the number of baseline images is determined
automatically.

Defines the last phase of the perfusion images series that is considered in the per-
fusion calculation.

This parameter is used to suppress noise in the source data. Lower values provide
more accurate computation results but are more sensitive to noise.

If this option is selected, an automatic motion registration is performed on the perfu-
sion time series when the user clicks one of the buttons Display tMIP, Define
Artery or Define Vein for the first time and no registration has been performed yet.
If the number of slices in the 3D volume is greater or equal to the number of slices
configured in the user interface, a 3D rigid body motion registration is performed,
otherwise only in-plane shifts and rotations are registered.

If you observe motion artifacts in the tMIP image, register your data before you con-
tinue.

Use the 2D Registration and 3D Registration buttons on the tool card to align
images and to recalculate the tMIP image.

Use the Default (adult) and Default (small children) buttons to switch hematocrit
values between program suggestions for adults and small children. You can fine-
tune these values with the slider further up on this tool card.

Use the Calculate Perfusion button at the bottom of the tool card or toolbar button
if you want to recalculate functional maps after parameter adjustments.

Lesion tracking tools and SUV tool card

Settings on the SUV
tool card

Patient’s weight, height,
and sex

Lesion tracking requires that the oncology option is installed and that your user
account has been granted the right to work with the oncology option.

SUV tool card

Use the SUV tool card to check patient data and SUV settings.

Check these settings after you have loaded a CT+PET study and before you start
lesion tracking.

Check this information and add missing information. This information is relevant for
the calculation of SUV for lean body mass and SUV for body surface area.
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Radionuclide half-life,
total dose, tracer injec-
tion, scan time

Reset to DICOM values

Measured Activity, SUV,
Counts

Make Default

Lesion tool

L

W

Check this information and add missing information, if necessary.

If you have changed patient or radionuclide information, you can use this button to
redisplay the data stored in the DICOM header of the dataset.

With these buttons you can select the units for radionuclide activity in the patient’s
body. Choose between becquerel or standardized uptake values (SUV), or select
Counts for data acquired with Philips scanners.

This button stores the values for the initial data windows and for the preferred SUV
type in the global settings for your user account.

Lesion tool and Lesions tool card

Use the Lesion tool and toolbar to mark and measure lesions.

B

Use the Lesions tool card for an overview of all the lesions that you have identified
in the loaded datasets.

=

Click the Lesion Tool button to show a new toolbar in the lower right corner of the
active viewer.

B

This toolbar comprises all the tools that you need for lesion tracking.

Segment Lesion

Click the lesion in the current study and also in the prior study, if the lesion is visible
in both studies.

If you have identified the lesion in both studies, the system creates a lesion pair,
labels it, and calculates activity.

Measure Lesion, Measure Lesion (2 Diameters)

If automatic lesion segmentation is not possible because of poor image quality or
because of artefacts in the images, resort to manual evaluation tools.

Select either the Measure Lesion or Measure Lesion (2 Diameters) tool, depend-
ing on which standard you follow. Drag the mouse across the lesion to measure its
diameter. Also measure the second diameter, if you work with the Measure Lesion
(2 Diameters) tool. Measure lesion dimensions in the prior study as well.
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Caution

The accuracy of distance measurements is £ 2 pixels. Larger errors can occur if
the image is displayed with reduced matrix size, that is, if not every original pixel
is shown on the screen due to zoom-out. For optimum accuracy, we recommend
zooming into the structure of interest as much as possible. The accuracy is fur-
ther limited by the physical resolution of the acquisition itself. If the monitor used
for display does not permit exact pixel selection, the inaccuracy can be still
greater.

Mark Lesion

» If a lesion does not exist in both datasets, use this tool to mark the spot where a
lesion exists in the other dataset.
Delete Lesion

b Select a lesion by clicking on the lesion text and then use this tool to remove the
marker from the dataset.
Classify Lesion
Use this tool or the keyboard shortcuts to classify a lesion or lesion pair.

A Target Lesion (TL, F1) or a Target Lymph Node (LN-TL, F4) exists in both the
current and prior study and is relevant in both studies.

A Non-Target Lesion (NTL, F2) or a Non-Target Lymph Node (LN-NTL, F5)
exists in both studies but is of no relevance in the prior study.

A New Lesion (NL, F3) or a New Lymph Node (LN-NL, F6) exists in the current
study only.

An Unspecified Lesion (F10) is not considered in the report. Therefore, do not
leave lesions unspecified, unless you explicitly want to exclude them from the
report.

Previous Lesion, Next Lesion

= » Use these tools to browse through your lesion segmentations and to review your
findings.

\E Accept and Exit
Click this tool when you have identified and classified all lesions in your current and
prior study. This tool closes the lesion tool and creates a report in the Export win-
dow.
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Lesions tool card

Name

Type

Current and prior stud-
ies

Click the Open Lesion Toolcard button to show this tool card.

=

The Lesions tool card displays an overview of the lesions that you identified in the
loaded studies.

Tip

If lesions were identified during an earlier session, the system checks whether all
the relevant prior studies have been loaded before moving on to the Lesions tool
card.

The Name column lists all lesions and a summary of lesion diameters in target
lesions.

Click Add Lesion and measure a lesion in an image to identify a new lesion.
Double-click a lesion name in this column to edit the lesion name.

Right-click a lesion in this column or any of the other columns and select Delete to
remove a lesion from the list.

Click a lesion row, hold the mouse button down, and drag this line up or down to
change the order in which lesions are presented in the table.

Double-click the Type column of a lesion and select a different lesion type from the
list. See also Classify Lesion, page 170.

Double-click the Type column of a lesion type summary and select your mode of
working. The DICOM structured report will consider the selected mode.

In the Non-Target Lesions summary row, double-click the cell of the current study
and assess the overall response of non-target lesions: CR (complete response),
PD (progressive disease), Non-CR/Non-PD (neither of the above). Repeat this
step for prior studies if appropriate.

The columns of the current and prior studies show the diameters of the lesions that
you identified in the images.

Click the column header of the current study or a prior study and drag it into a
viewer to show this study in this viewer.

Use the context menu in these columns to split or merge lesions.

Splitting lesions: You have identified areas of activity in corresponding images of
the current and prior study and the system has assigned them to one lesion. In ret-
rospect, you realize that both areas of activity belong to different tumors.

Right-click the current or prior study column of this lesion and select Split into New
Lesion.

Merging lesions: You have identified two areas of activity in the current and prior
study and marked them as two separate lesions. In retrospect, you realize that both
areas of activity belong to the same tumor.
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Select (left-click) the table row of one lesion, and then right-click the table row of the
second lesion. Select Merge With Selected Lesion from the context menu.

Last edited This table row shows the name of the last user who edited lesions in a study.

Point to the table cell of each study to show the complete editing history in a tooltip.

Previous Lesion, Next Lesion

< ® Use these tools to browse through your lesion segmentations and to review your
findings.
Select the Follow button to browse lesions in the current and prior studies simulta-

neously, even if viewers are not linked.
Clear the selection of the Follow button to browse lesions in one study only.

Selecting or clearing Follow makes sense only if viewers are not linked. If corre-
sponding viewers are linked in the current and prior studies, selecting or clearing
Follow has no effect on browsing.

If the system detects inconsistencies in the segmentation and identification of
lesions, a warning symbol appears on the Lesions tool card.

>

Point to this symbol to show a tooltip that explains the problem or inconsistency.

Click Report to send lesion statistics to the Export window as screenshots.
-Or-

n

Report Ve

[+]

il

L

Click Save to create a DICOM structured report of your findings and append it to
the current study as a new series (modality SR).
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Screenshot list

You use the Export window to create reports or to save, send, or print screenshots.
The Export window is subdivided into two sections:
» Screenshots

In this section you find screenshots from the session in the active View window.
This is the tab card that is highlighted with a bullet.

Study Browser AMNSELL “ MILLER Export

* Reports

This section presents you with a template for quick and easy report creation.
Relevant patient and study information from the case in the active View window
has already been entered.

Screenshots are bitmap images that you have created or that were created auto-
matically to document observations or evaluation results. Because screenshots are
bitmaps, you cannot edit them, even if you send them as a DICOM series, or save
them in DICOM format.

In this list, you find the following types of screenshots:

» Screenshots that were created by the software when you stored a key view.

These screenshots are labeled Auto in the lower right corner. See Annotation
and measurement tools, page 90, and Key views tools, page 108.

» Screenshots that you have created with one of the screenshot tools.

Screenshots are numbered. All screenshots that you have created with Screen-
shot All have the same number. See Screenshot tools, page 107.

» Line profiles, which you have sent to the Export window with the screenshot tool
of the Line Profile tool card. See Line Profile, page 140.

* ROl statistics, which you have sent to the Export window with the screenshot
tool of the Statistics tool card. See Statistics tool card, page 155.

» Tables and graphs that result from an LV analysis or a calcium scoring analysis.

You have sent these analysis results to the Export window with the Report but-
ton on the corresponding tool card. See LV Results tool card, page 163, and Cal-
cium tool card, page 164.
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Export window

Displaying screenshots

Deleting screenshots

Saving screenshots

Exporting screenshots

Double-click a screenshot to show it in a floating window.

If the screenshot list contains more than one screenshot, use the Previous Screen-
shot/Next Screenshot buttons in this floating window to browse screenshots.

Q0O

Click a screenshot to select it and click Delete to remove screenshots that you do
not want to save.

% Delete

Saving or sending screenshots means saving them on the Visage 7 server, on a
partner system, or on a connected DICOM node.

1. Select the screenshots that you want to save.
-Or-

Press Ctrl + A (Windows) or Cmd + A (Mac) to select all screenshots in the
Export window.

2. Click Save/Send.

= Save/Send

3. In the DICOM Send dialog box, select one or several DICOM servers.

If the list of servers is very long, type the name or part of the name of the server
in the Filter box above the list of destinations.

4. Enter a Series Number and Series Description.

The program suggests 1000 as a series number. This adds the screenshot
series to the end of the study.

5. Click Send.
-Or-

To have the system save your screenshots automatically next time, select Save
Automatically and Make Default before you click Send.

The next time you close a study for which screenshots exist, Visage 7 creates a
screenshot series and sends it to the server. If you have selected automatic data
transfer with confirmation, a message appears when you exit the program or try to
load a new study.

Exporting screenshots means storing them on your local computer or in your net-
work.
1. Select the screenshots that you want to export.

-Or-

Press Ctrl + A (Windows) or Cmd + A (Mac) to select all screenshots in the
Export window.

2. Click Export.
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Screenshots

Printing screenshots

Copying screenshots to
the clipboard

il Export

3. Select the drive and folder where you want to save the images.

4. Enter a file name and select a file format.

Remember that if you select *.dcm the images are saved in DICOM format. You
need a DICOM viewer or a graphics program that can read DICOM data to be
able to view these images.

5. Click Save.
If a DICOM printer is connected to your Visage 7 server, use Print below the
screenshots list to print images on paper or on film.
1. Select the screenshots that you want to print.
-Or-

Press Ctrl + A (Windows) or Cmd + A (Mac) to select all screenshots in the
Export window.

2. Click Print.

= Print
3. Inthe Print dialog box, select the printer and change printer settings, if neces-
sary.
See Printer settings, page 124.
If you want to show a screenshot in a presentation or in a text file, the easiest way is
to copy it to the clipboard and paste it into your document from there.
1. Select the screenshot that you want to copy.

2. Right-click and select Copy, or use the keyboard shortcut Ctrl + C (Windows) or
Cmd + C (Mac).

Tip

You can only copy one screenshot at a time.
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Export window

Reports

Basic reporting

Filling out a report tem-
plate

Saving a report

Depending on the overall organization of reporting in your hospital you will proceed
in a different manner.

In this mode of working, you use the Visage 7 Client Export window to summarize
your findings on a study and save it on your computer or in your network. However,
the final report on the case will be created in a different system, for example, the
reporting platform of the RIS (radiology information system).

To create a summary of findings in the Visage 7 Client Export window, you fill out a
report template and then save your report.

A standard report template is already selected in the Export window and basic
patient data and study information has been entered in the report header.

1. If necessary, select a different report template.

Template (all)

cium Scoring Report (all) k

2. Use the Insert Placeholders command on the Edit menu to add more study
data to the header or to the report text.

3. Add findings or comments by typing them into the report.

4. Use the buttons on the Text Formatting and Paragraph Formatting toolbars to
highlight or align your findings or comments text.

5. Drag screenshots into the report where you want to show them.
Visage 7 offers various alternatives for saving reports, either in your network, on a
connected DICOM network node, or in the RIS (radiology information system).

Click Export Word or Export PDF to save your report as a Word file or pdf file on
your local computer or in the network.

PDF
W &

Note

Export Word is available only on Windows PCs and only if Word for Windows is
installed on your client PC.

-Or-
1. Create a screenshot of your report pages.

e
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Creation of a screenshot of your report requires that a printer is installed at your
client PC.

2. Select all report pages in the Screenshots section.

3. Send these report pages as a screenshot series to the Visage 7 database orto a
connected DICOM network node.

= Save/Send

-Or-

Use the Send to RIS button if your Visage 7 is connected to a radiology information
system, such as a ProMedicus RIS.

Diagnostic reporting workflow

Creating a report

In this mode of working your Visage 7 has been configured for creation and storage
of reports. Visage 7 records a history of changes by creating a new version of the
report every time a user edits and saves it again. Draft and preliminary reports are
expected to be signed off. Final reports can no longer be edited. Reports are stored
on the Visage 7 server and are eventually archived together with the image data of
a study.

In a diagnostic reporting workflow users are assigned specific rights regarding cre-
ation and review of draft, preliminary and final reports. This means, that your user
account might not be permitted to perform all the steps described below. For exam-
ple, you might have the right to create preliminary reports but not to sign off reports.

Tip

Use this tool from a View window to open the Export window and start reporting
with only one mouse click.

A standard report template is already selected in the Export window and basic
patient data and study information has been entered in the report header.

1. If necessary, select a different report template.

Visage Report Template (all)

Calcium Scoring Report (all) k

Lesion Analysis (all)

2. Click Start Reporting above the report template.

Start Reporting

3. Fill out the report template.
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Export window

Editing a report

Viewing previous report
versions

Use the Insert Placeholders command on the Edit menu to add more study
data to the header or to the report text.

Add findings or comments by typing them into the report.

Use the buttons on the Text Formatting and Paragraph Formatting toolbars to
highlight or align your findings or comments.

Drag screenshots into the report where you want to show them.

4. Save the report.

Save As Final "k

Save As Final

Cancel

You can edit a draft or preliminary report either you or a colleague created for a
study. However, only one user can edit or create reports for a study at any one time.

When you load a study from Study Browser and move on to the Export window,
the most recent version of the study report is shown here.

1. Click Start Reporting.

If you try to edit or create a report another user has worked on since you have
loaded the study, a message will ask you to update the report first.

Click Options > Refresh near the right edge of the Export window.

ﬁ Options

F!.r:fnﬁh

Previous Versions *

Click Start Reporting again.
2. Add or correct findings and comments.
3. Save the report again.
Every time you or another user edits a report and saves it again, a new report ver-
sion is created.

Click Options > Previous Versions and an earlier version of this report.

Visage 7 Client opens this earlier version of the report in a separate tab card. You
can read but not edit or sign off this report version.
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Signing off a report

Resetting the report
status

With appropriate user rights you can sign off a report. Signing off means saving the
most recent report version as the final report.

Click Save as Final.

Save As Final B

A report with report status final can no longer be edited.

If your user account has the right to sign off reports, you can also reset the report
status of final reports. Resetting the status of a final report to preliminary becomes
necessary when you need to add findings to an already signed off report.

Click Options > Reset Status.

The report status is reset to preliminary. You can now open it (Start Reporting) and
add any new findings, comments, or images and save it again.

Creating report templates

Templates contain patient and study data as placeholders and standard text. The
software comes with a few sample templates, which help you to understand the
basic concept and to create templates of your own. You can base a new template
either on a system template or on a typical report that you have just created.

1.

Select Edit > Edit Template.

2. Add all the required placeholders and standard texts.
3.
4

Format placeholders and standard texts.

. Click Save next to the template selection list.

el

5. In the Save dialog box, enter a template name.

Also decide whether you want to make this template available for all users or
only for your own user account.
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Quality Assurance

Visage 7 provides a platform for performing quality assurance. Quality assurance
here means checking the assignment of studies to orders from the RIS (radiology
information system) and correcting patient, study, and series information.

The quality assurance workflow may differ from organization to organization. For
example, in many cases Patient Edits (name change) may be performed in the RIS
or the HIS (hospital information system), and the respective functions may even be
disabled in Visage 7. Please check with your PACS Administrator for site-specific
details.

Refer to Tools for performing quality assurance on images, page 128, for quality
assurance regarding image content.

Find out more about the Quality Assurance window and how to perform quality
assurance in the following sections.

* Query section
» Performed procedures and scheduled procedures lists

* Quality assurance tasks

Note

Only users with appropriate user rights are permitted to perform quality assur-
ance. For users without these user rights, the Quality Assurance window is not
available in their Visage 7 Client installation.

The right to perform quality assurance is independent of any other user rights.
This means that a user whose task it is to perform quality assurance might not
have access to any other program windows. Talk to your system administrator to
find out how these tasks are assigned in your institution.
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Quality Assurance

Query section

The query section of the Quality Assurance window comprises two tab cards.
» Study tab card

Data that you find as a result of a search on the Study tab card is listed in the
Performed Procedures list.

e Order tab card

Data that you find as a result of a search on the Order tab card is listed in the
Scheduled Procedures list.

Tip

If you do not know a complete name or number, you can use wildcards in your
search. For example, type Mi1 in the patient name box to find Miller, Milford, Milt-
ner, or *mi1 to find all the above and also Hamilton, or AB? 234 in the patient ID
box to find AB1234, AB0034, and AB11345678.

However, even if you use wildcards, always specify your search criteria as pre-
cisely as possible. Rather general queries might yield a very long hit list, which
requires extensive scrolling.

Filter and search criteria

Patient

Use the filter and search criteria in this list to search for studies or orders.
Enter the name, date of birth or age, or ID of the patient that you are looking for. If
you do not remember the exact name, date, or number, use wildcards.

For names that occur frequently, you might want to include the first name or other
components of the patient’s name in your search. To define such a search, you
need to know how patient names are stored in the database.

FamilyName GivenName MiddleName Prefix Suffix
The following example shows a search string for first name, last name, and title.
Doe John*Dr.

If you want to search for more than one patient, separate patient names with a
semicolon (;) or the pipe character (|). For example, Anderson|Alexander or
Miller;Milford.
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Date

Modality

Fields (Study tab card)

Select the Date box. Select if you want to search by Study Date or Insertion Date
(Study tab card), or by Modification Date (Order tab card).

The Insertion Date is the date when a study was transferred to the server from a
modality or an archive. The Modification Date is the date when an order was cre-
ated or modified on the RIS (radiology information system).

From ... To specifies a search period. Type dates in the format YYYY-MMM-DD, or
click the button to the right of a date entry box and select a date in the calendar.

Use the buttons Today, Yesterday, 1 Week, 2 Weeks as a quick way to specify fre-
quently searched periods in the correct format.

You can configure these four search-period buttons. Right-click one of the four but-
tons and select Hours > 1 Hour, for example, if you are frequently looking for stud-
ies that were performed within the last 60 minutes.

Select the check boxes of all modalities whose studies you want to search:

CT (computed tomography), MR (magnetic resonance tomography), PT (positron
emission tomography, PET), US (ultrasound), CR (computed radiography), DX
(digital radiography), MG (Mammography), XA (X-ray angiography).

-Or-

Enter a modality abbreviation in the Others box. Separate multiple modalities by a
space, for example, CT PT MR.

Here you can specify additional search criteria.

Open the lists of available criteria with the double-arrow buttons and select a crite-
rion.

Specify your search string in the input box below the selected criterion. Remember
that you can use wildcards in your search.

If you want to search for more than one accession number, for example, separate
numbers with a semicolon (;) or the pipe character (|). For example, 12345|67890
or09876;54321.

If the search strings themselves contain semicolons, pipe characters, or back-
slashes, asin Ward 4; Rm.6orWard 1\Rm.2, use the following notation:
Ward 4\; Rm.6;Ward 1\\Rm.2 orWard 4\; Rm.6|Ward 1\\Rm.2

-Or-

Click the list button next to an input field.

Select an item.
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Study States (Study tab  Click the Study States button and select study states in the Select State dialog
card) box.

If you want to search by QA status, ask your system administrator how these sta-
tus flags are assigned on your server.

Searching by study state Interpretation Status makes sense only if the modalities
that send data to the Visage 7 server set this flag. In Visage 7 you cannot set or edit
the interpretation status of a study.

If study states are included in your search, the Study States button label appears
italic and the Reset button next to it is available. Click this Reset button next to the
Study States button if you want to reset only study states but none of the other
search criteria.

Fields (Order tab card) Here you can specify two additional criteria when searching for scheduled proce-
dures. Open the lists of available criteria with the double-arrow buttons and select a
criterion. Then specify your search string in the input box below the selected crite-
rion. Remember that you can use wildcards in your search.

Status (Order tab card) Here you can filter the schedules procedures list. Choose whether to display either
only those scheduled procedures that are assigned to performed procedures or
only those that cannot be assigned.

Starting and resetting a search

Use these buttons to start a database search or to reset search criteria.

Click Query on the Study tab card to update the Performed Procedures list.

Skudy Crder

Query k

Patient

Click Query on the Order tab card to update the Scheduled Procedures list.

Skudy

Patient

Click Reset to return to the default query preset (see Defining a preset, page 185). If
no default query preset has been defined, Reset removes all search criteria.
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Query section

Query presets

Quick search with a
preset

Defining a preset

If you frequently use the same combinations of search criteria, you can save them in
a preset. Your presets are listed directly above the query section. Any presets that
you define are available for your own user account only. You cannot make presets
public.

Tip

A preset stores filter and search criteria on both tab cards (Study and Order tab
cards). It also stores the size and arrangement of the Performed Procedures
and Scheduled Procedures lists.

1. Click a preset button to retrieve its search criteria.

File Edit

2. Depending on how you defined the preset, you might have to click Query to start
the search.

1. On the Study and Order tab cards, select and type search criteria.
2. Click New Preset.

=+ Mew Preset

3. In the Preset dialog box, enter a name for your new preset.
4. Select Default if you want to make this preset the default query preset.
See also Starting and resetting a search, page 184.

5. Select Auto Query if you want the system to reenter your search criteria and
then run the search immediately. You do not have to click Query again.

-Or-

Select Default plus Auto Query to have the system run this search every time
you call up Visage 7 and Quality Assurance.

6. Save the preset.

A new preset button appears above the query section.

Tip

Right-click presets that you defined earlier. A context menu appears, which helps
you to manage presets. For example, you can remove preset buttons that you no
longer need.
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Performed procedures and scheduled procedures lists

The Performed Procedures and Scheduled Procedures lists display the results
of the last query that you performed on the Study and Order tab card.

Information in the performed procedures list

Patient Name

g 8

Issuer
Patient ID
Date of Birth
Sex

QA Status

Date/Time

Accession Number

Study ID

Performed Procedures lists all studies that are currently stored on the Visage 7
server.

Name of the patient.

Click the pin symbol in front of a patient name to retain this patient in the performed
procedures list before you start a new database query.

This way, you can combine the results of subsequently performed procedures que-
ries (that is queries on the Study tab card).

The institution that issued the patient ID.

The patient’s identification number.

The patient’s birth date.

The patient’s sex: M (male), F (female), O (other or unknown).

This provides meaningful information only if your Visage 7 is connected to a RIS
(radiology information system). In this case, the QA Status of a study indicates
whether the study (performed procedure) can be matched to a RIS order (sched-
uled procedure).

COMPLETED: This QA status indicates that this study has been matched with a
RIS order either automatically or manually.

SCHEDULED: This QA status indicates that the study cannot be matched with a
RIS order automatically. You either need to assign this study to an order manually
or wait until a new order message arrives from the RIS.

DISCONTINUED: This QA status indicates that quality assurance for this study was
terminated.

NOT SCHEDULED (column remains empty): This QA status indicates that no
matching of performed procedure to scheduled procedure was planned for this
study.

Use the Study States button on the Study tab card to search for studies of a spe-
cific QA status.

Date and time when the study or series was performed. The format is YYYY-MMM-
DD and HH:MM:SS (24 hour clock).

Job number of the study in the RIS (radiology information system).

Identification number of the study.
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Performed procedures and scheduled procedures lists

Modality

Body Part

Images
Description

Comment

Performing Physician

Institution/Station Name

Modality or modalities where the patient was examined.

The part of the body or anatomical region that was examined in this study or series.

Use one of the Fields boxes on the Study tab card if you want to search for studies
by DICOM flag Body Part.

Number of images in a study or series.
Study or series description.

A study comment, if such a comment exists for a study.

A study comment can either have been sent from the modality or entered in the
Study Info dialog box of the Visage 7 View window.

Name of the physician who performed a study.
Use one of the Fields boxes on the Study tab card to search for studies by per-
forming physician.

Name of the institution or department or name of the device where the study was
performed.

Information in the scheduled procedures list

Patient Name
Patient ID
Birth Date
Sex

Assigned

Order Status

Study Date/Time

Accession Number

Scheduled Procedures lists all orders that have been sent from a connected RIS
(radiology information system). If your Visage 7 is not connected to a RIS, the
scheduled procedures section is nevertheless shown, however, the list will remain
empty.

Name of the patient.

The patient’s identification number.

The patient’s date of birth.

The patient’s sex: M (male), F (female), O (other or unknown).

This column indicates whether a scheduled procedure (RIS order) has been
assigned to a performed procedure.

The corresponding study in the performed procedures list has the QA status COM-
PLETED.

Use the Status box on the Order tab card to search for scheduled procedures that
have already been assigned or that cannot be assigned.

Status of the RIS order.

Date and time of the study. The format is YYYY-MMM-DD and HH:MM:SS (24 hour
clock).

Job number of the study in the RIS (radiology information system).
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Modality Modality or modalities where the patient was examined.

Organizing and rearranging procedures lists

You can rearrange the performed procedures and scheduled procedures lists for a
better overview.

Enlarging or reducing Drag the split bar above the Scheduled Procedures list up or down to enlarge or
window sections reduce this window section.

If your Visage 7 is not connected to a RIS, you might choose to hide the scheduled

procedures list altogether. Drag the split bar all the way to the bottom of the Quality
Assurance window in this case.

Rearranging columns 1. Right-click the column header of the performed procedures or scheduled proce-
dures lists.

2. Cancel the selection for any columns that you want to hide or move.

Birth Date

1940-1an-01

3. Point to a column to the right of which you want to reinsert a hidden column.

4. Right-click and select the column again.

Expanding or collaps- The performed procedures list is arranged in a hierarchical tree view.
ing the p(?rformed pro- Use the + (plus) button in front of an entry to expand it and show lower levels of
cedures list . .
information.
-Or-

Click the Expand To button below the performed procedures list to show the
study level or the study and series level for all performed procedures.

Expand To

-Or-

Use the - (minus) sign in front of an entry to collapse this level, or click Collapse All
to show only the patient level.
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Quality assurance tasks

Quality assurance typically involves different tasks, depending on whether your
Visage 7 is connected to a RIS (radiology information system) or not.

Quality assurance with RIS

Automatic data consoli-
dation

Assigning studies to
orders

When your Visage 7 is connected to a RIS, quality assurance is performed automat-
ically and in the background.

When a RIS connection exists, Visage 7 is typically configured in such a way that all
incoming studies are automatically matched with orders from the RIS. If study data
contain errors, for example, if the patient name was misspelled during patient regis-
tration, these errors are automatically corrected with information from the RIS order.
Studies that can be matched to RIS orders receive the QA status COMPLETED.
These studies require no further user interaction.

When your Visage 7 is connected to a RIS, you only need to perform manual quality
assurance if automatic matching of studies and RIS orders fails. A common sce-
nario for this is when scans are performed without Modality Worklist and incomplete
or incorrect information was entered at the modality.

1. In the Performed Procedures list, search for studies with QA Status SCHED-
ULED.

Use the Study States button on the Study tab card to define such a query. Start
the search with the Query button on the Study tab card.

2. In the Scheduled Procedures list, search for orders that have not yet been
assigned to studies.

In the Status box at the bottom of the Order tab card select NOT ASSIGNED.
Start this search with the Query button on the Order tab card.

3. Select a study in the Performed Procedures list and the corresponding order in
the Scheduled Procedures list.

Use Accession Number information or patient information (columns Patient
Name, Patient ID, Birth Date, and Sex) to identify studies and orders that
require matching.

4. Click Assign Order to Study on the toolbar.

o

A message appears that asks you to confirm study to order assignment.

If patient data for study and order are not identical, a second message appears.
5. Click Update to update the patient data of the study.

-Or-

Click Create New Patient to correct the patient information stored in the order.
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Assigning series to
orders

1. Inthe Performed Procedures list, search for and select the series that you want
to reassign.

2. In the Scheduled Procedures list, search for and select the order to which you
want to assign the series.

3. Click Assign Order to Study on the toolbar and confirm.

@

The system now splits the study from the Performed Procedures list, assigns the
series to the new study and the new study to the selected order in one step.

Quality assurance without RIS

Completing data of an
emergency registration

Merging patients

If your system is not connected to a RIS (radiology information system), quality
assurance means completing patient information or correcting errors that were
made during patient registration.

1. On the Study tab card, search by study date and modality, for example.

2. Click Query.

Patient

3. Select an emergency patient in the Performed Procedures list.

4. Click Edit.

X

5. Overwrite any preliminary information with the correct patient information.
6. Click OK.

The Performed Procedures list is updated automatically now.

1. Search for an emergency study or a patient whose name is misspelled.

2. Click the gray pin symbol in front of the patient name.

The pin symbol turns blue when you select it.

g > 8

3. Search for the correct patient name.

4. In the Performed Procedures list, select the emergency patient or misspelled
patient.

5. Press and hold Ctrl or Cmd while you also click the correct patient name.
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Moving studies, series,
or images

Editing patient, study,
series, or image infor-
mation

6. Click Merge Patients.

R

7. Select the correct patient name.
8. Click OK.

The Performed Procedures list is updated. Only the correct patient name is dis-
played now and the study has been moved. The emergency or misspelled patient
entry has been deleted.

If studies, series, or images were assigned incorrectly, move the data to another
patient, study, or series. You proceed in a similar way in all these operations.

1. Select the study, series, or images that you want to move and the patient, study,
or series that you want to move the data to.

2. Click Move.

B

3. Read the message and confirm with OK.
-Or-

1. Select a study, series, or image that you want to move to a patient, study, or
series that does not yet exist in your database.

2. Click Split.

RS

3. Enter the new patient, study, or series information in the Edit Patient, Edit
Study, or Edit Series dialog box.

4. Click OK.

Tip
For series Split means moving the series to a new study of the same patient.

If you want to move the series to a new study of a new patient, use the Move to
New Patient button instead.

CQ

Select a patient, study, series, or image.
Click Edit.

X

3. Overwrite the patient, study, series, or image information in the Edit Patient,
Edit Study, Edit Series, or Edit Image dialog box.

N =

4. Click OK to confirm and close the dialog box.
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Deleting patients, stud-
ies, series, or images

Undeleting studies
deleted for quality rea-
sons

Modifying patient ID
mappings

Note that deleting images, series, or studies is rarely required. If images were
scanned under a wrong patient or study, it is generally strongly preferred to correct
the images using the QA functions described above (for example, order assign-
ment) instead of deleting them and re-sending them from the modality.

However, if circumstances arise where you do need to re-send images to Visage 7
with modified metadata (for example, different patient ID), then you should delete
the images on the Visage 7 server before the corrected study is sent to the Visage 7
server again. Otherwise, the study might be partially or fully rejected or other prob-
lems may result.

Before deleting data, ensure that the data is no longer required by your users. After
you have deleted a study from the server, you cannot restore it again, unless there
is an independent copy that you have access to, such as a long-term archive. Note
that in some installations delete operations may propagate to other systems, such
as long-term archives.

1. Select one or several patients, studies, series, or images.
2. Click Delete.

E

A dialog box appears, which prompts you to specify a reason.
3. Select a reason for data deletion and click OK if you are sure you no longer need
this data on the server.

With appropriate configuration settings, data that you deleted for quality reasons do
not disappear from the Quality Assurance window entirely. Even though the data is
no longer available in the Study Browser, the data remains in the Performed Pro-
cedures list of the Quality Assurance window where it is marked with an asterisk

(*). You can revoke deletion of such data.

1. Select a patient, study, series, or image with an asterisk (*).
2. Click Undelete.

Gy

The asterisk is removed from the patient, study, series, or image in the Performed
Procedures list and the data is available again in the Study Browser.

If subsystems that send data to the Visage 7 server or that receive data from the
Visage 7 server use different patient IDs than Visage 7, IDs can be mapped. In the
Quality Assurance window, you can edit patient ID mappings.

1. Select a patient, study, series, or image.
2. Right-click and select Mapped Patient IDs.

3. Inthe Mapped Patient IDs dialog box, add new patient ID mappings or delete a
mapping that is no longer valid.
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Visage 7 users can customize the Visage 7 Client in various ways. For some of
these configuration options advanced user rights are required, others are available
for all Visage 7 users.

Tip

If you cannot find some of the configuration options described in this section on
your user interface, ask your system administrator about your user rights.

Basic settings

Basic configuration settings can be made by all Visage 7 users. Users do not need
advanced user rights to access these commands and dialog boxes.

Ul appearance and display size

Select View > Ul Appearance and Native Style, Visage Bright, Visage Dark, or
Visage Medium to adapt the user interface to the ambient light conditions of your
workplace.

Point the cursor to a screen or section of a screen, hold the Ctrl key down, and
rotate the mouse wheel to display image text larger or smaller.

Change Password dialog box

You should change your password from time to time for data security reasons.
1. Select File > Preferences > Change Password.

2. Enter your Old Password, the New Password, and repeat the new password in
the Retype New box.
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¥’ Change Password

3. Press Return.

Use the new password from now on when you log in.

Reset all warnings

If you have selected Do not show again ... for any warning that has appeared since
you called up Visage 7, View > Reset All Warnings revokes this selection. From
now on, all warnings are shown again.

Streaming compression

With View > Streaming Compression you can select a compression level for
image transfer from the server to your computer.

Note

Depending on the system configuration and your user role, you might not see all
the compression options listed here. Furthermore, Visage Imaging's customer
service can fine-tune the compression settings to optimize performance and net-
work use in your organization. Contact your system administrator if you have fur-
ther questions on this topic.

Select a compression level depending on the network you are working in and on the
image quality you require.

+ Auto analyzes the current network bandwidth and the latency characteristics
and optimizes the compression level.

» Lossless Only transfers only losslessly compressed data with full image quality.
Select this option only for fast networks, for example, in local area networks
(LANSs). Your server needs to be configured to support this function.

¢ High Quality applies a low compression level that ensures high image quality.
Select this option in fast networks.

* Medium applies a medium compression level. Select this option, for example, in
a slow local area network (LAN) or in a wide area network (WAN).

» Strong applies a high compression level for fast data transfer at the expense of
image quality. Select this option, for example, if you are working in a slow or very
busy network.
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Note

If images are displayed with reduced image quality because of streaming com-
pression settings, a red bullet appears in the lower right corner of the viewer. Wait
until the red bullet has disappeared to ensure that the images that you are look-
ing at do not show any compression artifacts.

Monitor Configuration dialog box

If you are working with more than one monitor, you use this dialog box to define
which Visage 7 window is shown on which monitor. For example, use a large high-
resolution monitor exclusively for viewing images and use another monitor to find
studies, create reports, or perform quality assurance.

1. Select File > Preferences > Monitor Configuration.

Tip

Point to a monitor box to show the resolution of this monitor as a tooltip.

Browse \View Export QA

4 4 4 4

Monitors and Visage S

Click into the monitors in order to change the assignment of function to the monitors.

Simulate Dual Monitors

+ Split Monitor 1

Reset to Default

2. Select display settings for each window.

Select Full Screen Mode to show the windows on this monitor in fullscreen
mode right after program start, that is without a window border. During a session
you can return to window size with the Restore Window button in the upper right
corner of the program window.
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Select Docked into Single Window if you want to show all Visage 7 windows in
the same program window. Clear this option to be able to show Visage 7 win-
dows side by side on the monitor.

Note

The selections Full Screen Mode and Docked into Single Window become
effective only if you select or clear these options for all windows of one monitor.

. If the monitor that you use for reading images is a grayscale monitor, also select
Grayscale for the View window.

This selection enhances the readability of thumbnails and highlights the bright
border that indicates the active viewer for grayscale monitors.

. Select which windows you want to show on which monitor.

Browse represents the Study Browser, Patients represents the Patient
Search window, View represents the View windows, Export represents the
Export window, and QA the Quality Assurance window.

. Decide whether you want to show the Windows taskbar when Visage 7 Client is
shown in fullscreen mode.

Showing the Windows taskbar facilitates switching over to other program win-
dows such as the RIS (radiology information system).

. Select Split Monitor 1 if you are using only a single monitor with this Visage 7
Client but are used to dual monitors at your regular workplace.

Splitting a single monitor allows you to use the same protocols that you are used
to in dual-monitor mode.

. Click Save to save the monitor configuration for your own user account.
-Or-

Click Reset to Default to reset the monitor configuration to the system default.

Tip

If studies are loaded in more than one View window (more than one tab card with
a patient name is shown in the title bar) when you change the monitor configura-
tion, reload these studies so that the new monitor configuration becomes effec-
tive in all View windows.
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Render Settings dialog box

In this dialog box, you can change technical parameters for the way 2D and 3D
images are generated by Visage 7. Change these parameters only if your system
administrators or Visage Imaging customer service instructs you to do so.

1. Select View > Render Settings.

¥ Render Settings

2. Select Auto for Local Rendering and Rendering Subsystem to have the sys-
tem identify and select the option best suited for your system configuration.

Caution

OpenGL is an advanced graphics standard that is not always properly supported
by client-computer graphics hardware.

In the View > Render Settings dialog box, you should set Rendering Subsys-
tem to OpenGL only if you are certain that this mode is supported properly by the
graphics card of your client computer.

3. Also adapt Volume Rendering parameters, if necessary.
4. Click OK to save your settings.

Any modifications that you made to Local Rendering and Rendering Subsystem
settings are stored permanently for your client. Modifications to Volume Rendering
settings are reset to their defaults when you restart Visage 7 Client.
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Configure Window/Level Presets dialog box

Window level presets are combinations of image brightness and contrast settings.
You can save these presets for specific image types.

While you are reading images, you can select predefined window presets from a
drop-down list in the viewer controls, from a list shown when you click the Show
Window Level Presets button on the tool palette, or with a keyboard shortcut.

1.0 mm

1. Select File > Preferences > Window/Level Presets, or select Window/Level
Presets from the viewer controls.

The image type of the currently loaded data is already selected.

7 Configure Window/Level Presets

Fixed

Center 70

Gamma: 1

2. Select the modality for which you want to define a preset and a preset number.

Preset numbers correspond to the keyboard shortcuts that you can use to select
presets quickly while you are reading images.

Undefined presets are listed as <Name>.
3. Enter a Preset Name.
4. Enter or select window level settings.

Fixed value range: Enter the window width as a range value or in terms of a
minimum and maximum value. The Center and Width and Min and Max boxes
are synchronized.

-Or-
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Automatic W/L based on histogram: This setting adapts the data window to
the value range available in an image dataset.

-Or-

Value range embedded in DICOM image: Select one of the window level pre-
sets that are stored with the image. Last represents the most recently stored
DICOM window preset.

-Or-

Click Copy values from active viewer to copy window level settings from the
currently active viewer into the Configure Window/Level Presets dialog box.

. Change the Gamma correction factor, if necessary.

Gamma correction can be used to compensate for distortions in image bright-
ness that are caused by the monitor.

. Select Save Preset to save your settings.

-Or-

Select OK to close the dialog box and choose whether to save or ignore
unsaved changes.

Configure Keyboard Shortcuts dialog box

Factory-default key-
board shortcuts

Configuring your own
keyboard shortcuts

Some of the functions and options that are represented by toolbar buttons can also
be selected with keyboard shortcuts. These keyboard shortcuts are active even if a
toolbar or button is currently not displayed in any of the toolbars on the screen.

A number of keyboard shortcuts have been predefined for your system.

Select Help > Keyboard Shortcuts on the main menu to show the list of factory-
default shortcuts.

If you feel that the factory-default shortcuts are not intuitive, you can redefine them
and also assign other functions to keyboard shortcuts.

1. Select File > Preferences > Keyboard Shortcuts.

Visage 7
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5 Configure Keyboard Shortcuts

Browse Continuously

r_—'l‘! Crop Box
i ceprire

2. In the search filter box above the Available Tools list, type the name or part of
the name of the tool that you are looking for.

-Or-
Scroll down the list of Available Tools.
3. Select a tool and drag it into the box of a keyboard shortcut on the right.

You can assign tools to function keys, alphanumeric keys, or special keys and
also to combinations of these keys with the Shift or Alt key.

If you drag a function to the box of a key or key combinations that already con-
tains a tool, this replaces the original key assignment.

Returning to factory Click the Revert to System Defaults button to reject any recent or previous key
defaults assignments or reassignments.

The factory-default keyboard shortcuts, which you can also find under Help > Key-
board Shortcuts, are now active again.
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Configure Tool Palette dialog box

When you right-click in a viewer, either the viewer context menu, or a tool palette, or
both are shown. The tool palette offers a quick way of calling frequently used func-
tions.

1. Select File > Preferences > Tool Palette.

® Show Both

. In the search filter box above the Available Tools list, type the name or part of

the name of the tool that you are looking for.
-Or-

Scroll down the list of Available Tools.

. Select a tool and drag it onto the Tool Palette to the right.

Moving a tool to a box that is already occupied by another tool replaces that tool.

. Select whether to show the tool palette, the viewer context menu, or both when

you right-click a viewer.

. Click the Revert to System Defaults button to reject any recent or previous

assignments or reassignments.

. Click OK to confirm and close the dialog box.

Tip

You can even configure a shortcut to the Configure Tool Palette dialog box
itself.

S
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Properties and protocols

Properties and protocols are Visage 7 concepts for controlling and adapting the
user interface and the default behavior of functions at various levels.

Properties dialog box

Properties define the default settings for many program functions. You can open the
Properties dialog box either from the File menu or from various context menus or

buttons. Depending on how you open the dialog box, it presents either the complete
set of properties or only a context-dependent subset. You can change properties for
your own user account, for all users, or for the currently active protocol, depending
on your user rights.

1. Select File > Preferences > Properties from any of the Visage 7 windows to
open a dialog box with all program properties.

-Or-

Select View > Viewer Properties in the View window if you want to redefine
only a subset of user interface settings for the View window.

-Or-

Click the Properties or Defaults button in a dialog box or on a tool card to mod-
ify only the properties of the corresponding function.

-Or-

Right-click a configurable tool or tool card and select Properties to modify the
properties of the corresponding function.

2. Decide on the level on which you want to save your changes.
System: This saves your changes on a system-wide basis.

User profile: This saves your changes in your user profile. The new settings will
be effective in all studies that you view from now on.

Protocol: This saves your changes in the protocol definition. The new settings
will be effective in all studies that use this protocol.

If you select Protocol, do not forget to save the protocol to make your changes
permanent. See Save Protocol dialog box, page 213.

3. Open the tree view of the function or feature that you want to modify.

The column Defined in tells you the level of the currently valid values: factory
default, system, user profile, or protocol.

-Or-

Type the name or part of the name of the property you are looking for in the filter
box above the property list.

4. Select the property that you want to modify and adapt its value in the second col-
umn.

Modified values have a check mark in the Modified column. When you clear this
box, you undo changes for this feature.
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Tip
When contradicting property settings exist at the various levels at which property
settings can be defined, the following rule applies.

Protocol settings overrule user profile settings, user profile settings overrule sys-
tem settings, and system settings overrule factory defaults.

Settings that will be overruled by settings of a higher priority are highlighted with
orange text.

Save in: ® User profile System rch Filter Clear

Property Value Modified | Defined in
— Annotations and Measurements
+ Spine Labeling
— Text and Arrow
Bold Font ( factory default
Circle Diameter 0 factory default
— Text and Line Color 5, 255, 255] factory default
Red
Green
Blue
Font Family MS Shell Dig 2 factory default
Font Size (px) il factory default
Ttalic Font Off factory default
Keep tool active after usage Off factory default
Line Width ) factory default
Freely movable text Off factory default

Manually factory default
Cobb's Angle
Freehand 2D

Point, Circular, and Elliptic ROIs
4

Bexpand all B collapse all

Please note that properties highlighted in orange will be overridden by this protocol even when they are saved in the user profile.

Remove from user profile... Cancel

5. Click Save to save your changes and close the dialog box.
-Or-

Click the Remove from ... button to reset properties settings to the settings of
the next higher level.
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Automatic loading of prior studies

Automatic loading of prior studies can be configured either for the entire system, for
specific user levels, or for individual user profiles.

When configuring automatic loading of prior studies you should consider the actual
requirements of your users closely, because loading prior studies unnecessarily will
slow down system performance.

Configuring automatic loading of prior studies

1. Select File > Preferences > Properties.
2. Open the list of options for Automatic Loading of Prior Studies.
3. Review and adjust settings.

If you select any of the rule-based options here, move on to the Edit Auto-prior
Rules dialog box to review or define rules.

Protocol ® User profile System

erty Modified | Defined in
Annotations
Automatic Loading of Prior Studies
Maximum Age in Days for Prior Studies factory default
2 factory default
factory default
Minimum Age ¥ factory default
Automatically Load Prior Studies ne v user profile
Batching

Rule-base
Rule-b

y and Body Part

o o o o

Magnifying Glass

Editing rules for automatic loading of prior studies

1. Select File > Preferences > Edit Auto-prior Rules.

2. In the Edit Auto-prior Rules dialog box, select System or User below the rules
list to show either only system rules or only the rules of your user profile.

3. Select a rule.
-Or-
Click New Rule.

4. For a system rule, you can specify for which user level or user levels the rule will
apply.
Type a user level number (e.g. 3).
-Or-
Type several user level numbers separated by a space (e.g. 3 4 5).

5. Under If study matches the following, define current studies for which the rule
will apply.

204 Visage 7



Customizing Visage 7 Client Properties and protocols

6. Under Additionally load these prior studies, specify the prior studies that will
be loaded together with the current study.

3 Edit Auto-Prior Rules

List of Auto-Prior Rules Auto-Prior Rule Properties

Thorax
MName: Thorax

User 1248910

Comment: - . - =
R Example: rule for prior chest examinations

Other: Disable
If current study matches the following:
Any of the following

Contains Any Of | CRDX

Equals ¥  CHEST

+  Wildcard > Sthorax®

Additionally load these prior

| Al studies that fulfill
All of the following =
Modali Study ¥  Contains Any Of| 3 CRDX
Any of the following | &
Body Part Examined | ¥  Equals

Thrdu M

Cancel

7. Always double-check your automatic loading configuration. Use the Properties
button as a shortcut to the Automatic Loading of Prior Studies configuration.

Parameters in the Properties dialog box and auto-prior rule settings are AND-
combined. For example, you might define a rule intended to load prior studies of
both the modalities CT and MR for current CT studies. However, you also select
the option Rule-based but only same Modality for the property Automatically
Load Prior Studies in the Properties dialog box. This will result in MR studies
being ignored and only prior CT studies will be considered.

8. Click Save.
Tip

If you want to adapt a system rule for your user profile, you can copy it to your
user profile. Likewise, and with appropriate user rights, you can move rules from
your user profile up to system level. Use the buttons Copy to User and Move to
System to copy and move rules.
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Modifying and creating protocols

Protocols control the screen layout and the scope of functions that are available
when a user loads different types of images or a combination of image types. Typi-
cally the system preselects the protocol best-suited for a selection of data when a
user loads data into the View window. If users do not agree with this choice, they
can select a different protocol. Users with appropriate user rights can prioritize pro-
tocols for specific image types or even edit or create protocols of their own.

Protocols are a very powerful and complex concept in Visage 7. Therefore, we rec-
ommend that you attend a dedicated training course before you attempt to perform
complex protocol editing tasks.

Simple protocol editing

The easiest way to modify a protocol is to make changes in the View window and
then to save these modifications.

Examples of simple The following list presents some typical examples of simple protocol editing tasks:
protocol editing tasks + Hiding toolbars or showing additional toolbars
» Showing or hiding the thumbnail section or tool cards
» Changing viewer linking and viewer alignment

» Changing viewer types or viewer properties such as color maps, window level
presets, image orientation, slice thickness, and rendering mode selection.

* Rearranging the Layouts toolbar.

Procedure in simple 1. Load images into the View window.
protocol editing

2. Check which protocol is currently selected, or select a different protocol from the
Protocol menu.

3. Make your changes.
For example, show a toolbar that was previously hidden.

4. On the Protocol menu, select Protocol Editing > Save Protocol.

5. Change the protocol name and add a comment, if required.

6. Click Save Protocol.

When you proceed as described here and change no other parameters in the Save
Protocol dialog box, the protocol is saved as a user-level protocol. The priority of
the new protocol is the same as the priority of the original protocol. User-level proto-
cols have a higher priority than system-level protocols. Therefore, the new user-
level protocol will be selected the next time you load images of this image type.

Prioritizing protocols As a further step, you might want to call up the Protocols dialog box. In this dialog
box you can change the priority of the modified protocol and disable obsolete proto-
cols for your user account.

For more information, see Protocols dialog box, page 207.
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Protocols dialog box

In the Protocols dialog box, you prioritize, activate or deactivate protocols in your
own user profile.

Changing protocol priorities does not change the protocol definition itself but only
stores customized protocol priorities in your user profile.

When you load images, Visage 7 automatically identifies the protocol best-suited for
these images. Each protocol contains a number of matching criteria, which include
a monitor configuration, DICOM tags, and other metadata. The software uses these
matching criteria to identify protocols that are suitable for the selected image data.
From among these candidates the software chooses the protocol with the highest
priority in your user profile.

1. Select File > Preferences > Protocols from any of the Visage 7 windows.
-Or-
Select Protocol > Protocol Editing > Protocols in the View window.

3 Protocols
Filter

Only Monitors:

4

Priority MName
1003
1002 MNudear Medicine [2L] system
601 CT Cardiac [2F] system
600
595 Mudear Medicine [Web] system

511 CT Brain Perfusion [2L] system

Ac
'
'
'
'
'
'
'

i1
511 CT Brain Perfusion [4] system
511 MR, Brain Perfusion [4] system
MR. Brain Perfusion [2L]
PET/CT [2F] system
MR. Brain Perfusion [2F] system

Cancel

Because the list of protocols that you find here is most likely very long, filter the
list before you begin.

2. Select if you want to show Active Protocols Only.

Filter

ols Only Monitors:

-Or-
Filter by protocol name. Type a search string in the Filter box and press Return.

For example, show only those protocols that apply to CT datasets or to a combi-
nation of CT and other modalities.
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Note that you cannot use wildcards in the Filter box.

Monitors:

-Or-
Show only those protocols that apply to specific monitor configurations.

Filter

Filter by name Active Protocols Only  « Monitors: 142

-Or-

Combine any of these filter criteria.

. Select Active for all protocols that will be considered when you load data. From

these protocols the system selects the one best suited for the selected data.

Protocols for which Active is not selected are not considered. Also be aware that
only active protocols are listed in the Protocol menu and available for manual
protocol selection.

. Double-click the priority rating of a protocol to overwrite the value.

1o 4 CT Cardiac 4D, 30, CaSc

Protocols with a high priority ranking are more likely to be selected by the system
when you load data into the View window. Protocols with a high priority ranking
also show up at the top of the list when you drop down the Protocol menu.

. Delete protocols only if you are sure you no longer need them.

10

k[:lelete Protocol

When you delete a protocol you remove it from the system. The protocol will no
longer be available, either for your own user account or for all other users.

To be able to delete protocols you need appropriate user rights.

. Click OK to confirm your configuration settings and close the dialog box.

-Or-

Click Reset to reject any recent and previous changes in this dialog box and
return to the factory-default settings.
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Advanced protocol editing

Advanced protocol editing requires that you thoroughly understand the principles
and concepts of the Visage 7 protocol mechanism.

Tip

We recommend that you attend a training course before you attempt to perform
these tasks. Alternatively, leave these tasks to trained administrators or Visage
Imaging service personnel.

Protocol definition Visage 7 expects you to base the definition of a new protocol on an existing proto-
workflow col. Moreover, the system expects you to edit some aspects directly in the View win-
dow and adapt others with the protocol editing commands on the Protocol menu.

The workflow for protocol modification therefore comprises the following steps:
1. Loading appropriate image data into the View window

Choose a study that is typical for the cases for which you want to create a new
protocol.

2. Selecting a base protocol on the Protocol menu
Choose a protocol that resembles the one you want to create.

The protocol editing options of the Visage 7 Client do not permit you to modify or
define all aspects of a protocol. Therefore, it is important that you start protocol
editing with a protocol that interprets the data in the correct way. In particular,
ensure that all images or image stacks that you want to present are available as
thumbnails. If you cannot find a suitable protocol, contact customer service.

3. Creating and editing layouts

A layout defines the arrangement of viewers on the screen. See Edit Layout dia-
log box, page 210.

4. Editing image assignment

Image assignment defines criteria for selecting images or image stacks and for
showing them in the viewers of a layout. Typically, you combine interactive
image selection in the View window and definition of criteria in the Image
Assignment dialog box in this step. See Image Assignment dialog box, page
212.

If you define no image assignment rules, images are distributed across viewers
in the order in which they were acquired.

5. Adapting image display and tool selection

Use the tools of the View window to modify image display settings such as slice
thickness, rendering modes, window level settings, or viewer linking. Also show
tools and tool cards as required.

6. Saving the protocol

Use the Save Protocol dialog box to save the modified protocol and to change
its name, priority, access and matching criteria. See Save Protocol dialog box,
page 213.
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Defining conditions

Service-level protocol
editing

Conditions are rules that help Visage 7 to identify specific types of images. See Edit
Conditions dialog box, page 215.

Note

Only very advanced users with the most advanced user rights are permitted to
edit conditions and therefore have access to the Edit Conditions dialog box.

The various options and dialog boxes for advanced protocol editing allow adaptation
of existing protocols or definition of new protocols based on existing protocols.

Visage 7 Client users are not permitted to build protocols from scratch or to modify
certain protocol properties which, if modified incorrectly, might render the system
unusable. This level is reserved for service personnel who have been trained for
these tasks specifically.

Tip

Do not hesitate to contact customer service if you require protocol changes that
you cannot perform yourself, for example, because you do not have the neces-
sary user rights.

Edit Layout dialog box

In the Edit Layout dialog box, you can configure layouts for the protocol that is cur-
rently active.

1. Before you open the Edit Layout dialog box, inspect the layouts of your current
protocol.

Axial+MPR. MIP+MPR MPR+YRT  MPR+3DMIP  MPR+Scout

By default, Visage 7 hides layouts that are not suitable for the currently loaded
data. If you want to review these layouts nevertheless, select Protocol > Proto-
col Editing > Show All Layouts.

-Or-

Right-click in the Layouts toolbar and select Show Layout and a layout that is
currently hidden.

2. Select Protocol > Protocol Editing > Edit Layout.
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7 Edit Layout

4
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4
b4
]

¥ Snap togrid

3. Select or clear the check box in front of a layout to activate or deactivate it.

A layout that you deactivate is no longer shown on the toolbar irrespective of
whether you select Protocol > Protocol Editing > Show All Layouts.

4. Drag a layout up or down in the Select Layout list to change its position on the
Layouts toolbar.

5. Select an existing layout that you want to modify, or create a new layout.
We recommend that you create new layouts by cloning existing ones.
6. Assign layouts to monitor configurations.

7. Use the Layout Priority and Condition boxes to define which layout is selected
automatically when a user loads this protocol.

Refer to customer service for detailed instructions about how to define priority
settings and conditions.

8. Modify viewer arrangement and viewer sizes

Use the buttons in the lower half of the dialog box to add or remove viewers from
this layout.

-Or-

Resize viewers by dragging their borders in or out, or move viewers by dragging
them to a different position.
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Image Assignment dialog box

Image assignment means assigning specific images to specific viewers by defining
matching rules. For example, in MR studies you might want to assign axial T1
images to the upper left viewer.

Image assignment typically combines interactive steps, which you perform in the
View window, and fine-tuning of rules in the Image Assignment dialog box.

1. Switch to the layout whose image assignment you want to modify.

Axial+MPR  MIPHMPR  MPRHVRT  MPR+3DMIP  MPR+

2. Drag images, image stacks, or series from the thumbnail section into the various
viewers.

2011-Mrz-29
n [8269: Mam 1
(L-MLO) {

1img 1img

You can only drag image sets that are represented by a thumbnail. You cannot

assign subsets of images or a combination of thumbnails to a viewer. Therefore,
if the base protocol does not group the data in appropriate image sets, select a

different base protocol, or contact customer service.

3. Select Protocol > Protocol Editing > Image Assignment.

7 Image Assignment

4. In the Image Assignment dialog box, refine the criteria the system uses to
select images for the active viewer.

Refer to customer service for detailed instructions about how to define and com-
bine conditions in image assignment rules.

5. Click Apply.
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Apply

In the View window, select another viewer.

You can leave the Image Assignment dialog box open while you select a differ-
ent viewer in the background.

Define image assignment criteria for this viewer as well.

Save Protocol dialog box

1.

3.

4,

Select Protocol > Protocol Editing > Save Protocol.
The Save Protocol dialog box has four tab cards.
On the General tab card, change the name, comment, and protocol priority.

For example, if you want to make sure that your new protocol is always chosen
instead of an existing one, you should increase its priority by at least 1.

Click the Protocols button to review the priority settings of all other protocols
that are available for your user account.

7 Save Protocol

Also select which of the attributes that you have changed since you selected this
protocol you want to save.

Click Next to move on to the Access tab card.

-Or-

If you do not want to change other aspects of the protocol, click Save to create a
new user-level protocol.

On the Access tab card, select whether you want to make this protocol available
for all users or for specific user groups only.

Visage 7
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7 Save Protocol

s
o
b
o
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6. Click Next to move on to the Monitors tab card.

7. On the Monitors tab card, define the monitor configuration for which this proto-
col will be considered suitable by the system.

The configuration considers only those monitors that display the View window.

When users load images and their monitor configuration does not correspond to
the configuration defined here, this protocol is not selected automatically by the
system. Users can nevertheless select this protocol on the Protocol menu.

7 Save Protocol

8. Click Next to move on to the Matching tab card.

9. On the Matching tab card, you define for which image type or image types the
new protocol will be considered suitable by the system.
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10.Refer to customer service for instructions about how to define conditions and
build matching rules.

11.Click Save to save the protocol under the name you specified earlier and with
the required access level.

Edit Conditions dialog box

Conditions are rules that help Visage 7 to identify specific types of images. Condi-
tions refer to the DICOM tags of images and series. Conditions combine these tags
and their values to form complex selection criteria.

Conditions are used in various protocol definition steps:

+ Definition of layout priorities: see Edit Layout dialog box, page 210.

* Image assignment to viewers: see Image Assignment dialog box, page 212.
+ Matching of protocols to studies: see Save Protocol dialog box, page 213.

Moreover, conditions are used by the system to group images in image sets. Image
sets are presented as thumbnails in the thumbnail section of the screen. The rules
for this process are not visible on the Visage 7 Client user interface.

Only very advanced users with the most advanced user rights are permitted to edit
conditions and therefore have access to the Edit Conditions dialog box.
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7 Edit Conditions

Refer to customer service for instructions about how to define conditions.
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